
5. FOS Release B Subsystem Test Cases 

Table 5-1. Release B Subsystem Test Cases (1 of 2) 
System Management: 
·SYS-2020B Logical String Configuration, Control, & Terminate 

FUI: 
·FUI-2060B Procedure Control/Validation 

·FUI-2080B OASIS/CSTOL Conversion 

PAS: 
·PAS-2035B EOC Timeline Manipulation 

·PAS-2040B Contact Scheduler 

·PAS-2110B Scheduling Microprocessor/table/FSW/RTS Load Uplink Activities 

·PAS-2180B Receive/Schedule Late Change Requests 

·PAS-2190B What-If Planning & Scheduling 

·PAS-2200B DAS Generation 

CMD: 
·CMD-2001B Command Generation 

·CMD-2010B Ground Script Control 

·CMD-2015B Ground Script Commanding 

·CMD-2030B Manual Commanding 

·CMD-2050B Uplink Loads 

·CMD-2070B Command modes - Transmission & Uplink 

·CMD-2080B Command - Telemetry Verification and Receipt Verification 

CMS: 
·CMS-2000B Memory Dump Image 

·CMS-2040B Table Load Validation & Generation 

·CMS-2060B Microprocessor & FSW Load Generation 

·CMS-2090B ATC Load Generation & Validation 

·CMS-2100B ATC Load Management 

·CMS-2170B Validate and Generate RTS load contents 

·CMS-2180B RTS load management 

·CMS-2190B Table load Management 

TLM: 
·TLM-2000B Decom - Health & Safety/Standby Tlm 

·TLM-2010B Decom - Housekeeping Telemetry 

·TLM-2020B Decom - Context Dependent Telemetry 

·TLM-2030B Engineering Unit Conversion 

·TLM-2040B User Adjustment of EU Algorithms/Coefficients 

·TLM-2050B Multi-Byte Parameter Processing 
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Table 5-1. Release B Subsystem Test Cases (2 of 2) 
·TLM-2060B Derived Parameter Processing 

·TLM-2070B Data Quality Determination 

·TLM-2080B Red/Yellow Limits Processing 

·TLM-2090B Delta Limits Processing 

·TLM-2150B Real-time Data Dropout 

·TLM-2160B Real-time Telemetry Archive and Merge 

·TLM-2170B Multiple Source TLM Data Receipt & Display 

·TLM-2190B Telemetry Replay Processing and Display 

Analysis: 
·ANA-2000B Dataset Generation - General Analysis 

·ANA-2020B Spacecraft Clock Correlation Based on RDD Method 

·ANA-2030B Spacecraft Clock Correlation Based on USCCS Method 

·ANA-2040B Special Processing Algorithms 

·ANA-2060B Time Order Down-link Report 

·ANA-2070B Parameter Out of Limits Report 

·ANA-2090B Analysis Products - Crossing Database Boundaries 

·ANA-2100B System Generated Statistics 

·ANA-2110B User Specified Statistics 

EDOS: 
·EDOS-2000B CODA Processing & Pre-command Readiness 

·EDOS-2002B Test Command Echo Exchange 

·EDOS-2010B SCS Summary Report Receipt & Display 

·EDOS-2030B Receive Trash Buffer Data and Forward to SAS/SDVF 

NCC: 
·NCC-2030B Request/Analyze User Performance Data (UPD) 

Contact 
· CONT-2010B DSS 

· CONT-2020B Spacecraft Activity Log 

· CONT-2030B SSR Monitoring 

· CONT-2040B Spacecraft State Check 
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Logical String Configuration, Control and Termination


Test Case No: SYS-2020B 

Test Configuration: See Appendix G 

Test Support: Real-Time Server, Data Server, 2 EOC user stations; telemetry (FtPgPackGen) and command-related (sc) 
drivers; tcpdump; dynamic pages built to display logical string information and to verify telemetry receipt. 

Test Case Description: 

This test is designed to verify the ability to configure the FOS resources in support of operational, test, and training 
activities. Following initialization of the FOS Servers and User Stations, logical strings are created for various 
combinations of data source (real-time or simulated) and mode (operational, test, or training). Several iterations of 
connecting to, disconnecting from, and deleting logical strings are performed. Telemetry processing and command 
generation is executed for each logical string mode. Telemetry decommutation is turned off, and later turned on, for a 
tailored string connection. Alphanumeric display pages containing logical string information are viewed for each logical 
string. Attempts to create existing strings, connect to non-existent strings, and delete connected strings are exercised. 

Success Criteria: 

This test is considered successful when initialization of real-time processes invoke the Real-Time server default logical 
string resources; additional logical strings can be created; logical strings can be deleted, but only by an authorized user who 
has taken ground control for the applicable string; logical strings can be created for valid combinations of data source and 
mode, i.e., real-time/operational, real-time/test, simulation/training, and simulation/test; a real-time logical string can 
coexist with another logical string; logical strings may be connected to, and disconnected from, via ECL directive; attempts 
to create existing strings, connect to non-existent strings, and delete connected strings are denied; logical string 
configuration is accurately portrayed by display pages; tailored string connections affect the tailored connection only; and 
telemetry is processed and commands generated for each logical string mode. 
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Step Id Action Expected Result/Output Pass/ 

Fail 

1. Log onto an EOC user station. 

Start the Data Server. 
of SYS2000B, ‘FOS Server and User Station 
Startup and Shutdown’. 

Data Server processes are running. 

2. Start two EOC User Stations. 
applicable steps of SYS2000B, ‘FOS Server and 
User Station Startup and Shutdown’. 

User station #1 -- User ID with ground control 
authority and command authority on a User Station 
configured for ground control and command. 

User station #2 -- User ID with at least ground 
control authority on a User Station configured for 
ground control. 

Notes: 
include User Stations #1 and #2; 

File /fosb/test/am1/config/gcuser.db must include 
EOC Users #1 and #2; 

File /fosb/test/am1/config/hw.db must include 
EOC User Station #1; 

File /fosb/test/am1/config/user.db must include 
EOC User #1. 

User Station #1 #2 -- Each user station is up when 
the ‘Control window’ is displayed. 

Execute the applicable steps 

Execute the 

File /fosb/test/am1/config/gchw.db must 
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3. User Station #1 #2 -- Invoke the Global Event 
Display. 

In the ‘Control window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Event_Display-Global’ 

User Station #1 #2 -- The ‘Tools’ menu comes up, 
then closes. 

The ‘Event Display’ comes up. 

4. Start the Real-Time Server. Execute the applicable 
steps of SYS2000B, ‘FOS Server and User Station 
Startup and Shutdown’. 

Real-Time Server processes are running. 

User Station #1 #2 -- The following event message 
appears: 

‘String 100 was Created’. 

5. User Station #1 #2 -- Attempt to take ground 
control authority. Enter the following ECL 
directive: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

User Station #1 #2 -- The following event message 
appears: 

‘Must be connected as Mirrored before requesting 
Ground Control Authority.’ 

6. User Station #1 -- Connect mirrored to string 100. 
Enter the following ECL directive: 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

User Station #1 -- The following event message 
appears (after several minutes): 

‘Successfully connected to string 100’. 

A ‘status’ window containing several SYS 
parameters comes up. 
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7. User Station #2 -- Connect tailored to logical 
String 100. Enter the following ECL directive: 

ECL> STRING CONNECT STRING=100 
CONFIG=TAILOR 

User Station #2 -- The following event message 
appears (after several minutes): 

‘Successfully connected to string 100’. 

A ‘status’ window containing several SYS 
parameters comes up. 

8. User station #1 -- Take ground control for String 
100. Enter the following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

User Station #1 -- The following event messages 
appear: 

‘Ground Control Authority has changed from 
<former user or EcDNull> to <User #1> for String 
100‘ 

9. User Station #1 -- Take command for String 100. 
Enter the following ECL directive: 

ECL> TAKE COMMAND STRING=100 

User Station #1 -- The following event message 
appears: 

‘Command Authority has changed from <former 
user or EcDNull> to <User #1> for String 100‘ 
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10. User Station #1 #2 -- Connect the logical string 
information display page to String 100. 

With the cursor on the display page, use the right 
mouse button to select ‘Data Source Selector’. 

In the ‘Data Source Switcher’ window: 

Click on ‘Refresh’ button; 

In the ‘Established Connections’ portion, select the 
row with String Id = 100, I channel; 

Select the existing row in ‘Assigned Connections’ 
portion; 

Click on ‘Switch Connection’ button; 

Click on ‘Close’ button. 

User Station #1 #2 -- The ‘Data Source Switcher’ 
window comes up. 

In the ‘Data Source Switcher’ window, the 
information selected in the ‘Established 
Connections’ portion overwrites the information in 
the ‘Assigned Connections’ portion. 

The ‘Data Source Switcher’ window contains the 
Status: ‘Data sources switched successfully’. 

The ‘Data Source Switcher’ window closes. 

The display page contains the following: 

SYS_ACTIVE_STRING_ID = 100 

SYS_CMD_AUTHOR_ID = <User #1> 

SYS_ CMD_AUTHOR_WS_ID = <User Station 
#1> 

SYS_DB_ID = 1.0 

SYS_BACKUP_RTS_ID = 0 

SYS_INACTIVE_RTS_ID = 0 

11. User Station #2 -- Create a real-time/test logical 
string. Enter the following ECL directive: 

ECL> STRING CREATE REALTIME 
SPACECRAFTID=AM1 
DATABASEID=1_0 MODE=TEST 
SERVER=1 

User Station #2 -- The following event message 
appears (after several minutes): 

‘String 101 was Created.’ 
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12. User Station #1 #2 -- Connect mirrored to logical 
String 101. Enter the following ECL directive: 

ECL> STRING CONNECT STRING=101 
CONFIG=MIRROR 

User Station #1 #2 -- The following event message 
appears (after several minutes): 

‘Successfully connected to string 101’. 

A ‘status’ window containing several SYS 
parameters comes up. 

13. User station #1 -- Take ground control for String 
101. Enter the following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=101 

User Station #1 -- The following event messages 
appear: 

‘Ground Control Authority has changed from 
<former user or EcDNull> to <User #1> for String 
101‘ 

14. User Station #1 -- Take command for String 101. 
Enter the following ECL directive: 

ECL> TAKE COMMAND STRING=101 

User Station #1 -- The following event message 
appears: 

‘Command Authority has changed from <former 
user or EcDNull> to <User #1> for String 101‘ 
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15. User Station #1 #2 -- Connect the logical string 
information display page to String 101. 

With the cursor on the display page, use the right 
mouse button to select ‘Data Source Selector’. 

In the ‘Data Source Switcher’ window: 

Click on ‘Refresh’ button; 

In the ‘Established Connections’ portion, select the 
row with String Id = 101, I channel; 

Select the existing row in ‘Assigned Connections’ 
portion; 

Click on ‘Switch Connection’ button; 

Click on ‘Close’ button. 

User Station #1 #2 -- The ‘Data Source Switcher’ 
window comes up. 

In the ‘Data Source Switcher’ window, the 
information selected in the ‘Established 
Connections’ portion overwrites the information in 
the ‘Assigned Connections’ portion. 

The ‘Data Source Switcher’ window contains the 
Status: ‘Data sources switched successfully’. 

The ‘Data Source Switcher’ window closes. 

The display page contains the following: 

SYS_ACTIVE_STRING_ID = 101 

SYS_CMD_AUTHOR_ID = <User #1> 

SYS_ CMD_AUTHOR_WS_ID = <User Station 
#1> 

SYS_DB_ID = 1.0 

SYS_BACKUP_RTS_ID = 0 

SYS_INACTIVE_RTS_ID = 0 

16. User Station #1 #2 -- Bring up two Housekeeping 
Telemetry display pages. 

In the ‘Control window’, click on the ‘TlmWins’ 
button. 

In the ‘Tlm Wins’ menu, select ‘TLM-2010B’. 

Repeat this step again. 

User Station #1 #2 -- The ‘Telemetry Window 
Selection’ menu comes up, then closes. 

The ‘TLM-2010B’ Housekeeping telemetry 
display page comes up. 

The same expected result occurs again. 
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17. User Station #1 #2 -- Connect one Housekeeping 
Telemetry display page to String 100. 

With the cursor on the Housekeeping Telemetry 
display page, use the right mouse button to select 
‘Data Source Selector’. 

In the ‘Data Source Switcher’ window: 

Click on ‘Refresh’ button; 

In the ‘Established Connections’ portion, select the 
row with String Id = 100, I channel; 

Select the existing row in ‘Assigned Connections’ 
portion; 

Click on ‘Switch Connection’ button; 

Click on ‘Close’ button. 

User Station #1 #2 -- The ‘Data Source Switcher’ 
window comes up. 

In the ‘Data Source Switcher’ window, the 
information selected in the ‘Established 
Connections’ portion overwrites the information in 
the ‘Assigned Connections’ portion. 

The ‘Data Source Switcher’ window contains the 
Status: ‘Data sources switched successfully’. 

The ‘Data Source Switcher’ window closes. 

18. User Station #1 #2 -- Connect the second 
Housekeeping Telemetry display page to String 
101 by re-executing the preceding step with the 
following exception: 

In the ‘Established Connections’ portion of the 
‘Data Source Switcher’ window, select the row 
with String Id = 101, I channel. 

User Station #1 #2 -- The data source is switched 
to String 101, I-channel. 
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19. User Station #1 -- Invoke the telemetry driver for 
the multicast of telemetry packets. 

In a new cmdtool window, enter the following: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: setenv SCRIPT UserStation 

%: source FosEnvVars 

%:cd/fosb/test/am1/bin/sun_sparc_5-5 
(bin is alias) 

%: FtPgPackGen 

User Station #1 -- The following message appears 
in the window where the FtPgPackGen tool is 
running: 

‘Packet Generator is ready to receive directives.’ 

20. User Station #1 -- Start the multicast of real

time/operational/I-channel housekeeping 
telemetry packets for processing. Enter the 
following ECL directives: 

ECL> PG CONFIG HOST=225.2.7.00 
PORT=20001 APID=1 

ECL> PG STARTDATA APID=1 
COUNT=-1 

(Note: The IP address and port number is in the 
file 
‘/fosb/test/am1/config/FoSwConfigData.cnfg’.) 

User Station #1 #2 -- Telemetry values are updated 
on the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 100. 

For the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 101, all 
parameter values remain static at their initial 
values. 
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21. User Station #2 -- Turn off the decommutation of 
all telemetry at this user station for String 100. 
Enter the following ECL directive: 

ECL> DECOM SEL=ALL MODE=OFF 
STRING=100 

User Station #1 -- Telemetry values are updated on 
the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 100. 

User Station #2 -- Telemetry values are n o t  
updated on the ‘TLM-2010B’ Housekeeping 
Telemetry display pages connected to String 100. 

User Stations #1 #2 -- For the ‘TLM-2010B’ 
Housekeeping Telemetry display pages connected 
to String 101, all parameter values remain static at 
their initial values. 

22. User Station #2 -- Turn on the decommutation of 
all telemetry at this user station for String 100. 
Enter the following ECL directive: 

ECL> DECOM SEL=ALL MODE=ON 
STRING=100 

User Stations #1 #2 -- Telemetry values are 
updated on the ‘TLM-2010B’ Housekeeping 
Telemetry display pages connected to String 100. 

For the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 101, all 
parameter values remain static at their initial 
values. 

23. User Station #1 -- Stop the flow of telemetry. 
Enter the following ECL directive: 

ECL> PG STOPDATA APID=1 

User Stations #1 #2 -- Telemetry values are no 
longer updated on the ‘TLM-2010B’ 
Housekeeping Telemetry display pages connected 
to String 100, and the values go static. 

For the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 101, all 
parameter values remain static at their initial 
values. 
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24. User Station #1 -- Start the multicast of real

time/test/I-channel housekeeping telemetry 
packets for processing. Enter the following ECL 
directives: 

ECL> PG CONFIG HOST=225.2.7.20 
PORT=20020 APID=1 

ECL> PG STARTDATA APID=1 
COUNT=-1 

(Note: The IP address and port number is in the 
file 
‘/fosb/test/am1/config/FoSwConfigData.cnfg’.) 

User Station #1 #2 -- Telemetry values are updated 
on the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 101. 

For the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 100, all 
parameter values remain static at their initial 
values. 

25. User Station #1 -- Stop the flow of telemetry. 
Enter the following ECL directive: 

ECL> PG STOPDATA APID=1 

User Stations #1 #2 -- Telemetry values are no 
longer updated on the ‘TLM-2010B’ 
Housekeeping Telemetry display pages connected 
to String 101, and the values go static. 

For the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 100, all 
parameter values remain static at their initial 
values. 

26. Logical String Command Subprocedure Start 
(next step) 

(No expected result/output; information only) 
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27. User Station #1 -- Remotely log in to the Real-
Time Server by entering the following in a new 
cmdtool window. 

%: rlogin <RealTimeServer> 

At the Real-Time Server prompt, enter the 
following: 

%: cd /fosb/test/am1/scripts/setup (test is 
alias) 

%: setenv SCRIPT RealTimeServer 

%: source FosEnvVars 

%: cd /fosb/test/am1/bin/sun_sparc_5-5 
(bin is alias) 

%: sc AM1 100 Ops 

User Station #1 -- The remote login to the Real-
Time Server is successful. 

The following message appears repeatedly in the 
Real-Time Server cmdtool window: 

‘sc Waiting for messages’ 

28. User Station #1 -- Initiate the tcpdump tool to 
capture real-time, operational commands. 

In a new cmdtool window, enter the following: 

%: tcpdump -v port 20058 

User Station #1 -- The following message appears 
in the cmdtool window: 

‘listening on le0’ 
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29. User Station #1 -- From the Control window, bring 
up the ‘Command Control window’. 

In the ‘Control window’, click on the ‘Tools’ 
button. 

In the ‘Tools’ menu, select ‘Command_Control’ 

In the Command Control dialog box, enter the 
following: 

String ID: 100 

Spacecraft ID: AM1 

User Station #1 -- The ‘Tools’ menu comes up. 

The ‘Command Control window’ comes up. 

The Command Control dialog box comes up and 
then closes after user input. 

30. User Station #1 -- In the ‘Config’ pull-down menu 
of the ‘Command Control window’, set the 
following: 

Cmd Verification (CV): Off 

Tlm Verification (TV): Off 

In the ‘Command Control window’, enter the 
following in the CMD field: 

FOP INIT CHECK 

Click on ‘Resume’ button 

Click on ‘Send’ button 

Click on ‘Suspend’ button 

User Station #1 -- In the ‘Command Control 
window’, the following occurs: 

The ‘CV’ and ‘TV’ indicators are both ‘Off’. 

The ‘DIRECTIVE’ column contains ‘FOP INIT 
CHECK’. 

After the ‘Resume’ button is clicked, the 
Send/Cancel options are activated. 

After the ‘Send’ button is clicked, the STATUS 
column includes ‘Processed -2 | Sent to subsys’. 

The following event messages appear: 

‘StringMgr process successfully configured’; 

‘Protocol Info: FOP INIT with CLCW check 
successful’. 
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31. User Station #1 -- In the ‘Command Control 
window’, enter the following in the CMD field: 

/AST_TURN_OFF_C_SDP 

Click on ‘Resume’ button 

Click on ‘Send’ button 

Click on ‘Override’ button 

Click on ‘Kill’ button 

User Station #1 -- In the ‘Command Control 
window’, the following occurs: 

The  DIRECTIVE co lumn con ta ins  
‘/AST_TURN_OFF_C_SDP’. 

After the ‘Resume’ button is clicked, the 
Send/Cancel options are activated. 

After the ‘Send/Override’ button is clicked, the 
STATUS column includes ‘TV Fail -3 | CV Pass -2 
| Processed -2 | Sent to FOP | Sent to subsys’. 

The following event messages appear: 

‘Command AST_TURN_OFF_C_SDP was 
successfully build with binary = ...’; 

‘CLTU id AST_TURN_OFF_C_SDP placed in 
command data block number 1’; 

‘Command Data Block number 1 sent to EDOS’; 

‘Command AST_TURN_OFF_C_SDP timed out -­
verification failure.’ 

A message in the window where tcpdump is 
running indicates that a command has been sent. 

A warning dialog states the ground script will be 
removed. 

The ‘Command Control window’ closes. 
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32. User Station #1 -- In the window containing the 
remote login to the Real-Time Server, depress the 
following two keys simultaneously: 

Ctrl C 

User Station #1 -- The ‘sc’ tool quits, and a UNIX 
prompt is received from the Real-Time Server. 

33. User Station #1 -- In the window containing 
tcpdump, depress the following two keys 
simultaneously: 

Ctrl C 

User Station #1 -- The ‘tcpdump’ tool quits, and a 
UNIX prompt is received from the user station. 

34. Logical String Command Subprocedure End 
(preceding step) 

(No expected result/output; information only) 

35. User Station #1 -- Execute the ‘Logical String 
Command Subprocedure’ with the following 
exceptions: 

At the Real-Time Server prompt, enter the 
following: 

%: sc AM1 101 Test 

In the window where tcpdump was running, enter 
the following: 

%: tcpdump -v port 20059 

In the Command Control dialog box, enter the 
following: 

String ID: 101 

Spacecraft ID: AM1 

User Station #1 -- The following event messages 
appear: 

FOP-related and AST_TURN_OFF_C_SDP­
related messages as indicated in the ‘Logical String 
Command Subprocedure.’ 

A message in the window where tcpdump is 
running indicates that a command has been sent. 
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36. User Station #1 -- Attempt to delete String 101. 
Enter the following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #1 -- The following event message 
appears: 

‘Unable to delete String 101 when users are 
connected. Suggest notifying users to disconnect 
from String.’ 

37. User Station #1 -- Disconnect from String 101. 
Enter the following ECL directive: 

ECL> STRING DISCONNECT 
STRING=101 

User Station #1 -- The following event messages 
appear: 

‘User successfully disconnected from String 101’ 

38. User Station #1 -- Attempt to delete String 101. 
Enter the following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #1 -- The following event message 
appears: 

‘Unable to delete String 101 when users are 
connected. Suggest notifying users to disconnect 
from String.’ 

39. User Station #2 -- Disconnect from String 101. 
Enter the following ECL directive: 

ECL> STRING DISCONNECT 
STRING=101 

User Station #2 -- The following event message 
appears: 

‘User successfully disconnected from String 101’ 

40. User Station #2 -- Attempt to delete string 101. 
Enter the following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #2 -- The following event message 
appears: 

‘User is not the Ground Controller for string 101. 
User must have Ground Control Authority before 
requesting this service.’ 
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41. User Station #1 -- Delete String 101. Enter the 
following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #1 -- The following event message 
appears: 

‘String 101 was deleted.’ 

42. User Station #1 -- Delete String 101. Enter the 
following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #1 -- The following event message 
appears: 

‘Unable to locate string 101. User should make 
sure directive contains correct string ID.’ 

43. User Station #1 -- Attempt to connect mirrored to 
String 101. Enter the following ECL directive: 

ECL> STRING CONNECT STRING=101 
CONFIG=MIRROR 

User Station #1 -- The following event message 
appears: 

‘Unable to locate string 101. User should make 
sure directive contains correct string ID.’ 

44. User Station #1 -- Attempt to disconnect from 
String 101. Enter the following ECL directive: 

ECL> STRING DISCONNECT 
STRING=101 

User Station #1 -- The following event message 
appears: 

‘Unable to locate string 101. User should make 
sure directive contains correct string ID.’ 

45. User Station #1 -- Create a simulation/training 
logical string. Enter the following ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 
DATABASEID=1_0 MODE=TRAINING 
SERVER=1 

User Station #1 -- The following event message 
appears: 

‘String 101 was Created.’ 
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46. User Station #1 #2-- Connect mirrored to logical 
String 101. Enter the following ECL directive: 

ECL> STRING CONNECT STRING=101 
CONFIG=MIRROR 

User Station #1 #2 -- The following event message 
appears (after several minutes): 

‘Successfully connected to string 101’. 

A ‘status’ window containing several SYS 
parameters comes up. 

47. User station #1 -- Take ground control for String 
101. Enter the following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=101 

User Station #1 -- The following event messages 
appear: 

‘Ground Control Authority has changed from 
<former user or EcDNull> to <User #1> for String 
101‘ 

48. User Station #1 -- Take command for String 101. 
Enter the following ECL directive: 

ECL> TAKE COMMAND STRING=101 

User Station #1 -- The following event message 
appears: 

‘Command Authority has changed from <former 
user or EcDNull> to <User #1> for String 101‘ 
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49. User Station #1 #2 -- Connect the logical string 
information display page to String 101. 

With the cursor on the display page, use the right 
mouse button to select ‘Data Source Selector’. 

In the ‘Data Source Switcher’ window: 

Click on ‘Refresh’ button; 

In the ‘Established Connections’ portion, select the 
row with String Id = 101, I channel; 

Select the existing row in ‘Assigned Connections’ 
portion; 

Click on ‘Switch Connection’ button; 

Click on ‘Close’ button. 

User Station #1 #2 -- The ‘Data Source Switcher’ 
window comes up. 

In the ‘Data Source Switcher’ window, the 
information selected in the ‘Established 
Connections’ portion overwrites the information in 
the ‘Assigned Connections’ portion. 

The ‘Data Source Switcher’ window contains the 
Status: ‘Data sources switched successfully’. 

The ‘Data Source Switcher’ window closes. 

The display page contains the following: 

SYS_ACTIVE_STRING_ID = 101 

SYS_CMD_AUTHOR_ID = <User #1> 

SYS_ CMD_AUTHOR_WS_ID = <User Station 
#1> 

SYS_DB_ID = 1.0 

SYS_BACKUP_RTS_ID = 0 

SYS_INACTIVE_RTS_ID = 0 
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50. User Station #1 #2 -- Re-connect the Housekeeping 
Telemetry display page that was connected to the 
‘old’ String 101 to the current String 101. 

With the cursor on the Housekeeping Telemetry 
display page, use the right mouse button to select 
‘Data Source Selector’. 

In the ‘Data Source Switcher’ window: 

Click on ‘Refresh’ button; 

In the ‘Established Connections’ portion, select the 
row with String Id = 101, I channel; 

Select the existing row in ‘Assigned Connections’ 
portion; 

Click on ‘Switch Connection’ button; 

Click on ‘Close’ button. 

User Station #1 #2 -- The ‘Data Source Switcher’ 
window comes up. 

In the ‘Data Source Switcher’ window, the 
information selected in the ‘Established 
Connections’ portion overwrites the information in 
the ‘Assigned Connections’ portion. 

The ‘Data Source Switcher’ window contains the 
Status: ‘Data sources switched successfully’. 

The ‘Data Source Switcher’ window closes. 

51. User Station #1 -- Start the multicast of 
simulation/training/I-channel housekeeping 
telemetry packets for processing. Enter the 
following ECL directives: 

ECL> PG CONFIG HOST=225.2.7.40 
PORT=20070 

ECL> PG STARTDATA APID=1 
COUNT=-1 

(Note: The IP address and port number is in the 
file 
‘/fosb/test/am1/config/FoSwConfigData.cnfg’.) 

User Station #1 #2 -- Telemetry values are updated 
on the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 101. 

For the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 100, all 
parameter values remain static at their initial 
values. 
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52. User Station #1 -- Stop the flow of telemetry. 
Enter the following ECL directive: 

ECL> PG STOPDATA 

User Stations #1 #2 -- Telemetry values are no 
longer updated on the ‘TLM-2010B’ 
Housekeeping Telemetry display pages connected 
to String 101, and the values go static. 

For the ‘TLM-2010B’ Housekeeping Telemetry 
display pages connected to String 100, all 
parameter values remain static at their initial 
values. 

53. User Station #1 -- In the window containing the 
‘FtPgPackGen’ telemetry driver, depress the 
following two keys simultaneously: 

Ctrl C 

User Station #1 -- The ‘FtPgPackGen’ tool quits, 
and a UNIX prompt is received. 

54. User Station #1 -- Execute the ‘Logical String 
Command Subprocedure’ with the following 
exceptions: 

At the Real-Time Server prompt, enter the 
following: 

%: sc AM1 101 Training 

In the window where tcpdump was running, enter 
the following: 

%: tcpdump -v port 20098 

In the Command Control dialog box, enter the 
following: 

String ID: 101 

Spacecraft ID: AM1 

User Station #1 -- The following event messages 
appear: 

FOP-related and AST_TURN_OFF_C_SDP­
related messages as indicated in the ‘Logical String 
Command Subprocedure.’ 

A message in the window where tcpdump is 
running indicates that a command has been sent. 
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55. User Station #1 -- In the window containing the 
remote login to the Real-Time Server, enter the 
following to log out from the Real-Time Server: 

%: exit 

User Station #1 -- A UNIX prompt is received 
from <User Station #1>. 

56. User Station #2 -- Attempt to delete String 101. 
Enter the following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #2 -- The following event message 
appears: 

‘User is not the Ground Controller for string 101. 
User must have Ground Control Authority before 
requesting this service.’ 

57. User Station #1 -- Attempt to delete String 101. 
Enter the following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #1 -- The following event message 
appears: 

‘Unable to delete String 101 when users are 
connected. Suggest notifying users to disconnect 
from String.’ 

58. User Station #1 #2 -- Disconnect from String 101. 
Enter the following ECL directive: 

ECL> STRING DISCONNECT 
STRING=101 

User Station #1 #2 -- The following event 
messages appear: 

‘User successfully disconnected from String 101’ 

59. User Station #2 -- Attempt to delete string 101. 
Enter the following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #2 -- The following event message 
appears: 

‘User is not the Ground Controller for string 101. 
User must have Ground Control Authority before 
requesting this service.’ 
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60. User Station #2 -- Attempt to create a 
simulation/test logical string. Enter the following 
ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 
DATABASEID=1_0 MODE=TEST 
SERVER=1 

User Station #2 -- The following event message 
appears: 

‘User illegally trying to create a Simulation string. 
Suggest making sure that string’s mode is valid.’ 

(Note: Cannot have simulation/training and 
simulation/test logical strings simultaneously.) 

61. User Station #1 -- Delete String 101. Enter the 
following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #1 -- The following event message 
appears: 

‘String 101 was deleted.’ 

62. User Station #1 -- Attempt to create a 
simulation/operational logical string. Enter the 
following ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 
DATABASEID=1_0 
MODE=OPERATIONAL SERVER=1 

User Station #1 -- The following event message 
appears: 

‘User trying to create a Simulation String with an 
invalid mode.’ 

(Note: A simulation/operational logical string is an 
invalid combination.) 

63. User Station #2 -- Create a simulation/test logical 
string. Enter the following ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 
DATABASEID=1_0 MODE=TEST 
SERVER=1 

User Station #2 -- The following event message 
appears: 

‘String 101 was Created.’ 
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64. User Station #1 #2-- Connect mirrored to logical 
String 101. Enter the following ECL directive: 

ECL> STRING CONNECT STRING=101 
CONFIG=MIRROR 

User Station #1 #2 -- The following event message 
appears (after several minutes): 

‘Successfully connected to string 101’. 

A ‘status’ window containing several SYS 
parameters comes up. 

65. User station #1 -- Take ground control for String 
101. Enter the following ECL directive: 

ECL> TAKE GROUNDCONTROL 
STRING=101 

User Station #1 -- The following event messages 
appear: 

‘Ground Control Authority has changed from 
<former user or EcDNull> to <User #1> for String 
101‘ 

66. User Station #1 -- Take command for String 101. 
Enter the following ECL directive: 

ECL> TAKE COMMAND STRING=101 

User Station #1 -- The following event message 
appears: 

‘Command Authority has changed from <former 
user or EcDNull> to <User #1> for String 101‘ 
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67. User Station #1 #2 -- Connect the logical string 
information display page to String 101. 

With the cursor on the display page, use the right 
mouse button to select ‘Data Source Selector’. 

In the ‘Data Source Switcher’ window: 

Click on ‘Refresh’ button; 

In the ‘Established Connections’ portion, select the 
row with String Id = 101, I channel; 

Select the existing row in ‘Assigned Connections’ 
portion; 

Click on ‘Switch Connection’ button; 

Click on ‘Close’ button. 

User Station #1 #2 -- The ‘Data Source Switcher’ 
window comes up. 

In the ‘Data Source Switcher’ window, the 
information selected in the ‘Established 
Connections’ portion overwrites the information in 
the ‘Assigned Connections’ portion. 

The ‘Data Source Switcher’ window contains the 
Status: ‘Data sources switched successfully’. 

The ‘Data Source Switcher’ window closes. 

The display page contains the following: 

SYS_ACTIVE_STRING_ID = 101 

SYS_CMD_AUTHOR_ID = <User #1> 

SYS_ CMD_AUTHOR_WS_ID = <User Station 
#1> 

SYS_DB_ID = 1.0 

SYS_BACKUP_RTS_ID = 0 

SYS_INACTIVE_RTS_ID = 0 

68. User Station #1 -- Attempt to create another real­
time/operational logical string. Enter the 
following ECL directive: 

ECL> STRING CREATE REALTIME 
SPACECRAFTID=AM1 
DATABASEID=1_0 
MODE=OPERATIONAL SERVER=1 

User Station #1 -- The following event message 
appears: 

‘User trying to create a Realtime string that already 
exists’ 
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69. User Station #1 -- Attempt to create another 
simulation/test logical string. Enter the following 
ECL directive: 

ECL> STRING CREATE SIMULATION 
SPACECRAFTID=AM1 
DATABASEID=1_0 MODE=TEST 
SERVER=1 

User Station #1 -- The following event message 
appears: 

‘User trying to create a Simulation string that 
already exists’ 

70. User Station #1 -- Attempt to create a real­
time/training logical string. Enter the following 
ECL directive: 

ECL> STRING CREATE REALTIME 
SPACECRAFTID=AM1 
DATABASEID=1_0 MODE=TRAINING 
SERVER=1 

User Station #1 -- The following event message 
appears: 

‘User trying to create a Realtime string with an 
invalid mode.’ 

(Note: A real-time/training logical string is an 
invalid combination.) 

71. User Station #1 #2 -- Disconnect from String 101. 
Enter the following ECL directive: 

ECL> STRING DISCONNECT 
STRING=101 

User Station #1 #2 -- The following event 
messages appear: 

‘User successfully disconnected from String 101’ 

72. User Station #2 -- Attempt to delete String 101. 
Enter the following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #1 -- The following event message 
appears: 

‘User is not the Ground Controller for string 101. 
User must have Ground Control Authority before 
requesting this service.’ 

73. User Station #1 -- Delete String 101. Enter the 
following ECL directive: 

ECL> STRING DELETE STRING=101 

User Station #1 -- The following event message 
appears: 

‘String 101 was deleted.’ 
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74. End of test. 
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Procedure Control & Execution (Final: August 29, 1997)


Test Case No: FUI-2060B 

Test Configuration: See Appendix G 

Test Support: A DAS; a set of validated procedures which include command, ground and local procedure types; a 
procedure that invokes another procedure; at least three (3) local type procedures. 

Test Case Description: 

This test is designed to verify the capability of the authorized users to execute procedures, suspend execution, resume 
execution, and 
user station, attaching to the operational string and executing a local procedure, suspending the execution of the procedure, 
resuming the procedure. 
terminated. 
procedures will be verified, restrictions for execution will be verified and the capability to monitor procedure execution will 
be performed. 

Success Criteria: 

This test is considered successful when the user is able to execute a non-command procedure from his workstation and to 
monitor and control the execution of the procedure from a system provided display; execute multiple local procedures 
simultaneously; suspend an executing procedure; resume execution of a suspended procedure; terminate an executing 
procedure; the system allows only one ground system procedure per logical string to execute at a time; the system allows an 
authorized user to invoke a command procedure consisting of more than one command; the system restrict command 
procedures to be active one at a time; the EOC requires a user authorization (allow or cancel) prior to up-linking a critical 
command; the system will allow procedures to invoke other procedures; 
time. 

Step Id Action Expected Result/Output Pass/ 
Fail 

The test begins with bringing up a terminate execution in accordance with system controls and restrictions. 

Multiple local procedures will then be executed simultaneously and one of the procedures will be 
Required authority for these Command type procedures and Ground type procedures will be executed. 

and the user can invoke a procedure at a specified 
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-- 

1. Log onto an EOC workstation. 

Start the Data Server. Reference Test Case 
SYS2000B – FOS Server Startup 

Data server processes are running. 

2. Start the Real-Time Server. Reference Test Case 
SYS2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

3. Log onto an FOT User Station. 

Start the User Station. Reference Test Case 
SYS2010B User Station Startup and 
Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

4. Click on the ‘Tools…’ button The Tools dialog window is dispayed. 

5. Select Event_Display-Global and click ‘OK’ The Tools dialog window closed and the Event 
Display window opened. 

6. In the Control window ECL text field enter: 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

The following event messages are displayed: 

Establishing ParameterServer service… 

ParameterServer process successfully configured. 

Establishing Decom service…. 

Decom process successfully configured 

StringMgr process connected to String 100 

Successfully connected to string 100. 

7. In the Control window ECL text field enter: 

ECL> START Local1 (local proc) 

Event messages are displayed in the Event Display 
and Control window as each directive is executed. 
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8. In the Control window ECL text field enter: 

ECL> START Local1 TIME=HH:MM:SS 

ECL> START TESTPROC1 
TIME=HH:MM:SS (same time + 1 second) 

At HH:MM:SS both local procedures start. Event 
messages are displayed in the Event Display window 
and the procedure steps flash as they are executed in 
the Procedure Control window and the status is 
updated. 

9. Click on the ‘Tools…’ button in the Control 
window. 

The Tools dialog window is displayed. 

10. Select Procedure_Control and click ‘OK’ The Procedure Control window is displayed. 

11. Click on the ‘File’ pull-down menu and select 
Open 

The Open File dialog box opened. 

12. Select file name Local1 from the file list and click 
on the ‘OK’ button 

The Open File dialog box closed and the Procedure 
Control window is populated with procedure name, 
status, start time and procedure steps. The procedure 
is in the Suspended state and the Step mode. 

13. Click on ‘Auto’ button 

Click on ‘Resume’ button. 

Click on ‘Suspend’ button. 

The procedure status changed from Suspended to 
Active when the Resume button was clicked and 
ECL directives started executing and the Directive 
Status fields started updating. 

The procedure status changed from Active to 
Suspended when the Suspend button was clicked and 
the ECL directives stopped executing. 

14. In the Procedure Control window click ‘Resume’ 
and then ‘Suspend’ and then ‘Kill’ 

The Procedure Status changes from Suspended to 
Active to Suspended to Terminated 

15. Click the ‘Close’ button on the Procedure Control 
window and select Close 

The Procedure Control window closed. 
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16. In the Control window ECL text field enter: 

ECL> TAKE COMMAND STRING=100 

The following event messages are displayed: 

Command Authority has changed from EcDNull to 
fostest2 

Command Authority of NccGroundMgr changed to 
user: fostest2 

Command Authority of NccStatusMgr changed to 
users wks: fossws<ws_id> 

Command Authority starting fossws<ws_id> for 
string 100 

17. In the Control window ECL text field enter: 

ECL> TOOL Command_Control 

A dialog box appears to enter Sting and Spacecraft 
ID. 

18. In the dialog box enter: 

STRING=100 

SPACECRAFT ID = AM1 

and click ‘OK’ 

The dialog box closed and the Command Control 
window is displayed with all five user interface (pull 
down) menus; File, Edit, Config, Utility, and Help. 

There are five columns: DATE/TIME, ATC_LOC, TYPE, 

DIRECTIVE, STATUS (Note: User may need to resize 
window if all columns are not displayed) 

19. In the Control window ECL text field enter: 

TAKE GROUNDCONTROL 
STRING=100 

The following event messages are displayed: 

StringMgr process successfully fonfigured 

Ground Control Authority has changed from 
EcDNull to fostest2 

Ground Control starting fosswsxx for string 100. 
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20. Create a new xterm window and remote login to the 
real-time server. 

%rlogin <real-time server id> 

%<password> 

%test 

%setenv SCRIPT RealTimeServer 

%source FosEnvVars 

%cd ../.. 

%cd bin/sun_sparc_5-5 

%sc AM1 100 Ops 

The xterm window starts displaying 

21. Click on the ‘Config’ pulldown menu in the 
Command Control window and select Command 
Verification and Telemetry Verification to set them 
to ‘OFF” 

CV and TV status in the Command Window show 
OFF. 
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22. Enter the following command in the Command 
Control window: 

FOP INIT CHECK 

Click on the ‘RESUME’ button. 

Click on the ‘Send” button. 

Click on the ‘Suspend’ button. 

The directive FOP INIT CHECK appears in the 
Ground Script of the Command Control window. 

The status of the directive in the Command Control 
window flashes Send/Cancel with yellow 
background. 

Status indicates ‘Processed -2 | Sent to subsys | 
Send/cancel’ 

Event messages ‘StringMgr process successfully 
configured’ and ‘Protocol Info : FOP INIT with 
CLCW check successful’ are displayed. 

23. In the Command Control window CMD text field 
enter: 

CMD> START <procname> 
TIME=HH:MM:SS 

(command proc; procedure contains a critical 
command; HH:MM:SS close to current time) 

Click ‘Allow’ in response to the critical command. 

The command proc is inserted into the Ground Script 
for execution. 

The procedure is executed at the start time 
designated. 

Event messages are received confirming the 
execution of the procedure steps. 

An allow/cancel message will flash in the status 
column of the Command Control window for the 
critical command. 

24. At another userstation take ground control of string 
100. 

Event messages will appear indicating ground contrl 
has changed to another userstation. 
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25. In the Command Control window CMD text field 
enter: 

CMD> START <procname> 

(ground control proc) 

An errr message is displayed stating user does not 
have ground control. 

26. Click on ‘Close’ button of the Command Control 
window and select Quit from the drop down menu. 

The Command Control window closed. 

27. In the Control window ECL text field enter: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

Event message is displayed acknowledging user_id 
and workstation_id has ground control. 

28. In the Control window ECL text field enter: 

ECL> START <procname1> 
TIME=HH:MM:SS 

(procname1= ground control procedure) 

ECL> START <procname2> 
TIME=HH:MM:SS 

(procname2= ground control procedure, 
HH:MM:SS is two seconds later than 
procname1 start time) 

An event message for the first procedure is displayed 
indicating the start time. 

An event message indicating the procedure cannot 
be executed because of another procedure being 
processed. 

29. Click on the ‘Tools…’ button in the Control 
window. 

The Tools dialog window is displayed. 

30. Select Procedure_Control and click ‘OK’ The Procedure Control window is displayed. 

31. Click on ‘File’ and select Open from the pull-down 
menu. 

The procedure dialog box opened listing the 
procedures in the directory. 
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32. Select Local1 from the directory listing and click 
‘OK’. 

Procedure Local1 is listed in the Procedure Control 
window and the window is in the Step-Mode. 

33. Click ‘Auto’ 

Click ‘Resume’ 

Click ‘Suspend’ 

The Mode changed to Auto. 

The procedure started executing. 

The procedure stopped executing. 

34. In the ECL text field of the Procedure Control 
window enter: 

ECL> START TESTPROC1 

and insert the directive in the procedure at case2: 

The directive was inserted in the procedure. 

35. Click on the ‘Resume’ button. The procedure continued execution. When the 
START TESTPROC1 directive was executed the 
steps of TESTPROC1 were inserted into the existing 
procedure and executed. The existing procedure 
then continued to execute from the point 
TESTPROC1 was inserted. 

36. At the end of execution of the previous procedure, 

in the Control window ECL text field enter: 

ECL> BYE 

The user is logged off of the workstation. 

37. End of test. 
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OASIS/CSTOL Conversion Test Procedure


Test Case No: FUI-2080B 

Test Configuration: See Appendix G 

Test Support: An OASIS file to be used for conversion 

Test Dependencies:  The Translator/Converter. 

Test Case Description: 

This test is designed to verify the ability to test the functionality of the CSTOL translators ability to convert OASIS 
directives into useable ECL directives. 

This test begins with an X-window is opened and the CSTOL translator utility is activated. 
once to create a fully translated file. 
performed to create another full conversion (the difference being that the input file has been modified). 
completion of the second conversion, a third conversion will be run. 
did not convert fully. 

Success Criteria: 

This test is considered successful when the conversions have been completed successfully (both types; full and partial) and 
error messages are displayed indicating the unconverted directives. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Logon to an FOS workstation Access to the workstation will be obtained 

The conversion is performed 
Following the successful completion of the first conversion, a second conversion will be 

Following the 
This file will also be modified to reflect directives that 

Error messages will appear in the partially converted file. 
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2. Open a terminal window. 

Place the pointer on the screen background 

Press the Right most mouse button 

Select “Programs” from the menu 

Select “Xterm” from the menu 

Release the mouse button. 

An X window will open. 

3. Full translation: 

At the Unix prompt enter: 

%:cd /fosb/test/am1/bin/sun_sparc_5-5 

sun_sparc_5-5 is where the executable file resides. 

4. At the Unix prompt enter: 

%:ls Fu* 

Check the listing for the executable file 
FuCsTranslate. 

5. Open a terminal window. 

Place the pointer on the screen background 

Press the Right most mouse button 

Select “Programs” from the menu 

Select “Xterm” from the menu 

Release the mouse button. 

An X window will open. 

6. At the Unix prompt enter: 

%:cd /fosb/test/am1/data 

The data directory is where the “CSTOL” (input) 
files reside. 
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7. At the Unix prompt enter: 

%:ls -la 

Check the listing for the “CSTOL” (input) files: 

FuCs_1 

cstolmath 

8. Place pointer in the first Xterm window with the 
directory path of /fosb/test/am1/bin/sun_sparc_5-5 
and click to activate the screen and enter at the 
Unix prompt: 

%:FuCsTranslate -i 
“/fosb/test/am1/data/FuCs_1” -o 
“/fosb/test/am1/data/fullcon.ecl” 

Note: The above is all one command line and the 
path names may very depending where the input 
files reside and where the out put files need to 
reside. 

This will activate the conversion utility and convert 
FuCs_1 to fullcon.ecl. 

9. Place pointer in the second Xterm window with the 
directory path of /fosb/test/am1/data and click to 
activate the screen and enter at the Unix prompt: 

%:ls -la 

The file fullcon.ecl should be in the data directory. 

10. At the Unix prompt enter: 

%:textedit fullcon.ecl & 

File fullcon.ecl will show a commented header about 
how to read the file and the results of the translation. 
It will also show an error count of zero (0) and 
warning count, if any. This file will show the 
comments from the CSTOL file that were carried 
over, and new comments that were added when 
necessary. 
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11. At the Unix prompt enter: 

%:textedit FuCs_1  & 

Compare FuCs_1 to fullcon.ecl. 

12. In the textedit window go to the file pull down 
menu. 

Using the left most mouse button 

Select Quit 

Note: Do this step twice, once in each texteditor 
window. 

The textedit window will close. 

13. Modify the input file: 

At the Unix prompt enter: 

%:cp FuCs_1 Testinput_1 

This will create a copy of FuCs_1. The copy file 
Testinput_1 will be modified to reflect errors. 

14. At the Unix prompt enter: 

%:vi Testinput_1 

The vi editor will open Testinput_1. 

15. Press the [ESC] key 

Type: 

:set nu 

This will enable line numbering in the vi editor. 
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16. Arrow down to line 14 of the file. 

Arrow to 5:7 

Press Shift R 

Type: 

7:9 

Line 14 will be modified to read: 

VARIABLE 

17. Press [ESC] key 

Arrow down to line 17 

Arrow to abcd efg 

Press Shift R 

Type: 

zxdr adc 

Line 17 will be modified to read: 

DECLARE 

18. Press [ESC] key 

Arrow down to line 28 

Arrow to abc 

Press Shift R 

Type: 

zxd 

Line 28 will be modified to read: 

LET 
((7 

7:9 1.5 = $a 

abc” “zxdr = $c INPUT 

+ SQRT(3+2)) * SIN(3 + (-$B $c ** = $a 
$zxd)) / -50 $C) * 9 -
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19. Press [ESC] key 

Type: 

:wq 

The file Testinput_1 is modified and saved. 

20. Place pointer in the first Xterm window with the 
directory path of /fosb/test/am1/bin/sun_sparc_5-5 
and click to activate the screen and enter at the 
Unix prompt: 

%: FuCsTranslate -i 
“/fosb/test/am1/data/Testinput_1” -o 
“/fosb/test/am1/data/errors_1.ecl” 

Note: The above is all one command line and the 
path names may very depending where the input 
files reside and where the out put files need to 
reside. 

This will activate the conversion utility and convert 
Testinput_1 to errors_1.ecl. 

21. Place pointer in the second Xterm window with the 
directory path of /fosb/test/am1/data and click to 
activate the screen and enter at the Unix prompt: 

%:ls -la 

The file errors_1.ecl should be in the data directory. 

22. At the Unix prompt enter: 

%:textedit errors_1.ecl & 

File errors_1.ecl will show a commented header 
about how to read the file and the results of the 
translation. It will also show an error count of zero 
(0) and warning count, if any. This file will show 
the comments from the CSTOL file that were carried 
over, and new comments that were added when 
necessary. 
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23. At the Unix prompt enter: 

%:textedit Testinput_1 & 

Compare Testinput_1 to errors_1.ecl. 

24. In the textedit window go to the file pull down 
menu. 

Using the left most mouse button 

Select Quit 

Note: Do this step twice, once in each texteditor 
window. 

The textedit window will close. 

25. Partial Translation 

Modify the input file: 

At the Unix prompt enter: 

%:cp FuCs_1 Testinput_2 

This will create a copy of FuCs_1. The copy file 
Testinput_2 will be modified to reflect errors. 

26. At the Unix prompt enter: 

%:vi Testinput_2 

The vi editor will open Testinput_2. 

27. Press the [ESC] key 

Type: 

:set nu 

This will enable line numbering in the vi editor. 
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28. Arrow down to line 15 of the file. 

Press i for insert mode 

Press the Return key 

Press the [ESC] key 

Arrow up to line 15: 

Press i for insert mode 

Press the TAB key 

Type: 

DECLARE 
150 

Line 15 will be modified to read: 

DECLARE 
:400 

-K 1.5 = $$b VARIABLE 
K :400 K 

K -150 K 1.5 = $$b VARIABLE 
K 
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29. Press [ESC] key 

Arrow down to line 19 

Press i for insert mode 

Press the Return key 

Press the [ESC] key 

Arrow up to line 19: 

Press i for insert mode 

Press the TAB key 

Type: 

DECLARE 
efg” 

Line 19 will be modified to read: 

DECLARE 

“abcd = cde abc INPUT 

efg” “abcd = cde abc INPUT 
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30. Press [ESC] key 

Arrow down to line 28 of the file. 

Arrow over to one space past the 3. 

Press i for insert mode 

Press the space bar 

Type: 

DEG 

Press [ESC] key 

Press Shift A to move to the end of the line 

Press the space bar 

Type: 

DN 

Line 28 will be modified to read: 

LET DN B#11010010 + DEG 3 -= $a 
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31. Press [ESC] key 

Arrow down to line 30 of the file. 

Press i for insert mode 

Press the Return key 

Press the [ESC] key 

Arrow up to line 30: 

Press i for insert mode 

Press the TAB key 

Type: 

;LET 

Press the Return key 

Line 30 will be modified to read: 

;LET 

7 + DEG 5 + DEG 3 = $a 

7 + DEG + 5 DEG 3 = $a 
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32. Press [ESC] key 

Arrow down to line 32 of the file. 

Arrow over to $abc 

Press i for insert mode. 

Type: 

abc 

To delete $abc 

Press [ESC] key 

Arrow to the $ 

Type: 

xxxx 

Line 32 will be modified to read: 

LET 
((7 

def 

+ SQRT(3+2)) * SIN(3 + (-$B ** $c = $a 
def)) abc / -50 $C * 9 -
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33. Press [ESC] key 

Arrow down to line 35 of the file. 

Arrow over to the 3 

Press i for insert mode. 

Press the space bar 

Type: 

RAD 

Press [ESC] key 

Arrow over to $b 

Press i for insert mode. 

Type: 

abc 

To delete $b 

Press [ESC] key 

Arrow to the $ 

Type: 

xx 

Line 35 will be modified to read: 

LET 
50 

def 

-*$C) 9 -((7 + RAD 3 + -1*(-$B = $a 
def)) abc / 
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34. Press [ESC] key 

Arrow down to line 36 of the file. 

Press Shift A 

Press the space bar 

Type: 

DEG 

Line 36 will be modified to read: 

LET 

35. Press [ESC] key 

Arrow down to the beginning of line 39 of the file. 

Press Shift R 

Press TAB key 

Type: 

SET 

Line 39 will be modified to read: 

SET 

36. Press [ESC] key 

Arrow down to the beginning of line 40 

Type: 

dd 

Line 40 will be modified (deleted). 

37. Press [ESC] key 

Arrow down to the beginning of line 40 

Type: 

dd 

Line 40 will be modified (deleted). 

DEG 3 -= $a 

LOW TO SPEED FAN 

LOW TO SPEED FAN 
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38. Press [ESC] key 

Type: 

:wq 

The file Testinput_2 is modified and saved. 

39. Place pointer in the first Xterm window with the 
directory path of /fosb/test/am1/bin/sun_sparc_5-5 
and click to activate the screen and enter at the 
Unix prompt: 

%: FuCsTranslate -i “/fosb/test/am1/data/ 
Testinput_2” -o 
“/fosb/test/am1/data/errors2.ecl” 

Note: The above is all one command line and the 
path names may very depending where the input 
files reside and where the out put files need to 
reside. 

This will activate the conversion utility and convert 
Testinput_2 to errors2.ecl. 

40. Place pointer in the second Xterm window with the 
directory path of /fosb/test/am1/data and click to 
activate the screen and enter at the Unix prompt: 

%:ls -la 

The file errors2.ecl should be in the data directory. 

41. At the Unix prompt enter: 

%:textedit errors2.ecl & 

File errors2.ecl will show a commented header about 
how to read the file and the results of the translation. 
It will also show an error count of eleven (11) and 
warning count of three (3). This file will show the 
comments from the CSTOL file that were carried 
over, and new comments that were added when 
necessary. 
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42. At the Unix prompt enter: 

%:textedit Testinput_2 & 

Compare Testinput_2 to error2.ecl. 

43. In the textedit window go to the file pull down 
menu. 

Using the left most mouse button 

Select Quit 

Note: Do this step twice, once in each texteditor 
window. 

The textedit window will close. 

44. End of test. 
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EOC Timeline - Management


Test No.:  PAS-2035B 

Test Configuration: See Appendix G 

Test Support: Predefined activities on the EOC user stations. A second user station must be available for permission testing. 

Test Description: 

This test will begin with the creation of scheduling plans and multiple timelines. 
saving capabilities and deleting functions. 
well. 

Success Criteria: 

The success of the test is based on managing multiple plans at one time; setting up user permissions in accordance to resources and 
ownership; and demonstrating the basic functionality with editing (cutting/copying/pasting) activities within a plan and across plans. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. -2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. ­
2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

3. Log onto an FOT User Station. 

Start the User Station. -2010B ­
- User Station Startup and Authentication. 

The FOT User Station is running and the 
‘Control window’ is displayed. 

4. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

The test will demonstrate the viewing options, 
Permissions for scheduling to a resource and deleting a plan and activity is covered as 

The test will move into the cut/copy/paste functionality across plans as well. 

Reference Test Case SYS

Reference Test Case SYS

Reference Test Case SYS
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5. Select the ‘General Scheduler’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The General 
Scheduler window appears. 

6. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

7. Select the ‘EOC Timeline’ option. (Timeline 1) 

Click the ‘OK’ button. 

The Tools dialog box closes. The EOC Timeline 
window appears. 

8. Within the EOC Timeline select the ‘Open’ option under 
the File menu. 

The Open dialog box appears. 

9. Select the ‘Master Plan’ option. 

Enter a start date and time. 

1997/172 00:00:00 

Enter a stop date and time. 

1997/175 00:00:00 

Click the ‘OK’ button 

The Open dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:1. The requested date and 
time periods appear at the top on the timeline 
viewing area. 

10. Activity Scheduling 

From the General Scheduler window, click the ‘Filter By 
Resource’ button and select AM1 MODIS. 

AM1 MODIS appears on the Filter By Resource 
button. 

11. Select the ‘Activities’ option from the ‘Filter’ menu. A list of activities defined under the AM1 
MODIS resource appears in the Activities field. 

12. Select an activity for scheduling. 

Select the ‘Master Plan:1’ as the scheduling plan. 

The selected activity and plan are highlighted. 
Default scheduling information appears. 

13. Select the ‘Impact’ option under the Action menu. The Impact button is selected. 
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14. Select the ‘Start Time’ and ‘Stop Time’ toggle buttons 

Enter a start date and time. 

1997/172 02:00:00 

Enter a stop date and time. 

1997/172 03:00:00 

Click the ‘Schedule’ button. 

The activity is scheduled on the Master Plan:1. 
The activity appears on the timeline in the 
scheduled location. 

15. Select the ‘EOC Timeline’ option. (Timeline 2) 

Click the ‘OK’ button. 

The Tools dialog box closes. The EOC Timeline 
window appears. 

16. Within the EOC Timeline select the ‘Open’ option under 
the File menu. 

The Open dialog box appears. 

17. Select the ‘Master Plan’ option. 

Enter a start date and time. 

1997/172 00:00:00 

Enter a stop date and time. 

1997/175 00:00:00 

Click the ‘OK’ button 

The Open dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:2. The requested date and 
time periods appear at the top on the timeline 
viewing area. 

18. Repeat the ‘Activity Scheduling’ steps. Schedule against 
the Master Plan:2. 

The activity is scheduled on the Master Plan:2. 
The activity appears on the timeline in the 
scheduled location. 

19. From timeline 1 select the ‘Master Plan:2’ option under 
the ‘Plan’ menu. 

Timeline 1 snaps to the Master Plan:2. 
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20. Within timeline 2 select the ‘Open’ option under the File 
menu. 

The Open dialog box appears. 

21. Select the ‘Master Plan’ option. 

Enter a start date and time. 

1997/174 00:00:00 

Enter a stop date and time. 

1997/175 00:00:00 

Click the ‘OK’ button 

The Open dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:3. The requested date and 
time periods appear at the top on the timeline 
viewing area. 

22. Repeat the ‘Activity Scheduling’ steps. Schedule against 
the Master Plan:3. 

The activity is scheduled on the Master Plan:3. 
The activity appears on the timeline in the 
scheduled location. 

23. From timeline 1 select the ‘Master Plan:3’ option under 
the ‘Plan’ menu. 

Timeline 1 snaps to the Master Plan:3. 

24. From timeline 1 select the ‘Master Plan:1’ option under 
the ‘Plan’ menu. 

Timeline 1 snaps to the Master Plan:1. 

25. Select the ‘Close’ option under the ‘File’ menu. A dialog box appears to prompt the user to save 
the plan. 

26. Click the ‘Yes’ button. The plan is saved and the Master Plan:1 closes. 
Timeline snaps to Master Plan:2. 

27. Within timeline 1 select the ‘New’ option under the File 
menu. 

The New dialog box appears. 
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28. Enter a new name. 

New Plan 

Enter a start date and time. 

1997/172 00:00:00 

Enter a stop date and time. 

1997/175 00:00:00 

Click the ‘OK’ button 

The New dialog box closes. The timeline 
updates with the requested time period and plan 
name as New Plan:1. The requested date and 
time periods appear at the top on the timeline 
viewing area. 

29. Repeat the ‘Activity Scheduling’ steps. Schedule against 
the New Plan:1. 

The activity is scheduled on the New Plan:1. 
The activity appears on the timeline in the 
scheduled location. 

30. Select the ‘Save’ option under the ‘File’ menu. The plan is saved with the current information. 

31. Select the ‘Save As’ option under the ‘File’ menu. The Save Plan As dialog box appears. 

32. Enter the plan name. 

Stan Plan 

Click the ‘OK’ button. 

The plan is saved with the Stan Plan name and 
the Save As dialog box closes. The timeline 
display snaps to the new name and the New Plan 
option is replaced with Stan Plan under the Plans 
menu. 

33. Within timeline 2 select the ’Stan Plan:1’ option under the 
‘Plans’ menu. 

Timeline 2 snaps to the Stan Plan:1 

34. Within timeline 1 select the ‘Close’ option under the 
‘File’ menu. 

A dialog box appears to prompt the user to save 
the plan. 
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35. Click the ‘Yes’ button. The plan is saved and Stan Plan:1 closes on 
timeline 1 and 2. Timeline 1 and 2 snaps to 
Master Plan:2. 

36. Within timeline 1select the “Delete’ option under the 
‘File’ menu. 

The Delete dialog box appears. 

37. Select the ‘Stan Plan:1’ option in the Plans field. 

Click the ‘OK’ button. 

A Confirm dialog box appears to delete the plan. 

38. Click the ‘Yes’ button. The Confirm dialog box closes. The Stan Plan:1 
is deleted and the Delete Plan dialog box closes. 

39. Within timeline 1select the “delete’ option under the ‘File’ 
menu. 

The Delete dialog box appears. The Stan Plan:1 
is not listed in the Plans field. 

40. Click the ‘Cancel’ button. The Delete dialog box closes. 

41. Select the Load Setup option under the User Setup Menu. The Load Setup dialog box appears. 

42. Enter the following pathe and file name. 

/home/fostest1/tl_config2 

Click the ‘OK’ button. 

The Load Setup dialog box closes. The timeline 
is updated with new resources stored with the 
tl_config2 file. 

43. Use the vertical scroll bar to view the selected resources. There are several additional resources with 
events, activities and view periods associated 
with them. 

44. Within timeline 1 select the ‘Master Plan:2’ option under 
the ‘Plans’ menu. 

Timeline 1 snaps to the Master Plan:2. 
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45. Repeat the ‘Activity Scheduling’ steps. Select an activity 
under the AM1 MISR resource and schedule against the 
Master Plan:2. 

The activity is scheduled on the Master Plan:2. 
The activity appears on the timeline in the 
scheduled location. 

46. Within timeline 1, select the ‘Save’ option under the ‘File’ 
menu. 

The Master Plan:2 is saved with scheduled 
activities. 

47. Select the ‘Permissions’ option under the ‘File’ menu. The Permissions dialog box appears. 

48. Within the Permissions dialog box select the ‘Master Plan 
- EOCMaster’ option in the Plans field. 

The Permissions Summary field will update with 
the current permissions allowed for the plan. 

49. Click the ‘Edit’ button. The Permissions/Resources dialog box appears. 
The Plan is Master Plan and the Owner is 
EOCMaster. 

50. Within the Permissions/Resources dialog box select the 
‘MISRScheduler’ option from the User Role field. 

The Selected Resources field is updated with the 
resources that the MISRScheduler has access to. 

51. Select the ‘AM1 MISR’ option from the Selected 
Resources field. 

Click the ‘remove’ button. 

The selected resource is removed from the 
Selected Resource field. 

52. Select the ‘AM1 MODIS’ option from the Available 
Resources field. 

Click the ‘Add’ button. 

The selected resource is added to the Selected 
Resource field. 

53. Click the ‘OK’ button. The Permissions/Resources dialog box closes. 
The Permissions Summary field within the 
Permissions dialog box is updated with the new 
information. 
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54. Within the Permissions dialog box click the ‘OK’ button. The new permissions are stored with the Master 
Plan and the Permissions dialog box closes. 

55. Log onto another User Station as MISRScheduler. 

Start the User Station. Reference Test Case SYS-2010B ­
- User Station Startup and Authentication. 

The User Station is running and the ‘Control 
window’ is displayed. 

56. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

57. Select the ‘General Scheduler’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The General 
Scheduler window appears. 

58. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

59. Select the ‘EOC Timeline’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The EOC Timeline 
window appears. 

60. Within the EOC Timeline select the ‘Open’ option under 
the File menu. 

The Open dialog box appears. 

61. Select the ‘Master Plan’ option. 

Enter a start date and time. 

1997/172 00:00:00 

Enter a stop date and time. 

1997/175 00:00:00 

Click the ‘OK’ button 

The Open dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:1. The requested date and 
time periods appear at the top on the timeline 
viewing area. 
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62. Repeat the ‘Activity Scheduling’ steps. 
under the AM1 MISR resource and schedule against the 
Master Plan:1 at the given time. 

1997/172 

A warning message dialog box appears 
indicating the activity failed to be scheduled. 
event message indicates the user does not have 
permission to schedule on AM1 MISR. 

63. Click the ‘OK’ button on the message dialog box. The message dialog box closes. 

64. Repeat the ‘Activity Scheduling’ steps. 
under the AM1 MODIS resource schedule against the 
Master Plan:1 at the given time. 

1997/172 

The activity is scheduled on the Master Plan:1. 
The activity appears on the timeline in the 
scheduled location. 

65. Select the “Delete’ option under the ‘File’ menu. The Delete dialog box appears. 

66. Select the ‘New Plan’ option in the Plans field. 

Click the ‘OK’ button. 

A message dialog box appears stating 
MISRScheduler does not have permission to 
delete the plan.. 
not the MISRScheduler. 

67. Click the ‘OK’ button on the message dialog box. The message dialog box closes. 

68. Click the ‘Cancel’ button in the Delete dialog box. The Delete dialog box closes. 

69. Cutting and Pasting Activities 

Select the activity on the timeline that was scheduled by 
the EOC Master on the MISR resource. 

Click the ‘Cut’ button. 

A error message dialog box appears. The 
MISRScheduler does not have permission to Cut 
events from AM1 MISR resource. 
is the EOC Master not the MISRScheduler. 

70. Click the ‘OK’ button on the message dialog box. The message dialog box closes. 

activity Select an 

01:30:00 -01:00:00 

An 

activity Select an 

01:30:00 -01:00:00 

The Owner is the EOCMaster 

The Owner 
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71. Select the activity on the timeline that was scheduled by 
the EOCMaster on the MODIS resource. 

Click the ‘Cut’ button. 

The activity disappears from the timeline. 

72. Click the ‘Impact’ button. 

Click the ‘Paste’ button. 

The activity appears on the timeline in its 
scheduled location. 

73. At the EOC Master user station and within timeline 2, 
select the ‘Open’ option under the File menu. 

The Open dialog box appears. 

74. Select the ‘Master Plan’ option. 

Enter a start date and time. (Same period as Master 
Plan:2) 

1997/172 00:00:00 

Enter a stop date and time. 

1997/175 00:00:00 

Click the ‘OK’ button 

The Open dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:4. The requested date and 
time periods appear at the top on the timeline 
viewing area. 

75. Repeat the ‘Activity Scheduling’ steps. Select 4 activities 
under the AM1 MOPITT resource and schedule against 
the Master Plan:4. 

Note: Several activities will have mode changes 
associated with it. Verify the display on the timeline. 

The activities are scheduled on the Master 
Plan:4. The activities appears on the timeline in 
the scheduled location with the associated mode 
changes. 

76. Select the 4 activities on the timeline using the pointer and 
ctrl key. 

Click the ‘Copy’ button. 

The activities remain on the timeline. 
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77. Select Master Plan:2 option under the Plans menu. 

Click the ‘Impact’ button. 

Click the ‘Paste’ button. 

The copied activities appears on the timeline in 
their scheduled locations with the associated 
mode changes. 

78. End of test. 
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Contact Scheduler


Test Case No.: PAS-2040 

Test Configuration: See Appendix G 

Test Support: Test support consists of available services to create TDRSS and GN Contact Activities; the use of a NCC generator 
(test tool) to simulate the NCC interface; available FDF data for timeline events and scheduling calculations; and knowledge to 
adjust contact activities to fit the best possible profile of scheduling algorithms. 

Test Description: 

This test will demonstrate the ability to create contact activities and schedule them against the mission schedule. 
consist on TDRSS and Ground contact scheduling. 
multiple scheduling and producing an optimized schedule of events. 

Success Criteria: 

Success of the test case is measure by the ability to create TDRSS and Ground Contact Activities; schedule contact activities; and 
optimize scheduling events. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. -2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. ­
2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

3. Log onto an FOT User Station. 

Start the User Station. -2010B ­
- User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

The test will 
The use of batch scheduling is also demonstrated to verify the functionality of 

Reference Test Case SYS

Reference Test Case SYS

Reference Test Case SYS
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4. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

5. Select the ‘Activity Definer’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. Activity Definer 
window appears. 

6. Defining a TDRSS Contact Activity 

Select the ‘New’ option under the File menu 

The New dialog box appears. 

7. Enter the activity name. 

TDR-A 

Select the ‘AM1 COMMUNICATIONS’ option under the 
resource button. 

Click the ‘OK’ button. 

The New dialog box closes. The activity name and 
the selected resource appear in the Activity Definer 
window. 

8. Under the appropriate menu options, select the services 
needed to define a TDRSS Contact Activity. (TDR-A) 

Uplink Activity 

Downlink Activity 

Tracking Activity 

NCC Code 

Select the ‘Save’ option under the File menu. 

The activities are saved with the current 
information. 

9. Repeat the Defining a TDRSS Contact Activity steps. 
(TDR-B) 

Select the ‘Save’ option under the File menu. 

The activity is saved with the current information. 

10. Select the ‘New’ option under the File menu. The New dialog box appears. 
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11. Enter the activity name. 

GN-A 

Select the ‘AM1 X-Band DP’ option under the resource 
button. 

Click the ‘OK’ button. 

The New dialog box closes. The activity name and 
the selected resource appear in the Activity Definer 
window. 

12. Defining a Ground Contact Activity 

Under the appropriate menu options, select the services 
needed to define a Ground Contact Activity. (GN-A) 

Uplink Activity 

Downlink Activity 

Select the ‘Save’ option under the File menu. 

Select the ‘Exit’ option under the File menu. 

The activity is saved with the current information. 
The Activity Definer closes. 

13. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

14. Select the ‘Communications Contact Scheduler’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The Contact 
Scheduler window appears. 

15. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

16. Select the ‘EOC Timeline’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The EOC Timeline 
window appears. 

17. Within the EOC Timeline select the ‘Open’ option under 
the File menu. 

The Open dialog box appears. 
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18. Select the ‘Master Plan’ option. 

Enter a start date and time. 

1997/234 00:00:00 

Enter a stop date and time. 

1997/244 00:00:00 

Click the ‘OK’ button 

The Open dialog box closes. The timeline updates 
with the requested time period and plan name as 
Master Plan:1. The requested date and time periods 
appear at the top on the timeline viewing area. 

19. Select the ‘Load’ option under the Set Up menu. The Load Configuration dialog box appears. 

20. Select the appropriate configuration file for this exercise. 
(stan3) 

Click the ‘OK’ button. 

The timeline snaps to the selected configuration 
showing the necessary contact scheduling 
resources. 

21. TDRSS Contact Scheduling 

From the Contact Scheduler window, click the ‘Filter By 
Resource’ button and select AM1 COMMUNICATIONS. 

AM1 COMMUNICATION appears on the Filter 
By Resource button. 

22. Select the ‘TDR-A.1’ activity for scheduling. 

Select the ‘Master Plan:1’ as the scheduling plan. 

The selected activity and plan are highlighted. 

23. Select the appropriate TDRS for the desired view period. 

Select the ‘Start Time’ and ‘Stop Time’ toggle buttons 

Enter a start date and time. (During a valid view period of 
the defined TDRSS) 

Enter a stop date and time. (10 minutes from the start) 

Click the ‘Schedule’ button. 

The activity is scheduled on the Master Plan:1. The 
activity appears on the timeline in the scheduled 
location. 
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24. Place the pointer on the scheduled contact. The start and end times for the contact appear in the 
status field. The contact is also indicated as 
‘Unsubmitted’. 

25. Ground Station Contact Scheduling 

From the Contact Scheduler window, click the ‘Filter By 
Resource’ button and select AM1 X-Band DP. 

AM1 X-Band appears on the Filter By Resource 
button. 

26. Select the ‘GN-A’ activity for scheduling. 

Select the ‘Master Plan:1’ as the scheduling plan. 

The selected activity and plan are highlighted. 

27. Select the ‘Start Time’ and ‘Stop Time’ toggle buttons 

Enter a start date and time. (During a valid view period of 
the defined GN Station) 

Enter a stop date and time. (10 minutes from the start) 

Click the ‘Schedule’ button. 

The activity is scheduled on the Master Plan:1. The 
activity appears on the timeline in the scheduled 
location. 

28. Within the Contact Scheduler, click the Submit button. The scheduled contact activity is transferred to 
NCC for confirmation. An event message will 
appear in the event display. The contact changes 
status to pending. Upon confirmation from NCC, 
the status changes to accepted and message appears 
on the event display. 

29. TDRSS Contact Batch Scheduling 

From the Contact Scheduler window, click the ‘Filter By 
Resource’ button and select AM1 COMMUNICATIONS. 

AM1 COMMUNICATION appears on the Filter 
By Resource button. 
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30. Select the ‘TDR-A.1’ activity for scheduling. 

Select the ‘Master Plan:1’ as the scheduling plan. 

The selected activity and plan are highlighted. 

31. Select the ‘Batch’ button. 

Select the ‘Start Time’ and ‘Stop Time’ toggle buttons 

Enter a start date and time. (During a valid view period of 
the defined TDRSS) 

Enter a stop date and time. (1 week from the start) 

Click the ‘Schedule’ button. 

The activities are scheduled on the Master Plan:1. 
The activities appear on the timeline in the 
scheduled locations. 

32. Place the pointer on the orbital events that are indicated on 
the AM1 Events resource. 

Information about the orbital event appears in the 
status field. 

33. Place the pointer on the HGA pointing angles that are 
indicated on the AM1 HGA resource. 

Information about the HGA pointing angle appears 
in the status field. 

34. Repeat the TDRSS Contact Scheduling steps for TDR-B. 
Schedule the activity in a period where the defined service 
TDRSS is not in view. 

An error message dialog box appears indicating the 
activity is not scheduled due to the TDRSS service 
is unavailable. 

35. Click the ‘OK’ button in the message dialog box. The message dialog box closes. 

36. Repeat the TDRSS Contact Scheduling steps for TDR-B. 
Schedule the activity in a period where the preceding 
TDRSS contact is too close for the HGA to slew in time 
for the contact. 

An error message dialog box appears indicating the 
activity is not scheduled. The HGA slew rate is not 
fast enough to point at the requested TRDSS 
location. 
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37. Click the ‘OK’ button in the message dialog box. The message dialog box closes. 

38. Repeat the TDRSS Contact Batch Scheduling steps for 
TDR-B. Use the default settings of the scheduling 
algorithm. Schedule the batch job for 6 hours. 

The activities are scheduled on the Master Plan:1. 
The activities appear on the timeline in the 
scheduled locations. 

39. Repeat the TDRSS Contact Batch Scheduling steps for 
TDR-B. Modify the settings of the scheduling algorithm. 
Schedule the batch job for 6 hours. 

The activities are scheduled on the Master Plan:1. 
The activities appear on the timeline in the 
scheduled locations. 

40. Compare the scheduling results with previous Batch 
Scheduling contacts. 

The information on the timeline for each scheduled 
contact will not be optimized to the requested 
scheduling periods. 

41. End of test. 
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Scheduling Load Uplink Activities


Test Case No.: PAS-2110B 

Test Configuration: See Appendix G 

Test Support: Predefined conditions consist of the spacecraft ATC buffer cleared of any assigned memory locations; activities 
scheduled on the master plan that will create an ATC load and DAS; activities scheduled on the master plan to create a partitioned 
ATC load and DAS; and several loads generated and available (RTS, Table, MPR, and FSW) for scheduling. 

Test Description: 

This test will demonstrate the generation of a Detailed Activity Schedule (DAS) and ATC loads. 
verified against the requested and valid uplink periods. 
(RTS), and Table loads are scheduled and verified against the requested and valid uplink periods. 

Success Criteria: 

The test is considered successful when a DAS and ATC load are generated; ATC loads are scheduled within the requested and valid 
uplink periods; abundance of ATC commands are associated with a DAS and the generation results with partitioned products; 
Binary, FSW, RTS, and Table loads are scheduled within the requested and valid uplink periods. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. -2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. ­
2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

ATC loads are scheduled and 
Binary (Microprocessor), Flight Software (FSW), Relative Time Sequence 

Reference Test Case SYS

Reference Test Case SYS
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3. Log onto an FOT User Station. 

Start the User Station. Reference Test Case SYS-2010B ­
- User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

4. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

5. Select the ‘General Scheduler’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The General 
Scheduler window appears. 

6. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

7. Select the ‘EOC Timeline’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The EOC Timeline 
window appears. 

8. Within the EOC Timeline select the ‘Open’ option under 
the File menu. 

The Open dialog box appears. 

9. Select the ‘Master Plan’ option. 

Enter a start date and time. 

1997/239 00:00:00 

Enter a stop date and time. 

1997/241 00:00:00 

Click the ‘OK’ button 

The Open dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:1. The requested date and 
time periods appear at the top on the timeline 
viewing area. 

10. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

11. Select the ‘Load Generator’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The Load 
Generator window appears. 
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12. DAS/ATC Load Generation 

Click the ‘DAS/ATC Load’ toggle button. 

Select the Master Plan. 

Enter the DAS Time: 

Start Date 1997/240 Start Time 03:30:00 

Stop Date 1997/240  Stop Time 06:00:00 

Enter the Uplink Request: 

Start Date 1997/240 Start Time 01:00:00 

Stop Date 1997/240  Stop Time 03:00:00 

Click the ‘Submit’ button. 

A DAS, Detail Activity Schedule, is generated. 
The ATC load is generated. The ATC load is 
scheduled within the uplink period. 

13. Repeat the steps for Activity Scheduling and DAS/ATC 
Load Generation. Select a time period after the previous 
DAS/ATC Load Generation. (Abundance of ATC 
Commands) 

A DAS, Detail Activity Schedule, is generated. 
The DAS is partitioned due to insufficient 
locations. The ATC load is generated and 
partitioned. The ATC load partitions are 
scheduled within the uplink periods generated. 

14. Select the ‘Quit’ option under the ‘File’ menu. The Load Generator window closes. 

15. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

16. Select the ‘Binary Load Builder’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The Binary Load 
Builder window appears. 
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17. Binary Load Scheduling 

Select a MISR Microprocessor (MPR) load from the Load 
Catalog field. 

Click the ‘Scheduling’ button. 

The Load Scheduling window appears. The load 
name and the associated uplink information that 
was defined during generation appear in the 
appropriate scheduling fields. 

18. Enter a number of contacts to schedule the load against. 
(3) 

Select a Load/Uplink activity. 

Click the ‘Schedule’ button. 

Click the ‘OK’ button within the Confirm dialog box. 

The load is scheduled on the timeline within the 
user specified uplink period at the computed time 
location(s) if there are contact schedules 
available. 

19. Repeat the Binary Load Scheduling steps for a CERES 
load. 

The load is scheduled on the timeline within the 
user specified uplink period at the computed time 
location(s) if there are contact schedules 
available. 

20. Repeat the Binary Load Scheduling steps for a FSW load. The load is scheduled on the timeline within the 
user specified uplink period at the computed time 
location(s) if there are contact schedules 
available. 

21. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

22. Select the ‘RTS Load Builder’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The RTS Load 
Builder window appears. 

23. RTS Load Scheduling 

Select the ‘Open’ option under the ‘File’ menu. 

The Open dialog appears with a list of RTS loads 
available in the load catalog. 
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24. Select a RTS load from the Load Catalog field. 

Click the ‘Scheduling’ button. 

The Load Scheduling window appears. The load 
name and the associated uplink information that 
was defined during generation appear in the 
appropriate scheduling fields. 

25. Enter a number of contacts to schedule the load against. 
(3) 

Click the ‘Schedule’ button. 

Click the ‘OK’ button within the Confirm dialog box. 

The load is scheduled on the timeline within the 
user specified uplink period at the computed time 
location(s) if there are contact schedules 
available. 

26. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

27. Select the ‘Table Load Builder’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The TableLoad 
Builder window appears. 

28. Repeat the RTS Load Scheduling steps for a Table load. The load is scheduled on the timeline within the 
user specified uplink period at the computed time 
location(s) if there are contact schedules 
available. 

29. End of test. 
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Receive and Schedule Late Change Requests


Test Case No.: PAS-2180B 

Test Configuration: See Appendix G 

Test Support: Test support is needed in the following areas; pre-planned mission schedules with activities, and defined hard and 
soft command constraints. 

Test Description: 

The test will demonstrate the ability to schedule activities on the timeline; identify any constraint violations; create a DAS 
successfully; and regenerate a DAS with requested changes. 

Success Criteria: 

Success is based on the ability to identify constraint violations; generate a DAS; unlock a DAS (resources); and regenerate a DAS 
across the same period. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. -2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. ­
2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

3. Log onto an FOT User Station. 

Start the User Station. -2010B ­
- User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

4. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

Reference Test Case SYS

Reference Test Case SYS

Reference Test Case SYS
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5. Select the ‘General Scheduler’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The General 
Scheduler window appears. 

6. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

7. Select the ‘EOC Timeline’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The EOC Timeline 
window appears. 

8. Within the EOC Timeline select the ‘Open’ option under 
the File menu. 

The New Plan dialog box appears. 

9. Select the Plan Name. 

Master Plan 

Enter a start date and time. 

1997/243 00:00:00 

Enter a stop date and time. 

1997/245 00:00:00 

Click the ‘OK’ button 

The Open Plan dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:1. 

10. Activity Scheduling 

From the General Scheduler window, click the ‘Resource’ 
button and select a resource. 

The resource appears on the Resource button. 

11. Select the ‘Activities’ option from the ‘Filter’ menu. A list of activities defined under the resource 
appears in the Activities field. 
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12. Select the an activity for scheduling. (Activity must 
violate a soft constraint) 

Select the ‘Master Plan:1’ as the scheduling plan. 

The selected activity and plan are highlighted. 
Default scheduling information appears. 

13. Select the ‘Impact’ option under the Action menu. The Impact button is selected. 

14. Insert appropriate start and stop times for the activity. 

Click on the Schedule button. 

The activity will appear on the timeline in the 
specified scheduled location. The activity will 
appear with the violation patterns indicated. 

15. Repeat the Activity Scheduling steps for scheduling 
activities that would violate a hard constraint. 

The activity will appear on the timeline in the 
specified scheduled location. The activity will 
appear with the violation patterns indicated. 

16. Click the ‘Save’ button on the timeline. The current contents are saved to the Master Plan. 

17. From the Control window, click on the Tools button. The Tools dialog box appears. 

18. Select the Load Generate option. 

Click the ‘OK’ button 

The Tools dialog box closes. The Load Generate 
window appears. 

19. Load Generate Window 

Select the DAS/ATC toggle button. 

Select the Master Plan from the Plans field. 

Input a valid DAS time. 

Input a valid Uplink Request. 

Click the ‘Submit’ button. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue field. Upon 
completion the job will appear in the Jobs 
Completed field. The DAS will result with a 
Failed status. 
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20. Select the failed DAS in the Jobs Completed field. 

Click the ‘View Constraints’ button. 

A Constraint dialog box appears with failed 
reason stated within the text field. 

21. Verify the violations are correct and click the ‘Close’ 
button to close out the box. 

The constraint Violation dialog box closes. 

22. Within the timeline display select the activity violating the 
hard constraint. 

Click the ‘Cut’ button to unschedule the activity. 

The activity is removed from the timeline. 

23. Click the ‘Save’ button on the timeline. The current contents are saved to the Master Plan. 

24. Repeat the Load Generating steps for a new DAS which 
will include the scheduled activities. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue field. The job 
status will reach a pending state. 

25. Select the job in the que. 

Click the ‘View Constraints’ button. 

A Constraint dialog box appears with the soft 
constraint violation listed in the text field. 

26. Click the ‘Approve’ button. The Constraint dialog box closes. The DAS 
process accepts the soft constraint. Upon 
completion the job will appear in the Jobs 
Completed field. The DAS will result with a 
Completed status. An Uplink process for the 
ATC load will result with a Complete status. 

27. Unlock the DAS 

Within the Load Generate window select the ‘Show 
Locks’ under the Lock Times menu. 

The Locks dialog box appears. 
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28. Select the resource with the activity violating the soft 
constraint. 

Enter a new time that occurs before the actual processed 
DAS time. 

Click the ‘OK’ button. 

The Lock dialog box closes. The selected 
resource is unlocked to new time input. The 
timeline will update with the new information. 

29. Within the timeline display select the activity violating the 
soft constraint. 

Click the ‘Cut’ button to unschedule the activity. 

The activity is removed from the timeline. 

30. Repeat the Activity Scheduling steps for scheduling 
activities that wouldnot violate a constraint. 

The activity will appear on the timeline in the 
specified scheduled location. 

31. Click the ‘Save’ button on the timeline. The current contents are saved to the Master Plan. 

32. Late Change 

Select the Late Change toggle button. 

Select the Master Plan from the Plans field. 

Select the DAS that is being changed in the Completed 
field. 

Input the valid DAS start time. 

Click the ‘Submit’ button. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue field. Upon 
completion the job will appear in the Jobs 
Completed field. The DAS will result with a 
Completed status. An Uplink process for the ATC 
load will result with a Complete status. 

33. End of test. 
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What-If Planning & Scheduling


Test Case No.: PAS-2190B 

Test Configuration: See Appendix G 

Test Support: Predefined activities on the EOC user stations. 

Test Description: 

This test will begin with the creation of what-if plans on the timeline. 
capabilities and deleting functions. 
move into the cut/copy/paste functionality across plans as well. 

Success Criteria: 

The success of the test is based on creating what-if plans; showing no affects to the Master Plan as what-if plans are saved and 
deleted; and demonstrating the privileges in accordance with plan ownership for using the cut/copy/paste functionality. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. -2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. ­
2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

3. Log onto an FOT User Station. 

Start the User Station. -2010B ­
- User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

4. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

A second user station must be available for what-if testing. 

The test will demonstrate the viewing options, saving 
The test will The effects to the Master Plan is also demonstrated with the what-if exercises. 

Reference Test Case SYS

Reference Test Case SYS

Reference Test Case SYS
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5. Select the ‘General Scheduler’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The General 
Scheduler window appears. 

6. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

7. Select the ‘Timeline’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The Timeline 
window appears. 

8. Within the Timeline select the ‘Open’ option under the 
File menu. 

The Open Plan dialog box appears. 

9. Select the ‘Master Plan’ option. 

Enter a start date and time. 

1997/178 00:00:00 

Enter a stop date and time. 

1997/180 00:00:00 

Click the ‘OK’ button 

The Open Plan dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:1. The requested date and 
time periods appear at the top on the timeline 
viewing area. 

10. Within the Timeline select the ‘New’ option under the 
File menu. 

The New Plan dialog box appears. 
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11. Enter the New Plan Name. 

STAN1 

Enter a start date and time. (Same as Master Plan) 

1997/178 00:00:00 

Enter a stop date and time. (Same as Master Plan) 

1997/180 00:00:00 

Click the ‘OK’ button 

The New Plan dialog box closes. The timeline 
updates with the requested time period and plan 
name as STAN1:1. The requested date and time 
periods appear at the top on the timeline viewing 
area. 

12. Activity Scheduling 

From the General Scheduler window, click the ‘Filter By 
Resource’ button and select AM1 MODIS 

AM1 MODIS appears on the Filter By Resource 
button. 

13. Select the ‘Activities’ option from the ‘Filter’ menu. A list of activities defined under the TBD resource 
appears in the Activities field. 

14. Select the ‘MODIS_ATC1.1 activity for scheduling. 

Select the ‘STAN1:1’ as the scheduling plan. 

The selected activity and plan are highlighted. 
Default scheduling information appears. 

15. Select the ‘Impact’ option under the Action menu. The Impact button is selected. 
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16. Select the ‘Start Time’ and ‘Stop Time’ toggle buttons 

Enter a start date and time. 

1997/178 02:00:00 

Enter a stop date and time. 

1997/178 03:00:00 

Click the ‘Schedule’ button. 

The activity is scheduled on the STAN1:1. The 
activity appears on the timeline in the scheduled 
location. 

17. Repeat the ‘Activity Scheduling’ steps to schedule two 
additional activities against the STAN1:1. (MODIS, 
MOPITT) 

The activities are scheduled on the STAN1:1. The 
activities appear on the timeline in the scheduled 
locations. 

18. Within the STAN1:1 click the ‘Save’ button. The STAN1:1 plan is saved with the current 
information. 

19. Select the ‘Master Plan:1’ option under the ‘Plans’ menu. The Master Plan:1 snaps to the timeline. The 
activities scheduled and saved to STAN1:1 will 
not appear on the Master Plan:1. 

20. Select the ‘STAN!:1’ option under the ‘Plans’ menu. The STAN1:1 snaps to the timeline. 

21. Select an activity on the timeline. 

Click the ‘Cut’ button. 

The selected activity is removed from the 
STAN1:1 timeline. 

22. Click the ‘Save’ button. The STAN1:1 plan is saved with the current 
information. 

23. Select the ‘Close’ option under the ‘File’ menu. A Confirm dialog box appears to save the plan. 

24. Click the ‘Yes’ button. The Confirm dialog box closes. The STAN1:1 
plan closes and the timeline snaps to Master Plan.1 
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25. Within the Timeline select the ‘New’ option under the 
‘File’ menu. 

The New Plan dialog box appears. 

26. Enter the New Plan Name. 

STAN2 

Enter a start date and time. (Same as Master Plan) 

1997/178 00:00:00 

Enter a stop date and time. (Same as Master Plan) 

1997/180 00:00:00 

Click the ‘OK’ button 

The New Plan dialog box closes. The timeline 
updates with the requested time period and plan 
name as STAN2:1. The requested date and time 
periods appear at the top on the timeline viewing 
area. 

27. Repeat the ‘Activity Scheduling’ steps to schedule two 
additional activities against the STAN2:1. (MODIS, 
MOPITT) 

The activities are scheduled on the STAN2:1. The 
activities appear on the timeline in the scheduled 
locations. 

28. Select the ‘Master Plan:1’ option under the ‘Plans’ menu. The Master Plan:1 snaps to the timeline. The 
activities scheduled and saved to STAN2:1 will 
not appear on the Master Plan:1. 

29. Select an activity on the timeline. (AM1_ATC0.1) 

Click the ‘Copy’ button. 

The activity remain on the timeline. 

30. Select the ‘STAN2:1’ option under the ‘Plans’ menu. The STAN2:1 snaps to the timeline. 

31. Click the ‘Impact’ button. 

Click the ‘Paste’ button. 

The copied activities appears on the timeline in 
their scheduled locations. 

32. Within the STAN2:1 click the ‘Save’ button. The STAN2:1 plan is saved with the current 
information. 
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33. Select the ‘Close’ option under the ‘File’ menu. A Confirm dialog box appears to save the plan. 

34. Click the ‘Yes’ button. The Confirm dialog box closes. The STAN2:1 
plan closes and the timeline snaps to Master Plan.1 

35. Select the ‘Open’ option under the ‘File’ menu. The Open Plan dialog box appears. 

36. Select the ‘STAN1’ option. 

Enter a start date and time. (Same as Master Plan) 

1997/178 00:00:00 

Enter a stop date and time. (Same as Master Plan) 

1997/180 00:00:00 

Click the ‘OK’ button 

The Open dialog box closes. The timeline updates 
with the requested time period and plan name as 
STAN1:1. The requested date and time periods 
appear at the top on the timeline viewing area. 

37. Select the ‘Delete’ option under the ‘File’ menu. The Delete Plan dialog box appears. 

38. Select the ‘STAN2’ option from the list. 

Click the ‘OK’ button. 

A Confirm dialog box appears to delete the plan. 

39. Click the ‘Yes’ button. The Confirm dialog box closes. The Delete Plan 
dialog box closes. The plan is deleted. 

40. Select the ‘Master Plan:1’ option under the ‘Plans’ menu. The Master Plan:1 snaps to the timeline. 

41. Select the ‘Close’ option under the ‘File’ menu. A Confirm dialog box appears to save the plan. 

42. Click the ‘Yes’ button. The Confirm dialog box closes. The Master Plan:1 
closes and the timeline snaps to Stan1.1 

43. Within the Timeline select the ‘Open’ option under the 
File menu. 

The Open Plan dialog box appears. 
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44. Select the ‘Master Plan’ option. 

Enter a start date and time. (Same as previous) 

1997/178 00:00:00 

Enter a stop date and time. (Same as previous) 

1997/180 00:00:00 

Click the ‘OK’ button 

The Open Plan dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:1. The requested date and 
time periods appear at the top on the timeline 
viewing area. Note the activity that was copied to 
STAN2 was not deleted from the Master Plan. 

45. Select the ‘STAN1:1’ option under the ‘Plans’ menu. The STAN1:1 snaps to the timeline. 

46. Select an activity on the timeline. 

Click the ‘Copy’ button. 

The activity remain on the timeline. 

47. Select the ‘Master Plan:1’ option under the ‘Plans’ menu. The Master plan:1 snaps to the timeline. 

48. Click the ‘Impact’ button. 

Click the ‘Paste’ button. 

The copied activities appears on the timeline in 
their scheduled locations. 

49. Log onto another User Station as MISRScheduler. 

Start the User Station. Reference Test Case SYS-2010B ­
- User Station Startup and Authentication. 

The User Station is running and the ‘Control 
window’ is displayed. 

50. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

51. Select the ‘General Scheduler’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The General 
Scheduler window appears. 

52. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 
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53. Select the ‘Timeline’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The Timeline 
window appears. 

54. Within the Timeline select the ‘Open’ option under the 
File menu. 

The Open Plan dialog box appears. 

55. Select the ‘Master Plan’ option. 

Enter a start date and time. (Same as EOC Master Plan) 

1997/178 00:00:00 

Enter a stop date and time. (Same as EOC Master Plan) 

1997/180 00:00:00 

Click the ‘OK’ button 

The Open Plan dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:1. The requested date and 
time periods appear at the top on the timeline 
viewing area. 

56. Within the Timeline select the ‘New’ option under the 
File menu. 

The New Plan dialog box appears. 

57. Enter the New Plan Name. 

MISR1 

Enter a start date and time. (Same as EOC Master Plan) 

1997/178 00:00:00 

Enter a stop date and time. (Same as EOC Master Plan) 

1997/180 00:00:00 

Click the ‘OK’ button 

The New Plan dialog box closes. The timeline 
updates with the requested time period and plan 
name as MISR1:1. The requested date and time 
periods appear at the top on the timeline viewing 
area. 
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58. Repeat the ‘Activity Scheduling’ steps. Select the TBD 
activity under the AM1 MOPITT resource and use the 
default scheduling information to schedule against the 
MISR1:1. 

The activity is scheduled on the MISR1:1. The 
activity appears on the timeline in the scheduled 
location. 

59. Within the MISR1:1 click the ‘Save’ button. The MISR1:1 plan is saved with the current 
information. 

60. Select an activity on the timeline. 

Click the ‘Copy’ button. 

The activity remain on the timeline. 

61. Select the ‘Master Plan:1’ option under the ‘Plans’ menu. The Master plan:1 snaps to the timeline. 

62. Click the ‘Impact’ button. 

Click the ‘Paste’ button. 

A message dialog box appears denying scheduling 
permission on the AM1 MOPITT resource on the 
Master Plan. 

63. Click the ‘OK’ button. The message dialog box closes. 

64. End of test. 
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DAS Generation


Test Case No.: PAS-2200B 

Test Configuration: See 

Test Support: Test support consists of pre-defined activities and procedures. 
load uplinks. 
Load Generator. 

Test Description: 

This test will begin with creating a test bed of activities needed to formulate an ATC load, violate command constraints, and 
populate a DAS period. 
constraints. 
which should prohibit DAS\ATC generation. The performance of creating a DAS with 1000 activities is tested as well. 

Success Criteria: 

The success of the test is based on the ability to flag constraint violations and display their definitions; 
violating activities; the ability to create a DAS across the requested time period; and the ability to create a DAS with specified load 
outputs within a short period of time. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. -2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. ­
2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

Appendix G 

The Master Plan will contain scheduled activities and 
Support Tools consist of the Activity Definer, General Scheduler, Timeline, BAP Definer, Ground Script Display, and 

The DAS/ATC is generated at this point to verify the capability to check ground directives against schedule 
The notification of constraint violations should appear during DAS generation. Hard constraint violations are tested 

the ability to remove the 

Reference Test Case SYS

Reference Test Case SYS

5-91 322-CD-007-002/ 
411-CD-007-002 



3. Log onto an FOT User Station. 

Start the User Station. Reference Test Case SYS-2010B ­
- User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

4. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

5. Select the ‘General Scheduler’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The General 
Scheduler window appears. 

6. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

7. Select the ‘EOC Timeline’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. The EOC Timeline 
window appears. 

8. Within the EOC Timeline select the ‘Open’ option under 
the File menu. 

The New Plan dialog box appears. 

9. Select the Plan Name. 

Master Plan 

Enter a start date and time. 

1997/241 00:00:00 

Enter a stop date and time. 

1997/245 00:00:00 

Click the ‘OK’ button 

The Open Plan dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:1. 

10. Activity Scheduling 

From the General Scheduler window, click the ‘Resource’ 
button and select a resource. 

The resource appears on the Resource button. 

5-92 322-CD-007-002/ 
411-CD-007-002 



11. Select the ‘Activities’ option from the ‘Filter’ menu. A list of activities defined under the resource 
appears in the Activities field. 

12. Select the an activity for scheduling. (Activity must not 
violate a constraint) 

Select the ‘Master Plan:1’ as the scheduling plan. 

The selected activity and plan are highlighted. 
Default scheduling information appears. 

13. Select the ‘Impact’ option under the Action menu. The Impact button is selected. 

14. Click on the Schedule button. The activity will appear on the timeline in the 
specified scheduled location. 

15. Click the ‘Save’ button on the timeline. The current contents are saved to the Master Plan. 

16. From the Control window, click on the Tools button. The Tools dialog box appears. 

17. Select the Load Generate option. 

Click the ‘OK’ button 

The Tools dialog box closes. The Load Generate 
window appears. 

18. Load Generate Window 

Select the DAS/ATC toggle button. 

Select the Master Plan from the Plans field. 

Input a valid DAS time. 

Input a valid Uplink Request. 

Click the ‘Submit’ button. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue field. Upon 
completion the job will appear in the Jobs 
Completed field. The DAS will result with a 
Completed status. An Uplink process for the ATC 
load will result with a Complete status. 

19. Repeat the Activity Scheduling steps for scheduling a 
Proc under the AM1 resource on the timeline. 

The Proc will appear on the timeline in the 
specified scheduled location. 

20. Click the ‘Save’ button on the timeline. The current contents are saved to the Master Plan. 
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21. Repeat the Load Generating steps for a new DAS which 
will include the scheduled Proc. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue field. Upon 
completion the job will appear in the Jobs 
Completed field. The DAS will result with a 
Completed status. An Uplink process for the ATC 
load will result with a Complete status. 

22. Repeat the Activity Scheduling steps for scheduling 
activities that would violate hard and soft constraints. 

The activities will appear on the timeline in the 
specified scheduled location. The activities will 
appear with their violation patterns indicated. 

23. Click the ‘Save’ button on the timeline. The current contents are saved to the Master Plan. 

24. Repeat the Load Generating steps for a new DAS which 
will include the scheduled activities. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue field. Upon 
completion the job will appear in the Jobs 
Completed field. The DAS will result with a 
Failed status. 

25. Select the failed DAS in the Jobs Completed field. 

Click the ‘View Constraints’ button. 

A Constraint dialog box appears with failed 
reason stated within the text field. 

26. Verify the violations are correct and click the ‘Close’ 
button to close out the box. 

The constraint Violation dialog box closes. 

27. Within the timeline verify the resource limits were not 
exceeded for the power and SSR totals. 

The graphs will indicate a plot below the 
horizontal maximum limit line. 

28. Within the timeline display select the activity violating the 
hard constraint. 

Click the ‘Cut’ button to unschedule the activity. 

The activity is removed from the timeline. 

29. Click the ‘Save’ button on the timeline. The current contents are saved to the Master Plan. 
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30. Repeat the Load Generating steps for a new DAS which 
will include the scheduled activities. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue field. The job 
status will reach a pending state. 

31. Select the job in the que. 

Click the ‘View Constraints’ button. 

A Constraint dialog box appears with the soft 
constraint violation listed in the text field. 

32. Click the ‘Approve’ button. The Constraint dialog box closes. The DAS 
process accepts the soft constraint. Upon 
completion the job will appear in the Jobs 
Completed field. The DAS will result with a 
Completed status. An Uplink process for the ATC 
load will result with a Complete status. 

33. Within the General Scheduler, repeat the Activity 
Scheduling steps to schedule the necessary BAPs that 
would provide at least 1000 activities within a 24 hour 
time period. 

The activities will appear on the timeline in the 
specified scheduled location. The activities will 
appear with their violation patterns indicated. 

34. Click the ‘Save’ button on the timeline. The current contents are saved to the Master Plan. 

35. Repeat the Load Generating steps for a new DAS which 
will include the scheduled activities. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue field. Upon 
completion the job will appear in the Jobs 
Completed field. The DAS will result with a 
Completed status. An Uplink process for the ATC 
load will result with a Complete status. 

36. End of test. 
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Command Generation


Test Case No: 2001B 

Test Configuration: See Appendix G 

Test Support: EOC startup scripts, DMS, RMS, CMS, CMD, FUI , sc 

Test Case Description: 

This test will verify the following functions of the Command Generation: 

a. Encase packets within a command link transmission unit. 

b. Monitor command link control words (CLCWs) from the spacecraft to ascertain status of the command link. 

c. Support the generation of FARM control commands. 

d. append the necessary acquisition sequence to the CLTU(s) 

e. Append the necessary gap to the CLTU prior to transmission to EDOS. 

Success Criteria: 

This test is successful when all of the above functions pass. 

Note: 

• Parameters inside the <> will be provided at run time. 
• When necessary in this test, a displayed window may be resized and/or relocated in order to see view data as related to a specific 

step. 

Step Id Action Remark/Expected Result/Output Pass/ 
Fail 

1. Log onto a EOC workstation, and open a terminal 
window. Log onto a EOC workstation under one of 
the fostest accounts (fostest1, fostest2, fostest3, 
fostest4) 

Username: fostest2 

Password: ********* 

prior to transmission to EDOS. 
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2. From a new terminal window: 

Starts the Data Server. Refer to Test Case SYS­
2000B – FOS Server Startup. 

Data Server processes are running. 

3. From a new terminal window: 

Starts the Real-Time Server. Refer to Test Case 
SYS-2000B – FOS Server Startup. 

Real-Time Server processes are running. 

4. From a new terminal window: 

Logs onto an FOT User Station. 

Start the User Station. Reference Test Case SYS­
2010B -- User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

5. Click on “Tools” button. The Tool Selection Dialog Box will appear on the 
screen. 

6. Selects Events_Display-Global from the Tool 
Selection Dialog Box. 

The Event Display window will appear on the screen. 

7. At an user station, connect to a real-time operational 
string. 

From the Control window enter the following ECL 
directive 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

Verify the following messages appear in the Event 
Display window: 

Successfully connected to string 100”. 
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8. Take CAC privilege. Using the ECL command line 
in the Control window enter 

ECL>TAKE COMMAND STRING = 100 

An event message via event display indicating 
privileges have been granted. Message indicates 
“Command Authority starting ‘hostname’ for string 
100. 

(Note: EOC operator now has the authorization to issue 
individual commands in real time. For more 
information regarding Command authorization please 
refer to test case CMD-2000B) 

9. Using the ECL command line in the Control window 
enter 

ECL>TAKE GROUNDCONTROL 
STRING=100 

An event message via event display indicating 
privileges have been granted. Message indicates 
“Ground Control starting ‘hostname’ for string 100. 

10.  ‘Click on Tools button’ 

11. Select Command_Control from the Tool Selection 
Dialog Box. 

Click ‘OK’ 

Tools selection dialog box appears; Command_Control 
is displayed in the ‘selection’ text box. 

Command Control window is displayed. A small dialog 
box with the title “CCW/CMW” appears on top of 
Command Control window prompting user to enter 
String and Spacecraft Id. 

12. Enter String id (ex. 100) 

Enter Spacecraft ID (ex. AM1) 

Click “OK” on “CCW/CMW dialog box. 

The Command Control window is displayed with all 
five user interface (pull down) menus; File, Edit, 
Config, Utility, and Help. 

There are five columns: DATE/TIME, BUFFER, 
TYPE, DIRECTIVE, STATUS 
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13. Start ‘sc’ simulator/Command Tool. From a terminal 
window enter the following: 

% rlogin <hostname> where hostname= real­
time server 

% cd /fosb/test/am1/scripts/setup 

% setenv SCRIPT RealTimeServer 

% source FosEnvVars 

% cd /fosb/test/am1/bin/sun_sparc_5-5 

% sc AM1 100 Ops 

CLCWs will be generated. The following messages 
will be displayed 

***sc waiting for messages*** 

CLCW before send to FOP 0 

14. From the Command Control window enter the 
following directive to set VR value to the requested 
value: 

Cmd:> FOP INIT VR=0 

Click ‘Resume’ 

Click ‘Send’ 

Type BC control command (set VR) is generated. 

Spacecraft frame sequence number is initialized to 0 
and will be shown on Commanding Ground Parameter 
Display. 

View events display for the following messages: 

CLTU id SetVr placed in command data block number 
1 

Protocal Info: FOP initialiing set Vr command 

Command Data Block number 1 sent to EDOS 

Protocal Info: Successful FOP INIT with BC cmd 

5-99 322-CD-007-002/ 
411-CD-007-002 



15. Enter the following to change directory to 
tlmarchive: 

%: cd /fosb/test/am1/tlmarchive 

% ls -ltr 

A logging file for the command link control word 
(CLCW.log) is generated with current date and time 
stamp in directory /fosb/dev/am1/tlmarchive. 

16. Running Unix tools named od to dump the file in hex 
format, and generate a report name CLCW.dat. 

%: od -x CLCW.log > output file 

Print output file 

Value shown “000” (which means No Fault Detected” 
in the Status field of the Command Link Control Word 
Format in CLCW.log 

(Note: Refer to ICD-106 page 43 to locate the field for 
Status field in command link control word format). 

17. Initiate Command Ground Parameter Display Page 

Click ‘Tools’ Button 

Select ‘CMD_GRD_CFG’ 

Click ‘OK’ 

The Tools dialog box appears 

The name of the Tool selected appears in the selection 
text box. 

18. Monitor on Commanding Ground Parameter Display 
for any CLCW status below: 

CLCW wait flag 

CLCW retransmit flag 

CLCW lockout flag 

The information is correct and verified. 
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19. Octal dump command data block: 

%: cd /fosb/test/am1/reports (skip if already 
set). 

%: ls -ltr 

%: od -x CDB.log > output file 

A logging file for the command data block (CDB.log) 
is generated with current date and timestamp in 
directory /fosb/int/am1/reports. 

CDB.log is generated. 

20. Print output file 

% lp < output file > 

A hard copy is sent to the printer. 

21. Observe CDB.log and bit busting data. Verify in the CDB.log file contains information 
regarding ByPass flag and Control Command flag. The 
ByPass flag and Control Command flag are shown 11 
(values in hex). 

(Note: Refer to ICD-106 page 31 to locate the fields for 
ByPass flag and Control Command flag in command 
data block) 

22. Observe CDB.log and bit busting data. Verify in the CDB.log file contains information 
regarding Control Command Type and FARM code. 
The Control Command Type should be “0000000”, 
FARM code should be “0000000”, and qualifying data 
should be “00000000’. 

(Note: Refer to CCSDS recommendation for 
telecommand: data routing service to locate the fields 
for Control Command Type and for FARM code.) 
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23. From the Command Control window enter the 
following directive 

Cmd:> CMDCFG PLOP=1 

Monitor for Plop 1 selected flag on Commanding 
Ground Parameter Display. Note: PLOP 1 is the default 

24. Issues individual commands in real time: 

From the Command Control window input line enter 
a command directive. 

Cmd:> /AST_TURN_ON_C_TDP 

Click the ‘Resume’ button 

Click the “Send” button 

A send/cancel message will flash in the status column 
of the Command Control window. 

The message in the status column indicates that the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data block 
#. The # will be based on the number of command data 
blocks sent. 

The command data block is successfully transmitted to 
EDOS. 

25. Repeat octal dump command data block step. A logging file for the command data block (CDB.log) 
is generated with current date and timestamp in 
directory /fosb/test/am1/reports. 

CDB.log is generated. 

26. Print CDB.log. 

% lp <CDB.log> 

A hard copy is sent to the printer. 
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27. Observe CDB.log and analyze command data block. The command data block contains Ground Message 
Header (24 bytes), acquisition sequence, CLTU and 
gap (8 bytes of all 0’s). 

Verify that in the Ground Message Header, value in the 
14th byte should reflect “002a’” in hex which is 
dedicated for Mission’s Spacecraft Identification AM1. 
(Reference to Table 5.1.2.1-1. EDOS Ground Message 
Header and Table 5.1.3-2.) 

28. Observe CDB.log and analyze command data block. Verify in the CDB.log file contains information 
regarding packets about command link transmission 
unit (CLTU). 

Note: (CLTU consists of a start sequence which is 
“eb90” in hex, the encoded transfer frame (consists of 5 
octets header + 10 octets data packets + 2 octets TFEC) 
and tail sequence which is “555555555555” in hex. 

29. Observe CDB.log and analyze command data block. Verify in the CDB.log file contains the acquisition 
sequence of 25 bytes long of all “aa” (hex value). 
(Note: refer to ICD-106 for more details on acquisition 
sequence.) 

30. Look into the directory: 

/fosb/test/am1/reports 

Another logging file for the command data block 
(CDB.log.nrz) is generated with current date and 
timestamp in directory /fosb/dev/am1/reports. 

31. Octal dump CDB.log.nrz: 

%: od -x CDB.log.nrz >&CDB.nrz 

CDB.nrz is generated. 
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32. Print CDB.nrz 

% lp <CDB.nrz> 

A hard copy is sent to the printer. 

33. Observe CDB.nrz. Verify in the CDB.nrz file contains information about 
command data in NRZ-M format. The EDOS ground 
message header (24 bytes) in CDB.nrz is the same as in 
CDB.log. The rest are differ from CDB.log. 

34. Send another command: 

From the Command Control window input line enter 
a command directive. 

Cmd:> /AST_TURN_OFF_C_TDP 

Click the ‘Resume’ button 

Click the ‘Send’ button 

A send/cancel message will flash in the status column 
of the Command Control window. 

The message in the status column indicates that the 
command has been processed. 

The message in the status column indicates that the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data block 
#. The # will be based on the number of command data 
blocks sent. 

The command data block is successfully transmitted to 
EDOS. 

35. Repeat octal dump command data block step. A logging file for the command data block (CDB.log) 
is generated with current date and timestamp in 
directory /fosb/test/am1/reports. 

CDB.log is generated. 
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36. Print CDB.log. 

% lp <CDB.log> 

A hard copy is sent to the printer. 

37. Observe CDB.log and analyze command data block. Bit busting the data to verify that we are building and 
applying the 1553-B header correctly. (Note: Refer to 
ICD-106 to locate the field for the command 
destination which is 1553B Command Word.) 

38. Observe CDB.log and analyze command data block. Verify in the CDB.log file contains the necessary gap: 
8 bytes of all 0’s append to the CLTU. 

39. Observe CDB.log and analyze command data block. Verify in the CDB.log file contains information 
regarding information about spacecraft identification 
for the CTIU. Its value in hexadecimal should be “a9” 
for CTIU1 which is the active CTIU by default. (Note: 
Refer to ICD-106 to locate the field for CTIU.) 
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40. Enter ECL directive using it raw (hex formatted 
command): 

ECL> /RAW 0x502230000001 

Click ‘Send’ button 

Click ‘Allow’ button 

Verify the user is prompted to enter “Allow” or 
“Cancel”. 

The command is flagged as critical. An Allow or 
Cancel messages flashes in status column. 

The message in the status column indicates that the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data block 
#. The # will be based on the number of command data 
blocks sent. 

The command data block is successfully transmitted to 
EDOS. 

Verify that the directive is executed. 

41. Repeat Octal dump steps. 

42. From User Station (optional): 

a. Enter the following to change directory to setup: 

%: cd /fosb/test/am1/scripts/setup 

b. Enter MyKill. 

All processes has been brought up before will be killed. 

43. Log off User Station. 

44. End of test. 
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Ground Script Control & Manipulation Test Procedure


Test Case No: Command 2010B 

Test Configuration:  See Appendix G 

Test Support: EOC startup scripts. Generated DAS, FOS User Interface, DMS, RMS, CMS, CMD and files “hw.db’ and 
“user.db” contain a list of valid EOC user stations and valid userid, respectively, that are authorized by for CAC and Ground 
Control. 

Test Description: 

This test demonstrates that a user with CAC privileges is provided the tools necessary to initiate the execution of a ground 
script and manipulate ground script execution. 
directives, transferring the execution of a directive, merging a procedure, suspending, resuming and termination of the 
currently executing ground script, executing ground script in confirmation mode (Step mode) and Auto mode. The user will 
have the ability to search for a specified text string, command or procedure. In addition, this test will verify the displays 
provided to the users for validating proper execution of ground script directives. Prior to executing the ground script the user 
can view the contents of the ground script from the Ground Script Display window. 

Success Criteria: 

Successful demonstration of CAC capabilities to select a valid ground script, initiate execution of the ground script, 
manipulate ground script control and terminate the ground script via user directives. The procedure contained in ground 
script expands and executes. The user can specify a find criteria based on a text string, command or procedure and the system 
will search the ground script. The ground script should process command directives for the spacecraft. When the ground 
script is placed in confirmation mode (step mode) the user is prompted for each directive and has the option to cancel or 
confirm pending commands. The ground script can be viewed from the Ground Script Display window. 

Step 
Id 

Action Expected Result/Output Pass/ 
Fail 

Manipulation of this ground script includes; enable/disable of individual 
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1. Log onto a EOC workstation, and open a terminal 
window. 

A blank desktop area with an xterm window 

2. Initiate Data Server, Real-time and User Station 
Startup scripts. 

The EOC system is up and running 

3. Invoke the Event Display window by entering the 
following in the ECL directive line 

Click the ‘TOOLS’ button on the Control window 

Select Event Display-Global 

Click ‘OK’ 

A list box appears 

Event Display-Global appears in the selection filter 
box 

An event display window appears 

4. Connect to a real-time string. From the Control 
window enter the following ECL directive 

ECL> STRING CONNECT STRING=100 
CONFIG= MIRROR 

String Manager will attempt to connect to a real-time 
string when this process is complete, an event 
message: 

‘Successfully connected to string 100’. 

5. Take CAC privilege. Using the ECL command line 
in the Control window enter 

ECL>TAKE COMMAND STRING = 100 

ECL> TAKE GROUNDCONTROL 
STRING=100 

An event message via event display indicating 
privileges have been granted. Message should 
indicate userid and workstation hostname. 

5-108 322-CD-007-002/ 
411-CD-007-002 



6. Select the desired ground script to execute the times 
will be based on the DAS generated. View the 
integrated report file associated with the selected 
DAS. 

7. Open a terminal window. 

%cd /fosb/test/am1/reports/integrated 

%ls -ltr 

An xterm window pops up. 

Displays a list of files in that directory the most 
recent fill file will appear at the bottom of the 
directory. 

8. To view the ASCII file Integrated Report enter 

% more “filename” 

The contents of the file are displayed. Note, the start 
and stop times of the DAS. 

9. Initiate the Ground Script Display Window. 

Click on the Tools button from Control window. 

Select Ground Script Display. 

Click OK. 

The Tools dialog box appears. 

Ground Display Window appears in the selection 
text box. 

The Ground Script Display Window is displayed. 

10. View ground script prior to execution 

Select a ground script to display. Using the "File" 
pull down menu in Command Control window 
select the “Open” option. 

A time selector dialog box appears 
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11. Click ‘Select Time’ 

Enter the start time of the ground script selected for 
display 

>YYYY/DDD HH:MM:SS.mmm 

Press the Enter key. 

Enter the stop time of the ground script selected for 
display. 

>YYYY/DDD HH:MM:SS.mmm 

Press the Enter key. 

Click ‘OK’ 

Click ‘OK’ 

The times entered will be displayed in the start and 
stop time text fields. 

The Stop and Start times entered will be updated at 
the bottom of the window. 

The Ground Script Display Window should contain 
the following: 

G/S Start Time 

G/S Stop Time 

An Expand push button 

s/c: AM1 

Mode: Operational 

12. Close Ground Script Display Window 

Click ‘OK’ 

A confirmation dialog box appears, prompting user 
Do you really want to quit? 

The Ground Script Display window is no longer in 
view. 

13. Activate Command Control window using the 
following tool directive from the Control window. 

ECL> TOOL Command_Control 

A dialog box appears prompting user to enter String 
and Spacecraft Id. 
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14. enter String id (ex. 100) 

enter Spacecraft ID (ex. AM1) 

click “OK” 

The Command Control window is displayed with all 
five user interface (pull down) menus; File, Edit, 
Config, Utility, and Help. 

There are five columns: DATE/TIME, BUFFER, 
TYPE, DIRECTIVE, STATUS (Note: User may 
need to resize window if all columns are not 
displayed) 

15. Start ‘sc’ Command Tool. From a terminal window 
enter the following: 

% rlogin <hostname> where hostname= real­
time server 

% cd /fosb/test/am1/scripts/setup 

% setenv SCRIPT RealTimeServer 

% source FosEnvVars 

% cd /fosb/test/am1/bin/sun_sparc_5-5 

% sc AM1 100 Ops 

The real-time host name will be displayed at prompt. 
The environment variables need to run the tool will 
be set. 

The tool will start sending CLCWs. 

CLCWs will be generated. The following messages 
will be displayed: 

***sc waiting for messages*** 

CLCW before send to FOP 0 

16. From the Command input line in the Command 
Control window, initialize FOP: 

>FOP INIT CHECK 

Click ‘Resume’ 

Click ‘Send’ 

The directive will be placed in the Directive column 
of the CCW. 

A send/cancel message will flash in the status 
column of the Command Control window 

The following event messages will be generated: 

‘String Manager successfully configured’ 

‘FOP INIT with CLCW check successful 
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17. Select a ground script for execution. Using the 
"File" pull down menu in Command Control 
window select the “Open” option. 

A time selector dialog box appears 

18. Enter the DAS start time of the ground script 
selected for execution. 

> YYYY/DDD HH:MM:SS.mmm 

press the Enter key 

Enter the DAS stop time of the ground script 
selected for execution. 

>YYYY/DDD HH:MM:SS.mmm 

press the Enter key 

The times entered will be displayed in the start and 
stop time text fields. 

The Stop and Start times entered will be updated at 
the bottom of the window. 

19. Click ‘OK’ A WARNING dialog box will appear with dates and 
times specified, prompting user to load ground 
script. 

20. Click ‘OK’ to load the ground script The contents of the ground script will be displayed 
in the text area of the window. 
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21. Verify the following items are properly displayed 
in the Command Control window. 

ground script start time 

ground script stop time 

spacecraft id associated with ground script 

ground script status - Suspend (default) 

ground script processing mode - Auto (default) 

current bias time 

verification flags (Prerequisite State Check 
(PSC)=ON, Command =ON, and Telemetry 
(TV)=ON) 

The commands/directives displayed should represent 
the time period specified. 

22. Turn TV off. 

Use Config Option pull down menu, and select 
Telemetry Verfication. 

TV = OFF 

23. Put ground script in confirmation mode 

enter MODE STEP. 

Click ‘Resume’. 

Click ‘Send’. 

Note: This makes for easier manipulation. 

A send or cancel message will flash in the status 
column. 

The Mode displayed is changed from “Auto” to 
“Step”. 

24. Click on the “Resume” button to invoke the 
execution of the ground script. 

G/S Status is “Active”. 
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25. Use the scroll bar to view directives in ground 
script. 

The user will be able to see executed ground script 
directives, current ground script directive and future 
ground script directives. 

26. Suspend the execution of the current ground script. The ground script should stop execution and the G/S 
Status is “Suspend”. 

27. Disable a directive in the current ground script that 
has not been executed. 

Select the desired directive. 

Click the "disable" button to disable the directive. 

The status column for that directive status is 
“disabled”. 

28. Click on the “Resume” button. G/S Status should be “Active”. The ground script 
will began executing and the disabled directive will 
be skipped. 

29. Suspend the execution of the current ground script. The ground script should stop execution and the G/S 
Status is “Suspend”. 

30. Disable a directive in the current ground script that 
has not been executed 

Select the desired directive. 

Click the "Disable" button to disable the directive. 

The status column for that directive status is 
“disabled”. 

31. Enable the directive that has been disabled. Select 
the disabled directive. Click the "Enable" button to 
enable the directive. 

The status column for that directive status is 
“enabled”. 

32. Click on the “Resume” button. G/S Status should be “Active”. The ground script 
will began executing and the disabled/enabled 
directive will be executed. 
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33. Suspend the execution of the current ground script. The ground script should stop execution and the G/S 
Status is “Suspend”. 

34. Transfer the execution to a directive in the ground 
script. 

Select a non-executed directive in the ground script. 

Click on the "Set Jump" button to jump to the 
specified directive. 

The “Set Jump” button will place ‘Skip’ in the status 
column of all directives above the cursor. Once the 
ground script is resumed the directives will not be 
executed. 

35. Deselect a set jump target in the executing ground 
script. 

Select another set of non-executed directive in the 
ground script. 

Click on the "Set Jump" button to jump to the 
specified directive. 

Click on the “Clear Jump” button. 

Click ‘Resume’. 

The “Clear Jump” button will deselect the directives 
initially selected to jump. Once the ground script is 
resumed the directives will execute. 

Verify this directive executes after the current 
directive has been successfully executed. 

36. Click on the “Resume” button. G/S Status should be “Active”. The ground script 
will began executing and the directives with the |skip 
status will not be executed and the ones with the 
Reset|Skip| status will execute. 

37. Suspend the execution of the current ground script. The ground script should stop execution and the G/S 
Status is “Suspend”. 
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38. Place ground script in confirmation mode (step 
mode). 

Use the “Config” pull down menu 

Select mode step 

The Mode displayed is changed from “Auto” to 
“Step”. 

39. Click on the “Resume” button G/S Status should be “Active”. The ground script 
will began executing and will prompt the user for 
confirmation of each directive. 

40. Merge a procedure with the ground script. 

Suspend the execution of the current ground script. 

Click on the "suspend" button. 

G/S Status is “Suspended”. 

41. Enter the following from the Command input line 
to start the PROC: 

START <procname> 

Click the “Resume” button to resume the 
suspended ground script. 

The status column will display ‘canceled’ for that 
directive. 

G/S Status is “Active” indicating ground script 
execution has resumed 

The procedure will expand. The procedure is 
complete when the last directive has a processed 
status. 
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42. Search the executing ground script for a specific 
procedure. 

Use the “Utility” menu option select “Find”. 

Select Procedure Name 

Enter the procedure name in the search text box. 

Click ‘Search’ button 

Click ‘Cancel’ 

A search dialog box is displayed 

Verify the entire line containing the procedure is 
highlighted 

43. Search the executing ground script for a specified 
time stamp. 

Go to the “Utility” pull down menu select “Find” 
option. 

Select Time option 

Enter the specified time in the find dialog window 

YYY/DDD HH:MM:SS 

Click ‘Search’ button 

Click ‘Cancel’ 

A search dialog box is displayed 

Verify the entire line containing the specified time is 
highlighted 
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44. Search the executing ground script for a specified 
text string. 

Go to the “Utility” pull down menu select “Find” 
option. 

Select Text String option. 

Enter the specified text string in the search text box. 

Click ‘Search’ button. 

Click ‘Cancel’. 

A search dialog box is displayed. 

Verify the entire line containing the specified text 
string is highlighted. 

45. Search the executing ground script for a specified 
command. 

Go to the “Utility” pull down menu select “Find” 
option. 

Select Command option. 

Enter the specified command in the find dialog 
window. 

Click ‘Search’ button. 

Click ‘Cancel’. 

A search dialog box is displayed. 

Verify the entire line containing the command 
selected is highlighted. 

46. Print the ground script. 

Go to “File” option and select “Print”. 

A hard copy of the ground script will be received 
from the printer. 

47. Terminate the current ground script by clicking on 
the "kill" button. 

A dialog box appears prompting user for certainty. 

48. Click ‘OK’. The Command Control window closes. 
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Ground Script Commanding Test Procedure


Test Case No: CMD 2015B 

Test Configuration: See Appendix G 

Test Support: EOC startup scripts, A Detailed Activity Schedule (DAS) with prerequisite state check, critical, 
submnemonic, and regular safety commands, hard copies of command pdb definitions. 

Test Description: 

This test is designed to verify the FOS capability to process critical commands, 
prerequisite state checks for commands that are contained as part of a ground script. 
prerequisite state check fails, or if a submnemonic is defined out of range the user can override the command directive or 
cancel the command directive. The test data will consist of generating a DAS consisting of all command types listed above. 
The commands 
from the ground schedule. This test also, demonstrates that for commands issued as part of a ground script, the FOS is 
capable of recognizing and executing valid command definitions based on the FOS PDB files. 

Success Criteria: 

The authorized user should be to override or cancel the command directive when prerequisite state check fails using the FUI 
interface options provided by the Command Control window (CCW). The submnemonic command definitions that are 
invalid should be rejected, based on the definition in the command PDB, however the user can override or cancel the 
command directive. The user should receive status of the command directive in the CCW. All commands are validated 
according to the FOS command PDB definitions. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto a EOC workstation, and open a terminal 
window. 

A blank desktop area with an xterm window. 

2. Initiate Data Server, Real-time and User Station Startup 
scripts. Reference Test Case #. 

The EOC system is up and running. 

commands with submnemonics, and 
Once, that ground script is executed the 

in the DAS will be placed in the ground schedule. The ground script will be a result of requesting the times 
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3. Invoke the Event Display window by entering the 
following in the ECL directive line. 

Click the ‘TOOLS’ button on the Control window. 

Select Event Display-Global. 

Click ‘OK’. 

A list box appears. 

Event Display-Global appears in the 
selection filter box. 

An event display window appears. 

4. Connect to a real-time string. From the Control window 
enter the following ECL directive. 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

String Manager will attempt to connect to a 
real-time string when this process is 
complete, an event message: 

‘Successfully connected to string 100’. 

5. Take CAC privilege. Using the ECL command line in the 
Control window enter. 

ECL>TAKE COMMAND STRING = 100 

ECL> TAKE GROUNDCONTROL 
STRING=100 

An event message via event display 
indicating privileges have been granted. 
Message should indicate userid and 
workstation hostname. 

6. Activate Command Control window using the following 
tool directive from the Control window. 

ECL> TOOL Command_Control 

A dialog box appears prompting user to enter 
String and Spacecraft Id. 

7. Enter String Id (Ex. 100) 

Enter Spacecraft ID (Ex. AM1) 

Click “OK” 

The Command Control window is displayed 
with all five user interface (pull down) 
menus; File, Edit, Config, Utility, and Help. 

There are five columns: DATE/TIME, 
BUFFER, TYPE, DIRECTIVE, STATUS. 
(Note: User may need to resize window if all 
columns are not displayed.) 
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8. Start ‘sc’ Command Tool. From a terminal window enter 
the following: 

% rlogin <hostmane> where hostname= real-time 
server 

% cd /fosb/test/am1/scripts/setup 

% setenv SCRIPT RealTimeServer 

% source FosEnvVars 

% cd /fosb/test/am1/bin/sun_sparc_5-5 

% sc AM1 100 Ops 

The real-time host name will be displayed at 
prompt. The environment variables need to 
run the tool will be set. 

The tool will start sending CLCWs 

CLCWs will be generated. The following 
messages will be displayed 

***sc waiting for messages*** 

CLCW before send to FOP 0 

9. Select the desired ground script to execute the times will 
be based on the DAS generated. View the integrated 
report file associated with the selected DAS. 

10. open a terminal window 

%cd /fos/test/am1/ reports/integrated 

%ls -ltr 

%ls 

A xterm window pops up. 

Displays a list of files in that directory with 
time order reverse. 

11. To view the ASCII file Integrated Report enter 

% more “filename” 

The contents of the file are displayed. Note, 
the start and stop times of the DAS. 
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12. Select ‘Open’ from the ‘File’ menu. 

Enter the start time of the ground script selected for 
display. 

>YYYY/DDD HH:MM:SS.mmm 

Press the Enter key. 

Enter the stop time of the ground script selected for 
display. 

>YYYY/DDD HH:MM:SS.mmm 

Press the Enter key. 

Click ‘OK’. 

A time selector window appears 

The times entered will be displayed in the 
start and stop time text fields 

The Stop and Start times entered will be 
updated at the bottom of the window. 

A confirmation box will appear with dates 
and times specified, prompting user to load 
ground script 

The ground script selected is displayed in the 
Command Control window (CCW). 

13. Verify the following items are properly displayed in the 
Command Control window. 

ground script start time 

ground script stop time 

spacecraft id associated with ground script 

ground script status - suspended (default) 

ground script processing mode - auto (default) 

current bias time 

verification flags (Prerequisite State Check (PSC)=ON, 
Command =ON, and Telemetry (TV)=ON) 

The commands/directives displayed should 
represent the time period specified. 

14. Click on the “Resume” button to invoke the execution of 
the ground script. 

G/S Status is “Active”. 
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15. Monitor the ground script to ensure all commands are 
successfully transmitted. 

The status column will display a status for 
each completed directive. 

Event messages will displayed indicating 
successful transmission of each command 

5-123 322-CD-007-002/ 
411-CD-007-002 



16. Adhere to the messages in the ground script 

Cancel the directive 

Allow critical command 

Override PSC 

Cancel PSC 

Override Submnemonic subfield error 

Cancel Submnemonic subfield error 

Cancel the critical command 

The status column will display ‘canceled’ for 
that directive. 

The critical command will be transmitted to 
EDOS, and an event message is generated. 
The status column in the CCW will display 
‘processed’ for that command. 

The PSC command will be transmitted to 
EDOS, and an event message is generated. 
The status column in the CCW will display 
‘processed’ for that command 

The PSC command will be canceled. The 
status column in the CCW will display 
‘canceled’ for that command 

The command with the out of range 
submnemonic will be transmitted to EDOS, 
and an event message is generated. The 
status column will display ‘processed’ for 
that command 

The command with the out of range 
submnemonic will be canceled. The status 
column will display ‘canceled’ for that 
command 

The critical command will be canceled. The 
status column will display ‘canceled’ for that 
command 
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Manual Commanding Test Procedure


Test Case No: 2030B 

Test Configuration:  See Appendix G 

Test Support: EOC startup scripts, DMS, RMS, CMS, CMD, FUI and sc (CLCW generator) 

Test Case Description: 

This test is designed to verify the FOS has the capability to support the processing of command directives that are entered manually via 
the command input line in the Command Control window (CCW) at a CAC user workstation during real-time. This test demonstrates 
that FOS is capable of recognizing regular safety commands, commands with valid and invalid submnemonics, hazardous, critical, 
commands, and prerequisite state check commands. A display page (entitled ‘prereq’) with PSC commands has been created to 
monitor the telemetry mnemonics associated with prerequisite state check commands. 

Success Criteria: 

The authorized user should be able to override or cancel a command directive when prerequisite state check fails. The user should be 
able to verify failed or passed status for all PSC commands by viewing the ‘prereq’ display page. Any manually entered submnemonic 
command definitions that are invalid should be rejected, based on the definition in the command PDB, however, the user can cancel or 
override the subfield error. The user should be able to allow or cancel critical commands, however hazardous commands will not be 
transmitted. 

Step Id Action Expected Result/Output Pass/Fail 

1. Log onto a EOC workstation, and open a terminal 
window. 

A blank desktop area with an xterm window. 

2. Initiate Data Server, Real-time and User Station 
Startup scripts. Reference Test Case # 

The EOC system is up and running. 
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3. Invoke the Event Display window by clicking the 
‘TOOLS’ button on the Control window. 

Select Event Display-Global. 

Click ‘OK’. 

A list box appears. 

Event Display-Global appears in the selection filter 
box. 

An event display window appears. 

4. Connect to a real-time string. From the Control 
window enter the following ECL directive: 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

String Manager will attempt to connect to a real-time 
string when this process is complete, an event 
message: 

‘Successfully connected to string 100’. 

5. Take CAC privilege. Using the ECL command line 
in the Control window enter: 

ECL>TAKE COMMAND STRING = 100 

ECL> TAKE GROUNCONTROL 
STRING=100 

An event message via event display indicating 
privileges have been granted. Message should 
indicate userid and workstation hostname. 

6. Invoke the Command Control window. 

Click the ‘Tools’ button on the Control window. 

Select Command_Control from the Tool Selection 
Dialog Box. 

Click ‘OK’. 

Tools  select ion dialog box appears;  
Command_Control is displayed in the ‘selection’ text 
box. 

Command Control window is displayed. A small 
dialog box with the title “CCW/CMW” appears on 
top of Command Control window prompting user to 
enter String and Spacecraft Id. 
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7. Enter String id (ex. 100). 

Enter Spacecraft ID (ex. AM1). 

Click “OK”. 

The Command Control window is displayed with all 
five user interface (pull down) menus; File, Edit, 
Config, Utility, and Help. 

There are five columns: DATE/TIME, BUFFER, 
TYPE, DIRECTIVE, STATUS. (Note: User may 
need to resize window if all columns are not 
displayed.) 

8. Start ‘sc’ Command Tool. From a terminal window 
enter the following: 

% rlogin <hostname> where hostname= real­
time server 

% cd /fosb/test/am1/scripts/setup 

% setenv SCRIPT RealTimeServer 

% source FosEnvVars 

% cd /fosb/test/am1/bin/sun_sparc_5-5 

% sc AM1 100 Ops 

The real-time host name will be displayed at prompt. 
The environment variables need to run the tool will 
be set. 

The tool will start sending CLCWs. 

CLCWs will be generated. The following messages 
will be displayed. 

***sc waiting for messages*** 

CLCW before send to FOP 0 
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9. From the Command input line in the Command 
Control window, enter the following directive to 
initialize FOP, and start AD service with CLCW 
check 

>FOP INIT CHECK 

Click ‘Resume’ 

Click ‘Send’ 

The directive will be placed in the Directive column 
of the CCW. 

A send/cancel message will flash in the status 
column of the Command Control window 

The following event messages will be generated: 

‘String Manager successfully configured’ 

‘FOP INIT with CLCW check successful’ 

FOP will accept whatever CLCW frame sequence 
number. 

10. Enter a regular safety (AD) command 

Using the Command input line from the Command 
Control window enter 

/AST_TURN_ON_C_VDP1 

Click ‘Resume’ 

Click ‘Send’ 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates that the 
command has been processed. 

View event display indicating: command <cmd 
mnem> (where <cmd_mnem> = Cmd entered) was 
successfully built with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 
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11. From the Command input line enter a command 
mnemonic with a valid submnemonic parameter 
value. 

/TCS_SET_PBATPWMA 
DUTYCYCLE=135 HTRGROUP=6 

Click ‘Resume’ 

Click ‘Send’ 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. Notice the following 
event messages 

View event display indicating: command <cmd 
mnem> (where <cmd_mnem> = Cmd entered) was 
successfully built with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

12. Enter a command mnemonic with an out range 
subfield value. 

/TCS_SET_PBATPWMA 
DUTYCYCLE=257 HTRGROUP=0 

A dialog box appears indicating invalid parameter 

for DUTYCYCLE 
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13. Enter a command mnemonic with valid 
submnemonic parameter values. 

/TCS_SET_PBATPWMA HTRGROUP=6 

DUTYCYCLE=205 

Click “Resume” button. 

Click the “Send” button. 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. 

View event display indicating: command <cmd 
mnem> (where <cmd_mnem> = Cmd entered) was 
successfully built with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

14. Enter a valid command mnemonic with a 
syntactically incorrect submnemonic parameter. 

/TCS_SET_PBATPWMA HTRGROUP*8 

A dialog box appears indicating invalid parameter. 
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15. Enter a command mnemonic with a valid 
submnemonic parameter value. 

/MOD_TEST_FR_PVGAIN GN= 248 

Click “Resume” button 

Click the “Send” button. 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

16. Enter a command mnemonic with a valid 
submnemonic parameter value. 

/MOD_TEST_FR_PVOFFSET OS= 0 

Click “Resume” button 

Click the “Send” button. 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 
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17. Enter a command mnemonic with an out of range 
subfield value. 

/MOD_TEST_FR_PVOFFSET OS= 256 

A dialog box appears invalid parameter 

18. Enter a command mnemonic without assigning the 
parameter values. (note: system will assign the 
default value). 

ECL> /TCS_SET_PBATPWMB 

Click “Resume” button 

Click the “Send” button. 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

Note: Verify via bit busting the command was 
accepted and default value was assigned 

19. Enter a invalid command mnemonic with an valid 
submnemonic. 

/MOD_STEP_SR_GRR_BSS SCANS=1 

. 

A dialog box appears indicating invalid parameter. 
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20. Enter a command with valid subnmenonic values 

/MOD_STEP_SR_GR_BSS SCANS=1 
STEPS =63 DIRECTION=1 

Click “Resume” button 

Click the “Send” button 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

Note: Verify via bit busting the command was 
accepted and default value was assigned 
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21. Enter a command submnemonic specifying only one 
of the subfield value. 

Click the “Resume” button. 

Click the “Send” button. 

/ MOD_STEP_SR_GR_BSS SCANS=1 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

Note: Verify via bit busting the command was 
accepted and default value was assigned for the 
mnemonics not specified. 
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22. Enter three (3)critical commands. 

/COM_ENABLE_SBT1_AON 

/COM_ENABLE_SBT2_AON 

/MOP_TURN_OFF_SIDE_A 

Click the “Resume” button. 

Click the “Send” button. 

Click “allow” button for each command. 

A send/cancel message will flash in the status 
column of the Command Control window. 

Event message indicating command is critical. 

An allow/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

Note: Verify via bit busting the command was 
accepted and default value was assigned. 

23. Enter three (3)critical commands. 

/TCS_DISABLE_TANK_H1B 

/MOP_SET_RD_SPARE 

/MOP_TURN_OFF_SIDE_B 

Click the “Resume” button. 

Click the “Send” button. 

Click the “cancel” button for each command 

A send/cancel message will flash in the status 
column of the Command Control window 

An allow/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been cancelled. View the event 
messages generated from the command indicating 
commands were cancelled 

5-135 322-CD-007-002/ 
411-CD-007-002 



24. Enter a hazardous command: 

/EAS_ENABLE_NEA_BUSB 

Click the “Resume” button. 

Click the “Send” button. 

An allow/cancel message will flash in the status 
column of the Command Control window. 

View the event message indicating command was 
hazardous. 

Command should not be transmitted. 

25. Enter a hazardous command: 

/EAS_ENABLE_NEA_BUSA 

Click the “Resume” button. 

Click the “Send” button. 

An allow/cancel message will flash in the status 
column of the Command Control window. 

View the event message indicating command was 
hazardous. 

Command should not be transmitted. 
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26. Send a prerequisite state check command with static 
telemetry values. 

/AST_TURN_OFF_C_SDP 

Click the “Resume” button. 

Click the “Send” button. 

Click ‘override’ 

Repeat above steps and cancel the command 

A send/cancel message will flash in the status 
column of the Command Control window. 

A PSC Fail -override/cancel message will flash in 
status column of the CCW. 

The message in the status column indicates the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

A cancelled message will appear in status column of 
Control window 
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27. Invoke the EDOS telemetry driver to generate 
telemetry packets to monitor prerequisite state 
check commands. 

In a terminal window, enter the following: 

%: cd /fosb/test/am1/scripts/setup 

%: setenv SCRIPT UserStation 

%: source FosEnvVars 

%: cd /fosb/test/am1/bin/sun_sparc_5-5 

%: FtPgPackGen 

From the Control window enter the following ECL 
directives: 

PG CONFIG HOST=225.2 .7 .00  
PORT=20101 APID=1 

PG STARTDATA APID=1 COUNT=-1 

Wait for message -- Packet Generator is ready to 
receive directives 

The telemetry driver starts sending packets. 

28. Bring up the ‘prereq’ display page. 

Click the ‘Tlm Wins…’ button the Control window. 

Select ‘prereq’. 

Click ‘ok’. 

A display page list boxes appears. ‘Prereq’ appears in 
the selected text field. The prereq page is displayed. 
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29. Enter a Prerequisite State Check command with one 
valid telemetry parameter value. 

/AST_TURN_OFF_C_SDP 

Click the “Send” button. 

check ‘AST_BR_C_S_PROCESS’ on the prereq 
telemetry page. If the value is ‘ON’ PSC check 
passes. 

If value is “OFF” a message in the status column 
should appear indicating PSC failure; override or 
cancel 

Click the ‘cancel’ button 

A send/cancel message will flash in the status 
column of the Command Control window. 

If PSC check passes the command will be 
transmitted. The message in the status column 
indicates the command has been processed. View the 
event messages generated from the command 
subsystem. 

If PSC fails an override/cancel message will flash in 
status column of the CCW. The command is not 
transmitted. The message in the status column 
indicates the command directive was canceled 
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30. Enter a Prerequisite State Check command with one 
valid telemetry parameter value. 

/CDH_ENABLE_CT1_OK 

Click the “Send” button. 

check ‘CDH_BR_ACT_IMOKDIST’ on the prereq 
telemetry page. If the value is ‘DISABLE’ PSC 
passes. 

If value is “ENABLE” a message in the status 
column should appear indicating PSC failure; 
override or cancel 

Click the ‘Override’ button 

A send/cancel message will flash in the status 
column of the Command Control window. 

If PSC check passes the command will be 
transmitted. The message in the status column 
indicates the command has been processed. View the 
event messages generated from the command 
subsystem. 

If PSC fails an override/cancel message will flash in 
status column of the CCW. The command is 
transmitted. The message in the status column 
indicates the command directive was processed. 
View the event messages generated from the 
command indicating: command <cmd mnem> 
(where <cmd_mnem> = Cmd entered) was 
successfully built with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 
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31. Enter a Prerequisite State Check command with one 
valid telemetry parameter value. 

/EPS_TURN_OFF_ADEA 

Click the “Send” button. 

check ‘EPS_BR_ADE_A_ON' on the prereq 
telemetry page. If the value is ‘ON’ PSC passes 

Verify the command was sent. 

If value is “OFF” a message in the status column 
should appear indicating PSC failure; override or 
cancel 

Click the ‘Cancel’ button 

A send/cancel message will flash in the status 
column of the Command Control window. 

If PSC check passes the command will be 
transmitted. The message in the status column 
indicates the command has been processed. View the 
event messages generated from the command 
subsystem. 

If PSC fails an override/cancel message will flash in 
status column of the CCW. The command is 
transmitted. The message in the status column 
indicates the command directive was processed. 
View the event messages generated from the 
command. 

32. Enter a Prerequisite State Check command with one 
valid telemetry parameter value. 

/EPS_SELECT_ADEA_FWD 

Click the “Send” button. 

check ‘EPS_BR_ADE_ACTSADIR on the prereq 
telemetry page. If the value is ‘REVERSE’ PSC 
passes 

Verify the command was sent. 

If value is “FORWARD” a message in the status 
column should appear indicating PSC failure; 
override or cancel 

Click the ‘Override’ button 

A send/cancel message will flash in the status 
column of the Command Control window. 

If PSC check passes the command will be 
transmitted. The message in the status column 
indicates the command has been processed. View the 
event messages generated from the command 
subsystem. 

If PSC fails an override/cancel message will flash in 
status column of the CCW. The command is 
transmitted. The message in the status column 
indicates the command directive was processed. 
View the event messages generated from the 
command. 
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33. Enter a Prerequisite State Check command with four 
valid telemetry parameters values: 

/AST_TURN_ON_C_SDP 

Click the “Send” button. 

Check the following telemetry mnemonics on the 
prereq telemetry page. 

Click ‘Override’. 

All of the values below must be displayed for the 
PSC to pass and the command transmitted. 

AST_BR_C_S_PROCESS = OFF 

CDH_BR_ACT_IMOKDIST = DISABLE 

CDH_CR_ACT_OSC_SEL = MO_B 

EPS_BR_ADE_A_ON = OFF 

The message in the status column indicates the 
command has been processed. View event display 
indicating: command <cmd mnem> (where 
<cmd_mnem> = Cmd entered) was successfully built 
with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

Otherwise, a message in the status column should 
appear indicating PSC failure; override or cancel. 

34. End of test. 
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Uplink Loads


Test Case No: 2050B 

Test Configuration:  See Appendix G 

Test Support: EOC startup scripts, a generated DAS containing uplink commands for a variety of loads: ATC, RTS, Table, Instrument 
and FSW loads. 

Test Case Description: 

This test 
and are ready for uplink. Secondly FOS shall provide the capability to view via telemetry the successful dispatch of absolute time stored 
commands and relative time stored commands. 

Success Criteria: 

The success of this test requires the demonstration that the FOS provides the user with a capability to uplink a variety of loads such as: 
RTS Load, Table Load, instrument and FSW load manually or via ground script. Demonstrate that the EOC is capable to verify via 
telemetry the successful dispatch of absolute time stored commands and relative time stored commands. 

Note: 

• Parameters inside the <> will be provided at run time. 
• When necessary in this test, a displayed window may be resized and/or relocated in order to see view data as related to a specific 

step. 
• Assume all loads (ATC load, RTS load, flight software load, table load, and instrument microprocessor load) are successfully 

generated and are ready for uplink. 

Step Id Action Remark/Expected Result/Output Pass/Fail 

1. Log onto a EOC workstation, and open a terminal 
window. Log onto a EOC workstation under one of 
the fostest accounts (fostest1, fostest2, fostest3, 
fostest4) 

Username: fostest2 

Password: ******* 

demonstrate the capability of FOS to uplink a variety of loads manually and via ground script; assume all loads are generated 
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2. From a new terminal window: 

Start the Data Server. Reference Test Case SYS­
2000B -- FOS Server Startup. 

Data Server processes are running. 

3. From a new terminal window: 

Start the Real-Time Server. Reference Test Case 
SYS-2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

4. From a new terminal window: 

Logs onto an FOT User Station. 

Start the User Station. Reference Test Case SYS­
2010B -- User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

5. Clicks on “Tools” button. The Tool Selection Dialog Box will appear on the 
screen. 

6. Selects Events Display-Global from the Tool 
Selection Dialog Box. 

The Event Display window will appear on the screen. 

7. At an user station, connects to a real-time 
operational string. 

From the Control window enters the following ECL 
directive 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

Verify the following messages appear in the Event 
Display window: 

“Successfully connected to string 100”. 
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8. Take CAC privilege. Using the ECL command line in 
the Control window enters 

ECL>TAKE COMMAND STRING = 100 

ECL> TAKE GROUNDCONTROL 
STRING=100 

An event message via event display indicating 
privileges have been granted. Message should indicate 
userid and workstation hostname. 

(Note: EOC operator now has the authorization to 
issue individual commands in real time. For more 
information regarding Command authorization please 
refer to test case CMD-2000B) 

9. Activates Command Control window using the 
following tool directive from the Control window. 

ECL> TOOL Command_Control 

Command Control window is displayed. A small 
dialog box with the title “CCW/CMW” appears on top 
of Command Control window prompting user to enter 
String and Spacecraft Id. 

10. Enters String id (ex. 100) 

Enters Spacecraft ID (ex. AM1) 

Clicks “OK” on “CCW/CMW” dialog box. 

The Command Control window is displayed with all 
five user interface (pull down) menus; File, Edit, 
Config, Utility, and Help. 

There are five columns: DATE/TIME, BUFFER, TYPE, 

DIRECTIVE, STATUS 
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11. Start ‘sc’ Command Tool. From a terminal window 
enter the following: 

% rlogin <hostname> where hostname= real­
time server 

% cd /fosb/test/am1/scripts/setup 

% setenv SCRIPT RealTimeServer 

% source FosEnvVars 

% cd /fosb/test/am1/bin/sun_sparc_5-5 

% sc AM1 100 Ops 

The real-time host name will be displayed at prompt. 
The environment variables need to run the tool will be 
set. 

The tool will start sending CLCWs 

CLCWs will be generated. The following messages 
will be displayed 

***sc waiting for messages*** 

CLCW before send to FOP 0 

12. From the Command input line in the Command 
Control window, enter the following directive to 
initialize FOP, and start AD service with CLCW 
check 

>FOP INIT CHECK 

Click ‘Resume’ 

Click ‘Send’ 

The directive will be placed in the Directive column of 
the CCW. 

A send/cancel message will flash in the status column 
of the Command Control window 

The following event messages will be generated: 

‘String Manager successfully configured’ 

‘FOP INIT with CLCW check successful’ 

FOP will accept whatever CLCW frame sequence 
number. 

13. Assume RTS load is generated. If not refer to RTS 
load generation test case (CMS-2170B) to generate 
RTS load prior to uplink. 

Note: Load contains critical commands 
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14. Change to the rts loads directory 

%: cd /fosb/test/am1/loads/rts 

%: cp <filename>.upl .. 

%: cd .. 

% ls ltr 

An image load (.img), a contents (.cnt) file and uplink 
load (.upl) are created. 

The uplink image file will be copied into the loads 
directory 

The file just copied will be listed in the current 
directory. 

15. Verify Load Catalog entry: 

a. %: isql -Ufos_dba 

b. password ***** 

c. 1>use am1_fos_ops 

d. 2>go 

e. 1>select * from fos_load_cat 

f. 2>go 

g. 1> exit 

The updated load catalog is stored/maintained within 
the DMS database. 

The load catalog fields include the load name, 
load_size, the uplink time, valid start time, valid stop 
time, and the spacecraft subsystem (sc_id). 

16. View load data: 

a. Enter the following to change directory to reports 

%: cd /fosb/test/am1/reports 

b. ls *.rpt 

A list of files in the specified directory will appear. 
There will be a file <RTS load name>.rpt associated 
with the load that was generated. 

17. View report: 

% more <filename.rpt> 

The contents of the report are displayed. Verify uplink 
window is still valid. 
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18. Invoke the EDOS telemetry driver to generate 
telemetry packets to monitor prerequisite state check 
commands. (Optional, only needed if user wants TV 
of load.) 

In a terminal window, enter the following: 

%: cd /fosb/test/am1/scripts/setup 

%: setenv SCRIPT UserStation 

%: source FosEnvVars 

%: cd /fosb/test/am1/bin/sun_sparc_5-5 

%: FtPgPackGen 

From the Control window enter the following ECL 
directives: 

P G  C O N F I G  H O S T = 2 2 5 . 2 . 7 . 0 0  
PORT=20101 APID=1 

PG STARTDATA APID=1 COUNT=-1 

Wait for message -- Packet Generator is ready to 
receive directives 

Note: CEV mnemonic represents telemetry parameter 
whose value verifies the receipt and execution of the 
command. CEV low value and high value must be 
equal). 

The telemetry driver starts sending packets. 

19. From Command Control window, enter the load 
uplink directive for a RTS load. 

ECL>LOAD <loadId> 
<partititionIndicator> <partitionAmount> 

Click ‘Resume’ 

Click ‘Send’ 

A send/cancel message will flash in the status column 
of the Command Control window. 

Verify through event display the load is transmitted 
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20. Assume instrument microprocessor load is generated. 
If not refer to instrument microprocessor load 
generation test case (CMS-2060B) to generate Table 
load prior to uplink. 

21. Enter the following to change directory to loads/mp: 

%: cd /fosb/test/am1/loads/mp 

%: ls 

%: cp <filename>.upl .. 

%: cd .. 

% ls -ltr 

An image load (.img), a contents (.cnt) file and uplink 
load (.upl) are created. 

The uplink image file will be copied into the loads 
directory 

The file just copied will be listed in the current 
directory. 

22. Repeat Verify load catalog entry steps. 

23. Repeat View load data steps for a Microprocessor 
load. 

24. From Command Control window, enter the load 
uplink directive for a microprocessor load. 

ECL>LOAD <loadId> 
<partititionIndicator> <partitionAmount> 

Click ‘Resume’ 

Click ‘Send’ 

A send/cancel message will flash in the status column 
of the Command Control window. 

Verify through event display the load is transmitted. 

25. Assume flight software load is generated. If not refer 
to flight software load generation test case (CMS­
2060B) to generate flight software load prior to 
uplink. 
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26. Enter the following to change directory to loads/fsw: 

%: cd /fosb/test/am1/loads/fsw 

%: cp <filename>.upl .. 

%: cd .. 

% ls -ltr 

An image load (.img), a contents (.cnt) file and uplink 
load (.upl) are created. 

The uplink image file will be copied into the loads 
directory 

The file just copied will be listed in the current 
directory. 

27. Repeat Verify load catalog entry steps for flight 
software load. 

28. Repeat View load data steps for flight software load. 

29. From Command Control window, enter the load 
uplink directive for a flight software load. 

ECL>LOAD <loadId> 
<partititionIndicator> <partitionAmount> 

Click ‘Resume’ 

Click ‘Send’ 

A send/cancel message will flash in the status column 
of the Command Control window. 

Verify through event display the load is transmitted. 

30. Assume table load is generated. If not refer to Table 
load generation test case (CMS-2040B) to generate 
table load prior to uplink. 
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31. Enter the following to change directory to loads/mp: 

%: cd /fosb/test/am1/loads/table 

%: cp <filename>.upl .. 

%: cd ../loads 

% ls ltr 

An image load (.img), a contents (.cnt) file and uplink 
load (.upl) are created. 

The uplink image file will be copied into the loads 
directory 

The file just copied will be listed in the current 
directory. 

32. Repeat Verify load catalog entry steps for table load. 

33. Repeat View load data steps for table load. 

34. From Command Control window, enter the load 
uplink directive for a table load. 

ECL>LOAD <loadId> 
<partititionIndicator> <partitionAmount> 

Click ‘Resume’ 

Click ‘Send’ 

A send/cancel message will flash in the status column 
of the Command Control window. 

Verify through event display the load is transmitted. 

35. From User Station (optional): 

a. Enter the following to change directory to setup 

%: cd /fosb/test/am1/scripts/setup 

b. run MyKill. 

All processes has been brought up before will be 
killed. 

36. Log off User Station. 

37. End of test. 
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Command Modes - Transmission & Uplink Test Procedure


Test Case No: 2070B 

Test Configuration:  See Appendix G 

Test Support: EOC startup scripts, DMS, RMS, CMS, CMD, FUI , sc, and FOP_INIT test proc 

Test Case Description: 

This test will verify the following functions of the Command modes - transmission & Uplink: 

a. Select Rate. 

b. Transmit Commands to the EOS spacecraft. 

c. Utilize a single virtual channel for uplink. 

d. Select CTIU. 

Also this test will provide the automatic retransmission of CLTU’s once it has been determined that commands have been lost. 

Success Criteria: 

The success of this test requires the demonstration that the FOS provides the user with a capability to select rate from a set of valid 
rate, to select either of the two CTIUs as the active CTIU, 
capability of retransmission 

Step Id Action Remark/Expected Result/Output Pass/ 
Fail 

Note: 

• Parameters inside the <> will be provided at run time. 
• When necessary in this test, a displayed window may be resized and/or relocated in order to see view data as related to a specific 

step. 

and to transmit commands to the EOS spacecraft. Demonstrate the 
since the commands have been lost during the transmission and uplink. 
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1. Log onto a EOC workstation, and open a terminal 
window. Log onto a EOC workstation under one of 
the fostest accounts (fostest1, fostest2, fostest3, 
fostest4): 

Username: fostest2 

Password: ******* 

2. From a new terminal window: 

Starts the Data Server. Refer to Test Case SYS­
2000B – FOS Server Startup. 

Data Server processes are running. 

3. From a new terminal window: 

Starts the Real-Time Server. Refer to Test Case 
SYS-2000B – FOS Server Startup. 

Real-Time Server processes are running. 

4. From a new terminal window: 

Logs onto an FOT User Station. 

Starts the User Station. Reference Test Case SYS­
2010B -- User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

5. Click on “Tools” button from the Control window. The Tool Selection Dialog Box will appear on the 
screen. 

6. Select Event Display--Global from the Tools 
Selection Dialog Box. 

The Event Display window will appear on the 
screen. 

7. At an user station, connect to a real-time 
operational string. 

From the Control window enters the following ECL 
directive 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

Verify the following messages appear in the Event 
Display window: 

“Successfully connected to string 100”. 
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8. Take CAC privilege. Using the ECL command line 
in the Control window enter: 

ECL>TAKE COMMAND STRING = 100 

ECL>TAKE GROUNDCONTROL 
STRING = 100 

An event message via event display indicating 
privileges have been granted. Message should 
indicate userid and workstation hostname. 

(Note: EOC operator now has the authorization to 
issue individual commands in real time. For more 
information regarding Command authorization 
please refer to test case CMD-2000B) 

9. Activate Command Control window using the 
following tool directive from the Control window. 

ECL> TOOL Command_Control 

Command Control window is displayed. A small 
dialog box with the title “CCW/CMW” appears on 
top of Command Control window prompting user to 
enter String and Spacecraft Id. 

10. Enter String id (ex. 100) 

Enter Spacecraft ID (ex. AM1) 

Click “OK” on “CCW/CMW” dialog box. 

The Command Control window is displayed with all 
five user interface (pull down) menus; File, Edit, 
Config, Utility, and Help. 

There are five columns: DATE/TIME, BUFFER, 
TYPE, DIRECTIVE, STATUS 

11. Make sure TV and CV are off if packet generator is 
not running. 

Use Config option pull down menu 

TV =Off and CV=Off 

12. Click on “TlmWins” button from the Control 
window. 

13. Click on “CMD_GRD_CFG” from the TlmWins 
display page. 

The Command Ground Parameter Display window is 
displayed. 
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14. Start ‘sc’ simulator. From a terminal window enter 
the following: 

% rlogin <hostname> where hostname= real-time 
server 

% cd /fosb/test/am1/scripts/setup 

% setenv SCRIPT RealTimeServer 

% source FosEnvVars 

% cd /fosb/test/am1/bin/sun_sparc5-5 

% sc AM1 100 Ops 

The real-time host name will be displayed at prompt. 
The environment variables need to run the tool will 
be set. 

CLCWs will be generated. The following messages 
will be displayed 

***sc waiting for messages*** 

CLCW before send to FOP 0 

15. From the Command input line in the Command 
Control window, initialize FOP 

ECL>FOP INIT CHECK 

Click ‘Resume’ 

Click ‘Send’ 

The directive will be placed in the Directive column 
of the CCW. 

A send/cancel message will flash in the status 
column of the Command Control window 

The following event messages will be generated: 

‘String Manager successfully configured’ 

‘FOP INIT with CLCW check successful 
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16. From the Command Control window enter the 
following ECL directive 

ECL> FOP VS=1 

Click ‘Resume’ 

Click ‘Send’ 

The directive will be placed in the Directive column 
of the CCW. 

A send/cancel message will flash in the status 
column of the Command Control window 

The following event messages will be generated: 

‘String Manager successfully configured’ 

‘Ground sequence number is set to 1’ 

The ground sequence number is set to 1 and is shown 
on the Commanding Ground Parameter Display. 

17. From the Control window enters the following ECL 
directive 

ECL> CMDCFG PLOP=1 

Event messages is generated 

Protocal Info: PLOP1 selected 

CTIU-1 is the primary default CTIU 

18. Issues individual commands in real time: 

From the Command input line enters a command 
directive. 

Cmd:> /AST_TURN_ON_C_TDP 

Click the “Resume” button 

Click the “Send” button 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates that the 
command has been processed. The command is 
successfully transmitted to EDOS. 

19. Analyze command data block report: 

%: cd /fosb/test/am1/reports 

%: ls -ltr 

A logging file for the command data block 
(CDB.log) is generated with current date and time 
stamp in directory: 

/net/beeper/fosb/dev/am1/reports. 
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20. Running Unix tools named od to dump the file in 
hex format, and generate a report name cdb.dat. 

%: od -x CDB.log >output file 

CDB.dat file is generated. 

21. Print CDB.dat CDB.dat is output to the printer. 

Verify in the CDB.dat file contains information 
regarding information about spacecraft identification 
for each CTIU. Its value in hexadecimal should be 
“a9” for CTIU1. (Note: Refer to ICD-106 to locate 
the field for CTIU) 

(F-CMD-14310, F-CMD-14315) 

22. Observe CDB.dat file and record the value of Frame 
Sequence Number: __________ 

(Note: Refer to ICD-106 to locate the field for frame 
sequence number) 
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23. From the Control window enter the following ECL 
directive to reconfigure to the backup CTIU. 

NOTE: FOP must be in initial state 

ECL> START FOP_REINIT 

Click ‘Resume’ 

Click ‘Send’ 

ECL> CMDCFG PLOP=2 CLTUQTY=3 

Click ‘Resume’ 

Click ‘Send’ 

ECL> START FOP_REINIT 

Click ‘Resume’ 

Click ‘Send’ 

Set Timer: 

ECL> FOP TIMER=30 

Click ‘Resume’ 

Click ‘Send’ 

ECL> CMDCFG PRIMARY=CTIU-2 

Click ‘Resume’ 

Click ‘Send’ 

ECL> FOP INIT CHECK 

Click ‘Resume’ 

Click ‘Send’ 

View event display to verify message indicating: 
CTIU-1 is primary and Plop 2 selected and 
CLTUqty: 3 

The FOP_REINIT procedure will expand. The FOP 
Timer will be set to 1, FOP Transmit will be set for 1 
and a no op command will be sent. 

Protocol : Fop, Protocol alert LIMIT 

CV will fail and Error will flash in the status column 
where no op command was entered. FOP is not in 
initial state. 

Changed to CTIU to backup 

The directive will be placed in the Directive column 
of the CCW. 

A send/cancel message will flash in the status 
column of the Command Control window 

The following event messages will be generated: 

‘String Manager successfully configured’ 

‘FOP INIT with CLCW check successful’ 

FOP will accept whatever CLCW frame sequence 
number. 

5-158 322-CD-007-002/ 
411-CD-007-002 



24. Enter the load uplink directive for a RTS load: 

ECL>LOAD<loadId><partitition 
Indicator> <partitionAmount> 

Click ‘Resume’ 

Click ‘Send’ 

Verify that the load has been uplinked and executed 
via the event display. 

25. Repeat steps to collect CDB.log files 

Analyze command data block report steps. 

Verify in the CDB.dat file contains information 
regarding information about spacecraft identification 
for each CTIU. Its value in hexadecimal should be 
“aa” for CTIU2. (Note: Refer to ICD-106 to locate 
the field for CTIU.) 

26. Observe CDB.dat file and bit busting the data. Verify in the CDB.dat file contains information 
regarding information about virtual channel 
identification. Its value should be “00” in 
hexadecimal. (Note: Refer to ICD-106 to locate the 
field for virtual channel id) 

27. Repeat Analyze command data block report steps. Verify in the CDB.dat file, the frame sequence 
number increments sequentially. 
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28. Reinitialize FOP  (from Command Control window) 

ECL> CMDCFG PLOP=1 

Click ‘Send’ 

Click ‘Resume’ 

ECL> START FOP_REINIT 

Click ‘Send’ 

Click ‘Resume’ 

Set Timer: 

ECL> FOP TIMER=30 

Click ‘Send’ 

Click ‘Resume’ 

Event messages is generated 

Protocal Info: PLOP1 selected 

The FOP_REINIT procedure will expand. The FOP 
Timer will be set to 1, FOP Transmit will be set for 1 
and a no op command will be sent. 

Fop, Protocol alert LIMIT 

CV will fail and Error will flash in the status column 
where no op command was entered 

FOP will return to initial state 
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29. From the Control window enters the following ECL 
directive 

ECL> CMDCFG PRIMARY=CTIU-1 

Click ‘Send’ 

Click ‘Resume’ 

ECL> FOP INIT CHECK 

Click ‘Send’ 

Click ‘Resume’ 

CTIU changed to primary 

The directive will be placed in the Directive column 
of the CCW. 

A send/cancel message will flash in the status 
column of the Command Control window 

The following event messages will be generated: 

‘String Manager successfully configured’ 

‘FOP INIT with CLCW check successful’ 

FOP will accept whatever CLCW frame sequence 
number. 

30. Issues spacecraft command from Command Control 
window: 

Cmd:> /CDH_ENABLE_CT2_OK 

Click the “Send” button. 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. View the event 
messages generated from the command subsystem. 

31. Repeat Analyze command data block report steps. Verify in the CDB.dat file, the frame sequence 
number increments sequentially. 
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32. Issues individual commands in real time from 
Command Control window and change configure to 
I Channel: 

ECL> CMDCFG CLCW=I 

Cmd:>/AST_TURN_OFF_C_TDP 

Click ‘Resume’ 

Click ‘Send’ 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. Notice the following 
event message. 

• The command has been successfully validated. 

The command has been successfully transmitted to 
EDOS. 

33. Repeat Analyze command data block report steps. Verify in the CDB.dat file, the first byte of EDOS 
Ground Message Header changes from 83 to 03 in 
hex (which means 3 in decimal, Operational 
Message Type). 

Note: Refer to Table 5.5.2-2 of the document # 510-
ICD-EDOS/EGS for Message Type Field Values in 
the EDOS Ground Message Header for a CDB. 

34. Issues individual commands in real time from 
Command Control window and change configure to 
back to the Q Channel: 

ECL> CMDCFG CLCW=Q 

Cmd:>/AST_TURN_OFF_C_VDP2 

Click ‘Resume’ 

Click ‘Send’ 

A send/cancel message will flash in the status 
column of the Command Control window. 

The message in the status column indicates the 
command has been processed. Notice the following 
event message 

• The command has been successfully validated 

The command has been successfully transmitted to 
EDOS. 
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35. Uplinks commands at a rate of 125 bits per second 
(bps) when the control center is configured for 
transmission utilizing SN SSA service and the AM1 
Omni antenna. 

ECL> CMDCFG RATE 125 

ECL> /AST_TURN_ON_C_VDP1 

Click ‘Resume’ 

Click ‘Send’ 

Verify that rate you selected (125) is shown on the 
Commanding Ground Parameter Display. 

36. Uplinks commands at a rate of 1 kilobits per second 
(kbps) when the control center is configured for 
transmission utilizing SN SMA service and the 
AM1 High Gain antenna. 

ECL> CMDCFG RATE 1000 

ECL> /AST_TURN_OFF_C_VDP1 

Click ‘Resume’ 

Click ‘Send’ 

Verify that rate you selected (1000) is shown on the 
Commanding Ground Parameter Display. 
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37. Uplinks commands at a rate of 2 kilobits per second 
(kbps) when the control center is configured for 
transmission utilizing GN service and the AM1 
Omni antenna. 

ECL> CMDCFG RATE 2000 

ECL> /AST_TURN_ON_C_VDP2 

Click ‘Resume’ 

Click ‘Send’ 

Verify that rate you selected (2000) is shown on the 
Commanding Ground Parameter Display. 

38. Uplinks commands at a rate of 10 kilobits per 
second (kbps) when the control center is configured 
for transmission utilizing SN SSA service and the 
AM1 High Gain antenna. 

ECL> CMDCFG RATE 10000 

ECL> /AST_TURN_OFF_C_VDP2 

Click ‘Resume’ 

Click ‘Send’ 

Verify that rate you selected (10000) is shown on the 
Commanding Ground Parameter Display. 

39. Kill s/c simulator. CLCWs are no longer being transmitted. 

40. Set Timer: (from Command Control window) 

ECL> FOP TIMER=5 

Click ‘Send’ 

Click ‘Resume’ 

The fop timeout (in seconds) you selected is shown 
on the Commanding Ground Parameter Display. 
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41. From the command Control window enters the 
following ECL directive 

ECL> FOP TRANSMIT=5 

Click ‘Send’ 

Click ‘Resume’ 

ECL> /AST_TURN_ON_C_VDP1 

Click ‘Send’ 

Click ‘Resume’ 

Verify via event display messages generated 
indicating retransmission set to <n-1> n= to the 
number enter for FOP Transmit. 

The FOP transmission limit is updated and is shown 
on the Commanding Ground Parameter Display. 

Verify that EOC provides automatic retransmission 
since it has been determined that command has been 
lost. 

Fop, Protocol alert LIMIT event message is 
generated. 

42. Repeat the above steps changing FOP TRANSMIT 
to 4, 3, 2. 

See above expected results. 

43. Set retransmission to off, from the Control window 
enter the following ECL directive 

ECL> FOP TRANSMIT=1 

Click ‘Send’ 

Click ‘Resume’ 

ECL> /AST_TURN_ON_C_VDP1 

Click ‘Send’ 

Click ‘Resume’ 

The FOP transmission limit is set to 1 and is shown 
on the Commanding Ground Parameter Display. 

Verify that the command retransmission is disabled. 
EOC will be determined that command has been lost 

Fop, Protocol alert LIMIT event message is 
generated 
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44. From User Station: 

a. Enter the following to change directory to setup 

%: cd /fosb/test/am1/scripts/setup 

b. run MyKill. 

All processes has been brought up before will be 
killed. 

45. Log off User Station. 

46. End of test. 
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Telemetry Verification And Command Receipt Verification


Test Case No: 2080B 

Test Configuration: See Appendix G 

Test Support: EOC startup scripts, DMS, RMS, CMS, CMD, FUI , sc 

Test Case Description: 

This test is designed to verify the FOS capability to support the verification of commands. Commands are verified in two ways: 
Command Receipt Verification and Telemetry Verification. Command Receipt Verification 
received intact on board the spacecraft. Telemetry verification verifies that the commands were successfully executed. This is 
accomplished by checking real time telemetry after allowing sufficient time for the command to execute, and the telemetry to 
downlink. (The pre-determined time is defined from command database, and is based upon onboard execution time) 

Success Criteria: 

The success of this test requires the demonstration that the FOS provides the user with a capability to verify the successful receipt of 
real time commands by the spacecraft, provides the user with the status of each command uplinked as success or fail, the 
demonstration that the FOS will provide the user with a capability to provide the user the spacecraft and instrument command 
telemetry verification status. 

Note: 
• Parameters inside the <> will be provided at run time. 
• When necessary in this test, a displayed window may be resized and/or relocated in order to see view data as related to a specific 

step. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto a EOC workstation, and open a terminal 
window. Log onto a EOC workstation under one of 
the fostest accounts (fostest1, fostest2, fostest3, 
fostest4): 

Username: fostest2 

Password:******* 

verifies that uplinked commands were 
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2. From a new terminal window: 

Starts the Data Server. Refer to Test Case SYS­
2000B – FOS Server Startup. 

Data Server processes are running. 

3. From a new terminal window: 

Starts the Real-Time Server. Refer to Test Case 
SYS-2000B – FOS Server Startup. 

Real-Time Server processes are running. 

4. From a new terminal window: 

Logs onto an FOT User Station. 

Start the User Station. Reference Test Case SYS­
2010B -- User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

5. Click on “Tools” button. The Tool Selection Dialog Box will appear on the 
screen. 

6. Select Events Display-Global from the Tool 
Selection Dialog Box. 

The Event Display window will appear on the screen. 

7. At an user station, connects to a real-time 
operational string. 

From the Control window enters the following ECL 
directive 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

Verify the following messages appear in the Event 
Display window: 

“Successfully connected to string 100”. 

8. Take CAC privilege. Using the ECL command line 
in the Control window enter 

ECL>TAKE COMMAND STRING = 100 

An event message via event display indicating 
privileges have been granted. Message should indicate 
userid and workstation hostname. 
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9. Activate Command Control window using the 
following tool directive from the Control window. 

ECL> TOOL Command_Control 

Command Control window is displayed. A small 
dialog box with the title “CCW/CMW” appears on top 
of Command Control window prompting user to enter 
String and Spacecraft Id. 

10. Enter String id (ex. 100). 

Enter Spacecraft ID (ex. AM1). 

Clicks “OK” on “CCW/CMW” dialog box. 

The Command Control window is displayed with all 
five user interface (pull down) menus; File, Edit, 
Config, Utility, and Help. 

There are five columns: DATE/TIME, BUFFER, 
TYPE, DIRECTIVE, STATUS (Note: User may need 
to resize window if all columns are not displayed.) 

11. Start ‘sc’ Command Tool. From a terminal window 
enter the following: 

% rlogin <hostname> where hostname= real­
time server 

% cd /fosb/test/am1/scripts/setup 

% setenv SCRIPT RealTimeServer 

% source FosEnvVars 

% cd /fosb/test/am1/bin/sun_sparc_5-5 

% sc AM1 100 Ops 

The real-time host name will be displayed at prompt. 
The environment variables need to run the tool will be 
set. 

The tool will start sending CLCWs 

CLCWs will be generated. The following messages 
will be displayed 

***sc waiting for messages*** 

CLCW before send to FOP 0 
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12. Configure CLCW channel from Command Control 
window: 

ECL> TAKE GROUNDCONTROL 
STRING=100 

ECL> CMDCFG CLCW=I 

Click ‘Resume’. 

Click ‘Send’. 

Set CLCW channel to I channel. 

13. Start AD service with CLCW check: 

ECL> FOP INIT CHECK 

click ‘Resume’ 

click ‘Send’ 

The directive will be placed in the Directive column 
of the CCW. 

A send/cancel message will flash in the status column 
of the Command Control window 

The following event messages will be generated: 

‘String Manager successfully configured’ 

‘FOP INIT with CLCW check successful’ 

FOP will accept whatever CLCW frame sequence 
number. 

Note: If CLCW is not received before the select timer 
expired, initialization will be considered unsuccessful. 
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14. Invoke the EDOS telemetry driver to generate 
telemetry packets to monitor prerequisite state 
check commands. 

In a terminal window, enter the following: 

%: cd /fosb/test/am1/scripts/setup 

%: setenv SCRIPT UserStation 

%: source FosEnvVars 

%: cd /fosb/test/am1/bin/sun_sparc_5-5 

%: FtPgPackGen 

From the Control window enter the following ECL 
directives: 

PG CONFIG HOST=225.2.7.00 
PORT=20101 APID=1 

PG STARTDATA APID=1 COUNT=-1 

START cmd2080 

Wait for message -- Packet Generator is ready to 
receive directives. 

Note: Port number depends on the Lan 

The telemetry driver starts sending packets. 

15. Bring up the ‘cev’ display page 

Click the ‘Tlm Wins…’ button the Control window 

Select ‘cev’ 

Click ‘ok’ 

A display page list boxes appears. ‘cev’ appears in the 
selected text field. The cev page is displayed. 
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16. Enter a instrument command: 

Cmd:> /CEF_SET_LRSXFR_HI 

click ‘Resume’ 

click ‘Send’ 

Verify that command is transmitted successfully. 
Receipt confirmation for the frame will be shown in 
CLCW. 

A send/cancel message will flash in the status column 
of the Command Control window. 

The message in the status column indicates that the 
command has been processed. 

View event display indicating: command <cmd 
mnem> (where <cmd_mnem> = Cmd entered) was 
successfully built with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

17. Check ‘CEF_SET_LRSXFR’ on the ‘cev’ telemetry 
page. If the value is ‘DISABLE’ TV passes. 

If the value is ‘ENABLED’ TV fails. 

The values will be displayed on the cev page 

If the command passes TV a message is displayed in 
the status column of the command Control window. 

If the command fails TV a message is displayed in the 
status column of the command Control window. 

18. Repeat above steps to obtain TV pass and fail 
results. 

TV fails or passes, a message is displayed in the status 
column of the command Control window 
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19. Enter a instrument command: 

Cmd:> /MOD_SET_DR_SVD_UL 

click ‘Resume’ 

click ‘Send’ 

Verify that command is transmitted succesfully. 
Receipt confirmation for the frame will be shown in 
CLCW. 

A send/cancel message will flash in the status column 
of the Command Control window. 

The message in the status column indicates that the 
command has been processed. 

View event display indicating: command <cmd 
mnem> (where <cmd_mnem> = Cmd entered) was 
successfully built with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

20. Repeat above steps to obtain TV pass and fail 
results. 

TV fails or passes, a message is displayed in the status 
column of the command Control window 

21. Check ‘MOD_CR_DRSVD_1LATCHD’ on the 
‘cev’ telemetry page. If the value is ‘LATCHED’ 
TV passes. 

If the value is ‘UNLATCHED’ TV fails. 

The values will be displayed on the cev page 

If the command passes TV a message is displayed in 
the status column of the command Control window. 

If the command fails TV a message is displayed in the 
status column of the command Control window. 

22. Repeat above steps to obtain TV pass and fail 
results. 

TV fails or passes, a message is displayed in the status 
column of the command Control window 
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23. Enter a instrument command: 

Cmd:> /MOD_ENABLE_CPA_EPWRT 

Click ‘Resume’. 

Click ‘Send’. 

Verify that command is transmitted succesfully. 
Receipt confirmation for the frame will be shown in 
CLCW. 

A send/cancel message will flash in the status column 
of the Command Control window. 

The message in the status column indicates that the 
command has been processed. 

View event display indicating: command <cmd 
mnem> (where <cmd_mnem> = Cmd entered) was 
successfully built with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

24. Check ‘MOD_CR_CPA_EEP_WRE_S’ on the 
‘cev’ telemetry page. If the value is ‘DISABLED’ 
TV passes. 

If the value is ‘ENABLED’ TV fails. 

The values will be displayed on the cev page 

If the command passes TV a message is displayed in 
the status column of the command Control window. 

If the command fails TV a message is displayed in the 
status column of the command Control window. 

25. Repeat above steps to obtain TV pass and fail 
results. 

TV fails or passes, a message is displayed in the status 
column of the command Control window. 
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26. Enter a spacecraft command: 

Cmd:> / COM_SELECT_SBT2_PN50 

Click ‘Resume’. 

Click ‘Send’. 

Verify that command is transmitted succesfully. 
Receipt confirmation for the frame will be shown in 
CLCW. 

A send/cancel message will flash in the status column 
of the Command Control window. 

The message in the status column indicates that the 
command has been processed. 

View event display indicating: command <cmd 
mnem> (where <cmd_mnem> = Cmd entered) was 
successfully built with binary displayed. 

CLTU id <cmd_mnem> placed in command data 
block #. The # will be based on the number of 
command data blocks sent. 

The command data block is successfully transmitted 
to EDOS. 

27. Check ‘COM_CR_SBT2_PN_SEL on the ‘cev’ 
telemetry page. If the value is ‘50’ TV passes. 

If the value is any other number TV fails. 

The values will be displayed on the cev page 

If the command passes TV a message is displayed in 
the status column of the command Control window. 

If the command fails TV a message is displayed in the 
status column of the command Control window. 

28. Repeat above steps to obtain TV pass and fail 
results. 

TV fails or passes, a message is displayed in the status 
column of the command Control window 
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29. From User Station(optional): 

a. Enter the following to change directory to setup 

%: cd /fosb/test/am1/scripts/setup 

b. run MyKill. 

All processes has been brought up before will be 
killed. 

30. Log off User Station. 

31. End of test. 
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Memory Dump Image


Test Case No: CMS 2000B 

Test Configuration: See Appendix G 

Test Support: EOC startup scripts, Telemetry packet generator, a procedure with dump initiate command 

Test Description: 

This test is designed to verify FOS has the capability to support that a user can successfully dump and store it in a file, in an area of 
memory on the spacecraft, and ensures a dump compare can be successfully performed. This test will also ensures a user can 
overwrite the current values of the ground reference image with the contents of a dump from the spacecraft. The Command 
Management Subsystem (CMS) will generate a report on the contents of a dump file, the ground image, load image or dump image. 
For this test we will generate a report on a dump file. 

Using the FUI tools and ECL directives the user can convert a table dump file to a table load contents file. 
file will then be ingested into the FUI table load builder, the user can perform a table dump, a 
compared with the default values in the data base for that table. 

Success Criteria: 

The success of 
in an area of memory. The user can issue ECL directives through the use of FUI tools, CMS will automatically process the request 
and generate the dump image, report, the ground comparison. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. -2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. ­
2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

The table load contents 
file will be created, this file can be 

this test requires the demonstration that FOS provides the user the capability to generate a dump and store it in a file 

Reference Test Case SYS

Reference Test Case SYS
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3. Log onto an FOT User Station. 

Start the User Station. Reference Test Case SYS-2010B --
User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

4. Invoke the Event Display window by entering the following 
in the ECL directive line. 

Click the ‘TOOLS’ button on the Control window. 

Select Event Display-Global. 

Click ‘OK’ 

A list box appears. 

Event Display-Global appears in the selection filter 
box. 

An event display window appears. 

5. Connect to a real-time string. From the Control window 
enter the following ECL directive. 

ECL> STRING CONNECT STRING=100 
CONFIG=MIRROR 

String Manager will attempt to connect to a real­
time string when this process is complete, an event 
message: 

‘Successfully connected to string 100’. 

6. Take CAC privilege (user1). Using the ECL command line 
in the Control window enter: 

ECL>TAKE COMMAND STRING = 100 

ECL> TAKE GROUNDCONTROL STRING=100 

An event message via event display indicating 
privileges have been granted. Message should 
indicate userid and workstation hostname. 

7. Activate Command Control window using the following 
Tool directive from the Control window: 

> TOOL Command_Control 

A dialog box will appear allowing user to enter 
String id and Spacecraft id. 
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8. Enter String id (ex. 100). 

Enter Spacecraft ID (ex. AM1). 

Click “OK”. 

The Command Control window is displayed with all 
five user interface (pull down) menus; File, Edit, 
Config, Utility, and Help. 

There are five columns: DATE/TIME, BUFFER, 
TYPE, DIRECTIVE, STATUS (Note: User may 
need to resize window if all columns are not 
displayed.) 

9. Start ‘sc’ Command Tool. From a terminal window enter the 
following: 

% rlogin <hostname> where hostname= real-time 
server 

% cd /fosb/test/am1/scripts/setup 

% setenv SCRIPT RealTimeServer 

% source FosEnvVars 

% cd /fosb/test/am1/bin/sun_sparc_5-5 

% sc AM1 100 Ops 

The real-time host name will be displayed at 
prompt. The environment variables need to run the 
tool will be set. 

The tool will start sending CLCWs. 

CLCWs will be generated. The following messages 
will be displayed: 

***sc waiting for messages*** 

CLCW before send to FOP 0 

10. From the Command input line in the Command Control 
window, initialize FOP: 

>FOP INIT CHECK 

Click ‘Resume’. 

Click ‘Send’. 

The directive will be placed in the Directive column 
of the CCW. 

A send/cancel message will flash in the status 
column of the Command Control window. 

The following event messages will be generated: 

‘String Manager successfully configured’. 

‘FOP INIT with CLCW check successful. 
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11. Update the ground reference Table image 

Enter the following directive from the Control window 

ECL> MUN <loadname-including partitions> 
YYYY:DDD:HH:MM:SS.MMM 

A event message is generated indicating the Table 
Memory model has been updated. 

12. View ground reference image 

Click on ‘TOOLS’ button on Control window. 

Select ‘Report Generator’. 

Click ‘OK’. 

Select ‘Ground Reference Image Reports (On Demand)’. 

Select ‘Table’. 

Enter Table Name, Start and End locations in the text boxes 
provided. 

Click ‘Ok’. 

The Report Generator tool is displayed 

Ground Reference Image Reports (On Demmand) 
window is displayed. 

FUI will submit the request to the CMS memory 
model and a ground image report will be generated 
in the reports/image directory. 

13. Update ground reference Table image. Enter the following 
directive from the Control window. 

ECL> MUN <loadname-including partitions> 
YYYY:HH:MM:SS.MMM 

Note: The load used is a partial load for the load used in the 
previous step. 

A event message is generated indicating the Table 
Memory model has been updated. 
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14. Repeat View ground reference image Verify ground reference image updated with the 
new information 

15. From the CMD input line in the Command Control window 
enter the following commands to uplink the load, initiate the 
dump for 1K diagnostic rate 

ECL> LOAD <TableLoad> <partitionIndicator> 
<partitionAmount> 

ECL> /FS1_DUMP_TBLINIT1 
TABLE_ID=<tableid> 
WORD_OFFSET=<wordoffset> 
WORD_COUNT<wordcount> 

Once the telemetry receives the dump message, a 
file is opened, the file is closed when the number of 
words for the particular RT addressed is received. 

Telemetry sends process dump message to CMS for 
processing. An event message is sent indicating that 
the dump is finished 

The ground reference image has been updated 

16. Verification of formatted dump file 

The dump input file is formatted and a formatted dump 
image file is generated. Go to the proper CMS directory 

% cd /fosb/test/am1/reports/table 

% ls -ltr 

The CMS memory image receives the message, 
reads the input dump file, formats the data from the 
input file, and generates a formatted dump image 
file. This file will be used for dump compares and 
dump conversions. 

Verify there is a <filename>.fdmp associated the 
Telemetry <filename>.dmp 

17. Verify the ground reference image was updated. 

Repeat Ground Reference Image steps. 
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18. From the CMD input line in the Command Control window 
enter the following commands to uplink the load, initiate the 
dump for 16K diagnostic rate 

ECL> LOAD <TableLoad> <partitionIndicator> 
<partitionAmount> 

ECL> /FS1_DUMP_TBLINIT1 TABLE_ID=<tableid> 
WORD_OFFSET=<wordoffset> 
WORD_COUNT<wordcount> 

Once the telemetry receives the dump message, a 
file is opened, the file is closed when the number of 
words for the particular RT addressed is received. 

Telemetry sends process dump message to CMS for 
processing. An event message is sent indicating that 
the dump is finished 

The ground reference image has been updated 

19. Repeat Verification of formatted dump file step. 

20. Generate a dump comparison report 

From the Control window, enter the image compare 
directive, to compare the dump file and the ground image 
file 

ECL>IMGCMP TABLE DUMP= <.dmpFile> 
GROUND START= _____ END=_______ 

FUI sends the image compare request to the CMS 
memory image subsystem. CMS does the compare 
and generates the image compare report. 

CMS will write the dump image file into the 
memory image. If necessary, the dump image file 
will overwrite any existing area that already has 
data. 

An event message is generated indicating the status 
of the compare. 

21. View Comparison Report 

% cd /fosb/test/am1/reports/compare 

% ls -ltr 

% more <filename> 

The files in the directory will be displayed in 
reverse time order. 
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22. Generate a dump comparison report 

From the Control window, enter the image compare 
directive, to compare two image different files. 

ECL> IMGCMP TABLE LOAD=<imageFile> 
LOAD=<imageFile> 

A comparison report is generated and the number of 
miscompares is displayed in the event message 

23. Repeat View Comparison Report Verify the number of miscompares match the 
number indicated. Verify that each location is a 
miscompare. 

24. Generate a dump comparison report 

From the Control window, enter the image compare 
directive, to compare two image files 

ECL> IMGCMP TABLE LOAD=<imageFile1> 
LOAD=<imageFile2> 

Note: imageFile1=imageFile2 

A comparison report is generated and the number of 
miscompares is displayed in the event message. 
There should be ‘0’ miscompares. 

25. Repeat View Comparison Report Verify there are no miscompares indentified 

26. Generate a dump comparison report 

From the Control window, enter the image compare 
directive, to compare the dump file and the ground image 
file. 

ECL>IMGCMP TABLE DUMP= <.imageFile> 
GROUND 

27. Repeat View Comparison Report. 
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28. Repeat View Ground Reference Image. 

29. From the Control window, enter the image overwrite 
directive 

ECL> IMGOVER TABLE DUMP = <filename> 
START= END= 

The image overwrite request is sent to the CMS 
memory image subsystem. CMS opens the dump 
file, overwrites the ground reference image with the 
contents of the dump file. 

An event message is generated indicating the status 
of the overwrite. 

30. From the Control window, enter the image report directive 
and the dump file name that is to be reported. 

ECL> IMGRPT TABLE = <fileName> 

A dump report request is sent to the CMS memory 
image subsystem. A report is generated by CMS. 

An event message is generated when the report is 
finished. 

31. Use a mask to exclude certain areas of memory from an 
image compare. From the Control window enter the 
following directive 

ECL> IMGCMP TABLE LOAD=<filename> 
LOAD=<filenmae> MASK = <MaskFileName> 

A comparison report is generated. The areas defined 
in the mask should be excluded from the report. 

32. Repeat View Comparison Report. 

33. Open the FUI Table Load Builder from the Tools button on 
the FUI command and Control window. 

The Table Load Builder appears. 
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34. Select the Open Dump option under the File pull down 
menu on the Table Load Builder. 

Select a Dump file. 

Click ‘OK’. 

A list box appears. 

A request is automatically sent to CMS to be 
processed. CMS will use the table id, and retrieve 
the definition from the database. The values 
retrieved determine the table definition and will then 
be written to the table load contents file. 

An event will be written to the event display when 
the load contents file is generated. 

The Table Load Builder Tool will automatically 
ingest this generated load contents file into the 
Table load builder 

35. Generate a Table Dump Compare 

From the Control window, enter the table image compare 
directive and the table dump for the compare. 

ECL> IMGCMP TABLE LOAD=<imageFile> 
LOAD= <.dmp fileName> 

Note: File Extensions are not needed. 

The command will be inserted into the text are of 
the CCW. A send/cancel message will flash in the 
status column of the Command Control window. 

The command will be executed. 

The request is automatically sent to CMS for 
processing. CMS will generate a list of table values 
from the binary in the dump file. The computed 
value from the dump file is compared to the value 
for the field in the table definition. 

A report is generated for any miscompares. 

36. End of test. 
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Table Load Validation & Generation


Test Case No: CMS 2040B 

Test Configuration: See Appendix G 

Test Support: EOC startup scripts, Document MIL STD 1750A 

Test Description: 

This test is designed to verify an authorized user’s generation of a Table Load content file using the load builder tools available through FUI. 
In addition, the authorized user is provided 
can be modified accordingly. This test demonstrates that the user is provided with the tools necessary to invoke the load builder to input, 
validate, and generate a table load. Once generation is complete this test will verify that CMS has stored the uplink load file, 
a load report, load contents file, and a load catalog entry in the FOS Database. The user will also have the capability to open 
table load from load catalog, open a table dump from load catalog, generate a load with the table load initiate command. The Scheduling of 
the load will be demonstrated in Test Case PAS 2110. 

Success Criteria: 

A user is able to select a Table Template using the FUI provided, and modify the 
provides the user with the capability to ingest a table load content file. Once the Table Load contents are validated against the Table buffer 
characteristics defined in the Project Data Base an uplink load, image load, and a 
associated with that table load are generated. Confirm the user is properly notified when the invalid load contents are detected during the 
validation process. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Invoke the Event Display window by clicking the Tools 
button on the Control window and selecting Event Display 
Global from the list box. 

A Tools Selection list box appears. The tool selected 
appears in the text field box. The Event Display 
Window is displayed. 

a pre-defined table template with default parameter values defined in the Project Data Base that 

load image file, 
and delete a 

contents to create a Table load. Demonstrate that FOS 

load report, load contents file, and load catalog entry 

Binary conversion of table load contents must conform to MIL STD 1750A. 
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2. Initiate the Table Load Builder Tool. 

Click the Tools button on the Control window and select 
Table Load Builder from the list box. 

A Tools Selection list box appears. The tool selected 
appears in the text field box. The Table Load Builder 
window is displayed 

3. Select a Table Template. 

Select New from the File menu 

The Table Template Selection window appears. 

4. From the Table Selection window select the Spacecraft id 
(note: system will default to AM1). 

. 

The Spacecraft selected appears in the appropriate text 
field. The tables associated with the S/C will appear in 
the Table Template Selection window 

5. Click on the desired Table Template. 

Click the ‘OK’ button. 

The selected table appears in the “Selected Table 
Template ” text box. 

The Table Template Selector window closes. The 
Table Load builder displays the corresponding table 
information: spacecraft ID, table type, and the default 
data field parameter values. 

6. Define load contents by modifying the parameter values. 
Enter acceptable values within the min/max range (specified 
in the PDB) of that parameter. Enter a Table Name. 

The value entered will be displayed in the highlighted 
text field of the pre-defined table template. 
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7. Generate a table load. 

Select "Generate" from File menu to execute load generation. 

The Time Selector window appears. 

Enter the uplink start time. 

>YYYY/DDD HH:MM:SS.mmm 

Enter the uplink stop time. 

>YYYY/DDD HH:MM:SS.mmm 

Click the “OK” button. 

Verify start and end field. 

Verify message(s) in the status line window. 

Verify event messages. 

The times specified will appear in the Start and Stop 
text boxes. 

The message in the status window will indicate the 
following: 

Table load validation was successfully completed. 

The Table Generator dialog box window appears: 
Table type, S/C, Table Name, Start and Stop of Valid 
period, Start Field, End Field, Load Initiate CMD 

Table load generation complete for load <tablename>. 
(note: software is designed to validate prior to 
generation). 

Event messages indicating the load generation started 
and load generation completed. 

An uplink load (.upl), image load (.img) and a contents 
(.cnt) file are created. 

8. Verify the uplink load (.upl) and an image load (.img) and 
contents (.cnt) file was created. 

Open a terminal window and enter the CMS directory. 

% cd /fosb/test/am1/loads/table 

% ls -lt 

A list of files in the specified directory will appear. 
There will be an uplink, image load and contents file 
associated with the table load defined in the table load 
generation step. 

9. Verify a load report was generated. 

% cd /fosb/test/am1/reports 

% ls -lt 

A list of files in the specified directory will appear. 
There will be a file <tablename>.rpt associated with 
the table load that was generated. 
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10. Print the load report.. 

% lp <filename> 

11. View the report associated with the generated table load. The following items are included: (where applicable): 

-Load name. 

-Starting field # and ending field # memory location. 

-Load initiate cmd. 

-Contents of the load in hex, and in decimal, if 
applicable. 

-Valid uplink window. 

-Load size in bytes. 

12. Verify load catalog entry was created and resides in the load 
catalog table in Sybase. 

Under the File option select Open Table. Provide the 
information requested in the dialog box. 

The <tablename> will appear in the Load Catalog list 
box. 
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13. Verify the load contents of the image uplink file by using the 
DumpUplinkImage tool. 

a. % cd /fosb/test/am1/scripts/setup 

b. % setenv SCRIPT UserStation 

c. % source FosEnvVars 

d. % cd /fosb/test/am1/bin/sun_sparc_5-5 

e. % FmUnDumpUplinkImage/fosb/test/am1/loads/table/ 
loadname.upl 

<directory path where .upl file resides>/<loadname> 

The tool provides binary representation of the table 
load contents. The dump also includes the Filename, 
CRC, load initiate command, and Number of Packets. 

14. Select a Table Template. 

Under “File” pull down menu select “New” option. 

The Table Template Selection window appears. 

15. From the Table Selection window select the Spacecraft id 
(note: system will default to AM1). 

The Spacecraft Id appears in the text S/C field. 

The tables associated with the S/C appear in the Table 
Template Selection window. 

16. Click on the desired Table Template. Verify selected Table 
appears in the “Selected Table Template ” text box. 

Click the “OK” button. 

The selected Table appears in the “Selected Table 
Template ” text box. 

The Table Template Selector window closes. The 
Table Load builder displays the corresponding table 
information: spacecraft ID, subsystem, table type, table 
time, and the default data field parameter values. 
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17. Enter unacceptable values outside the high/low range 
specified. 

Select “Validate” under the “File” option. 

Browse the table load, for any invalid parameter field(s) 

A appears message in the status window indicating 
which data fields are invalid and the error. (i.e. field 
descriptor error: invalid data entry 

18. Modify the invalid parameters. 

Select “Validate” under the “File” option. 

Verify CMS does not start processing 

The border returns to the normal state 

A message appears in the status window indicating the 
load validation is complete. 

No event messages are generated indicating load 
processing has started. 

19. Verify a table can be opened from the load catalog. 

Select ‘Open Table’ from the File menu, click on Generate 
from the next file menu 

Click the “OK” button. 

A load catalog list box appears. The Table will be 
displayed in the table load builder 

20. Using the same table in the above step enter a series of invalid 
stop uplink time format with a valid start uplink time 

>1997/560 HH:MM:SS.mmm 

> 1197/300 12:00:56.760 

> 1997/230 99:00;56.000 

Each incorrect format entered should invoke a dialog 
box indicating invalid format specified 
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21. Using the same table in the above step enter a series of invalid 
start uplink time format with a valid stop up link time 

>1997/560 HH:MM:SS.mmm 

> 1197/300 12:00:56.760 

> 1997/230 99:00;56.000 

Each incorrect format entered should invoke a dialog 
box indicating invalid format specified 

22. Using the same table load enter the a start time greater than 
the stop time. 

An error dialog box will be displayed indicating 
invalid times entered. 

23. Delete a table load from the Load Catalog. Select Delete 
Table from the File menu. 

A Selection dialog box for Delete will be display the 
file names from the Load Catalog 

24. 

Select the desired file name. 

Click the “Yes” button. 

A dialog box will be displayed prompting the user to 
confirm deletion 

The table load will be deleted from the load catalog. 
An event message will be displayed indicating the 
table load was deleted. 

25. Delete a table load from the Load Catalog. Select Delete from 
the File menu. 

A Selection dialog box for Delete will be display the 
file names from the Load Catalog 

26. Select the desired file name 

Click ‘No’ 

A dialog box will be displayed prompting the user to 
confirm deletion 

The table load will not be deleted from the load 
catalog. The dialog box should close and the 
tablename should still appear in the list box. 

27. Repeat the steps to delete a load catalog entry. Do not specify 
a table to delete 

An error dialog box will be displayed indicating the 
Selected Table Load does not exist. 

5-192 322-CD-007-002/ 
411-CD-007-002 



28. Perform a table dump. Select Open Dump from the File menu. 
Select the desired filename. 

A File Selection dialog box will be displayed with the 
table that is going to be dumped. 

The selected table dump will be converted to a content 
file and displayed in the table load builder. 

Should receive: no dumps 

29. Select a Table Template. 

Under “File” pull down menu select “New” option. 

The Table Template Selection window appears. 

30. From the Table Selection window select the Spacecraft id 
(note: system will default to AM1). 

The Spacecraft Id appears in the text S/C field. 

The tables associated with the S/C appear in the Table 
Template Selection window. 

31. Click on the desired Table Template Verify selected Table 
appears in the “Selected Table Template ” text box. 

Click the “OK” button. 

The selected Table appears in the “Selected Table 
Template ” text box. 

The Table Template Selector window closes. The 
Table Load builder displays the corresponding table 
information: spacecraft ID, subsystem, table type, table 
time, and the default data field parameter values. 

32. Generate a table load by specifying the load initiate command. 
Click the tools button on the Control window and select 
“Table Load Builder” from the list box. 

The Table Load Window is displayed. 

Select “Generate” from the File menu to execute load 
generation. 

Close the dialog box. 

An error dialog box indicates “Enter Table Load 
Name”. 
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 33. Generate a partial load. 

Select “Open Table” from the File menu to select a previously 
created table load. Click on the desired file. 

Click the “OK” button. 

Enter a new name for the table selected in the “Table Name” 
box. 

The table is highlighted and appears in the “Selected 
Table Template” text box. 

The table is displayed and the new name appears in the 
“Table Name” box. 

34. Select “Generate” from the File menu to execute the load. 

The Time Selector window appears, 

Enter the uplink start time. 

>YYYY/DDD HH:MM:SS.mmm 

Enter the uplink stop time. 

>YYYY/DDD HH:MM:SS.mmm 

The times will appear in the Start and Stop text boxes. 
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 35. Locate the “Start Field” and “Stop Field” boxes and manually 
insert a smaller number of items that fall within the range 
displayed. 

Click the “OK” button. 

Verify start and end fields. 

Verify message(s) in the status line window. 

Verify event messages. 

Select “Open Table” from the File menu and highlight the 

partial load created, <tablename>. The name is in the 

“Selected Table” 

box. 

Click on the “OK” button. 

The number of items displayed reflect the numbers 
inserted manually. 

The message in the status window will indicate the 
following: 

Table load validation was successfully completed 

The Table Generator dialog box window appears: 
Table type, S/C, Table Name, Start and Stop of Valid 
period, Start Field, End Field, Load Initiate CMD 

Table load generation for <tablename> was 
successfully completed. (note: software is designed to 
validate prior to generation). 

Event messages indicating the load generation started 
and load generation completed. 

The load contains only the items selected. 

An uplink load (.upl), image load (.img) and a contents 
(.cnt) file are created. 

36. Repeat steps 8 through 13 to verify the files created. 
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Microprocessor & FSW Load Generation


Test Case No: 2060B 

Test Configuration: See Appendix G 

Test Support: EOC startup scripts, DMS, RMS, CMS, CMD, FUI. It is necessary to generate support files (.cnt) prior to this test as 
well as database information containing valid min/max values for successful test execution. 

Test Case Description: 

This test is designed to verify that the FOS has the capability to support EOC in generating instrument loads from microprocessor load 
content and in generating flight software load from flight software load content. 

This test begins with the initialization of the server and workstation so that the FUI Binary Load Builder window can be invoked at the 
user workstation. From the FUI Binary Load Builder window, the ingest process is invoked and the load contents file is selected. Once 
After load validation, the test continues with the uplink load generation. The Binary Load Builder window ‘Generate’ toggle button is 
used to initiate a request to CMS to generate the uplink load. The final steps of the test verify that the load catalog is updated with an 
entry for the uplink load generated. The scheduling of uplinking of loads will be demonstrated in Test Case CMS 2050. 

Success Criteria: 

The success of this test requires the demonstration that the FOS provides the user with a capability to ingest the instrument and flight 
software load contents file into the EOC. Following successful ingest, demonstration that the load contents file can be validated and 
used by CMS to generate an instrument & flight software uplink load. CMS generation of the uplink load will be invoked by a 
successful request from FUI Binary Load Builder. Demonstrate that CMS is capable of generating the load reports and load image 
files. Demonstrate that CMS is able to update the load catalog with an entry for the uplink load. 

Note: 

• Parameters inside the <> will be provided at run time. 
• When necessary in this test, a displayed window may be resized and/or relocated in order to view data as related to a specific step. 

Step Id Action Expected Result/Output Pass/ 
Fail 
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1. Log onto a EOC workstation, and open a terminal 
window. Log onto a EOC workstation under one of 
the fostest accounts (fostest1, fostest2, fostest3, 
fostest4): 

Username: fostest2 

Password: ******* 

2. From a new terminal window: 

Start the Data Server. Refer to Test Case SYS-2000B 
– FOS Server Startup. 

Data Server processes are running. 

3. From a new terminal window: 

Start the Real-Time Server. Refer to Test Case SYS­
2000B – FOS Server Startup. 

Real-Time Server processes are running. 

4. From a new terminal window: 

Log onto an FOT User Station: 

Start the User Station. Reference Test Case SYS­
2010B – User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

5. Click on the Tools button from Control window. The Tool Selection Dialog Box will appear on the 
screen. 

6. Select Event_Display_Global from the Tool 
Selection Dialog Box. 

The Event Display window will appear on the screen. 

7. Click on the Tools button from Control window. The Tool Selection Dialog Box will appear on the 
screen. 

8. Select Binary Load Builder from the Tool 
Selection Dialog Box. 

The Binary Load Builder dialog box will appear on 
the screen. 
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 9. Copy a file from the “.../loads/mp directory (if 
applicable) to the user’s home directory. 

Ex: AM1_MPR_CERES_test1_01_01.cnt 

10. From the “File” pull down menu, select Ingest. 

Note: You may ingest all files at this time. 

A file selection dialog box is displayed. 

11. Filter on the user’s home directory for the naming 
convention. 

The file is highlighted and selected for loading. 

12. Select a load content file to be ingested. 

Click the “OK” push button. 

The file selection dialog is removed. 

The load contents file is now shown in the load 
contents section of the Binary Load Builder display. 

13. Generate the load ingested in previous steps and 
select from the load contents file list. (for example 
pick up a file for instrument load named CERES as: 
“AM1_MPR_CER_ ….”) 

Highlight and click Generate. 

The Generate Binary Load dialog is displayed with 
the correct load type: MPR (which is 
microprocessor), spacecraft: AM1, and name of the 
instrument load. 

14. Generate load: 

Click on ‘Select Time’ and okay for the default time 
or enter a valid Uplink Start and Stop Time. 

The selected times are shown correctly in the “Start 
Time” and “Stop Time” text fields. 

15. Select a “Remote Terminal” option menu. CTIU1 is displayed on the push button next to the 
Remote Terminal field. (Note: CTIU1 is one of the 
remote terminal id needed to build the load initiate 
command.) 
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16. Select a load initiate mnemonic from the 
“Mnemonic” option menu. (Refer to the database to 
get the minimum/maximum values) 

Note: If an invalid load size error occurs, choose a 
start and end location to get a valid size. 

A standard set of AM1 load initiate mnemonics is 
displayed. 

17. Enter locations in the “Start Location” and “End 
Location” text fields. 

The computed size of the load appears in size field 
next to the “Size” label. 

18. Enter a description of the load in the “Description” 
text field. 

The description is displayed. 

19. Select “OK” push button. The Generate Binary Load Dialog is removed. 

Verify that via event display, CMS received the 
request and started to build the binary load. 

Verify that via the event display, the microprocessor 
load built successfully. 

An image load (.img), a contents (.cnt) file and 
uplink load (.upl) are created. 
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20. Verify Load Catalog entry (Use SYSBASE): 

Open an Xterm Window 

a. %: isql -Ufos_dba -P******* 

b. 1> use am1_fos_ops 

c. 2> go 

d. 1> select * from fos_load_cat 

e. 2> go 

View the Binary Load Builder and verify the file 
appears in the Load Catalog window. 

Verify that the updated load catalog is 
stored/maintained within the DMS database. 

Verify that the load catalog fields include the load 
name, load_size, the uplink time, valid start time, 
valid stop time, and the spacecraft subsystem (sc_id). 

The miroprocessor load name (ex: CERES) will 
appear in the Load Catalog list box. 

21. Verify the correct files are created: 

From an Xterm window 

a. Enter the following to change directory to verify 
the “*.img” and the “*.upl files were created: 

b. %cd /fosb/test/am1/loads/mp (directory for the 
‘mpr’ file) or 

c. %cd /fosb/test/am1/loads/fsw (directory for the 
‘fsw’ file) 

d. %ls - lt 

A list of files in the specified directory will appear. 
There will be a file <microprocessor load name>.ing 
and a file <microprocessor load name>.upl 
associated with the load that was generated. 
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22. Verify Load Report: 

Enter the following to change directory to reports: 

a. % cd /fosb/test/am1/reports 

b. ls -lt *.rpt 

A list of files in the specified directory will appear. 
There will be a file <microprocessor load name>.rpt 
associated with the load that was generated. 

23. Print the load report: 

% lp <filename> 

A hard copy of the report is sent to the printer. 

24. View the report associated with the generated 
instrument load. 

Verify that in the report all necessary load control 
commands append to the microprocessor or load. 

Verify that information such as: Load name, Load 
type, Valid uplink period, Load size in bits, Starting 
and ending memory location, contents of the load in 
hex, are shown in the report. 

Remote Terminal ID, Sub-address, and Word Count 
are also shown in the report. (Note: Those are part of 
Command Destination - 1553B Command Word.) 
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25. Verify Load Contents: 

Dump the image uplink file by using the 
FmUnDumpUplinkImage tool. 

a. % cd /fosb/test/am1/scripts/setup 

b. % setenv SCRIPT UserStation 

c. % source FosEnvVars 

d. % cd /fosb/test/am1/bin/sun_sparc_5-5 

e. %FmUnDumpUplinkImage../../loads/ 
loadname.upl 

<directory path where .upl file resides>/<loadname> 

Verify that the dump includes the file name, CRC, 
load initiate command, and Number of Packets. 

26. Select another file for instrument load named MISR 
from the load contents file list. 

Select Generate. 

The Generate Binary Load dialog is displayed with 
the correct load type: MPR (which is 
microprocessor), spacecraft: AM1, and name of the 
instrument load. 

27. Repeat Generate load  steps (14 -19, 21) for MISR 
instrument microprocessor load. 

28. Repeat Verify Load Catalog entry step (20) for 
MISR. 

Verify that load catalog entry was created and resides 
in the load catalog table in Sybase. 

The microprocessor load name (MISR) will appear in 
the Load Catalog list box. 

29. Repeat Verify Load Report steps (22-24) for MISR. Verify the load generation preappends the load 
initiate command, load descriptor, start address, word 
count and CRC. (Note: MISR loads use 16 bit 
CCSDS CRC) 

5-202 322-CD-007-002/ 
411-CD-007-002 



30. Repeat Verify Load Contents step (25) for MISR. Verify that the dump includes the file name, CRC, 
load initiate command, and Number of Packets. 

31. Select another file for instrument load named 
MODIS from the load contents file list. 

Select Generate. 

The Generate Binary Load dialog is displayed with 
the correct load type: MPR (which is 
microprocessor), spacecraft: AM1, and name of the 
instrument load. 

32. Repeat Generate load  steps (14-19, 21) for 
MODIS instrument microprocessor load. 

33. Repeat Verify Load Catalog entry step (20) for 
MODIS. 

Verify that load catalog entry was created and resides 
in the load catalog table in Sybase. 

The microprocessor load name (MODIS) will appear 
in the Load Catalog list box. 

34. Repeat Verify Load Report steps (22-24) for 
MODIS. 

Verify the load generation preappends the load 
initiate command, load descriptor, start address, word 
count and CRC. (Note: MODIS loads use 16 bit 
CCITT CRC.) 

35. Repeat Dump the image uplink file step (25) for 
MODIS. 

Verify that the dump includes the file name, CRC, 
load initiate command, and Number of Packets. 

36. Select another file for instrument load named 
MOPITT from the load contents file list. 

Select Generate. 

The Generate Binary Load dialog is displayed with 
the correct load type: MPR (which is 
microprocessor), spacecraft: AM1, and name of the 
instrument load. 

37. Repeat Generate load steps (14-19, 21) for 
MOPITT instrument microprocessor load. 
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38. Repeat Verify Load Catalog entry step (20) for 
MOPITT instrument load. 

Verify that load catalog entry was created and resides 
in the load catalog table in Sybase. 

The microprocessor load name (MOPITT) will 
appear in the Load Catalog list box. 

39. Repeat Verify Load Report  steps (22-24) for 
MOPITT. 

Verify the load generation preappends the load 
initiate command, load descriptor, start address, word 
count and CRC. (Note: MOPITT loads use 16 bit 
CCITT CRC) 

40. Repeat Dump the image uplink file step (25) for 
MOPITT. 

Verify that the dump includes the file name, CRC, 
load initiate command, and Number of Packets. 

41. Select another file from the load contents file list to 
generate flight software load (for example this time 
pick up a file for flight software load such as: 
“AM1_FSW_CERES…” 

Select Generate. 

The Generate Binary Load dialog is displayed with 
the correct load type: FSW (which is flight software), 
spacecraft: AM1, and name of the flight software 
load. 

42. Repeat Generate load  steps (14-19, 21) for flight 
software load. 

The selected times are shown correctly in the “Start 
Time” and “Stop Time” text fields. 

The computed size of the load appears in size field 
next to the “Size” label. 

CTIU1 is displayed on the push button next to the 
Remote Terminal field. (Note: CTIU1 is one of the 
remote terminal ids needed to build the load initiate 
command; Others may be selected.) 
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43. Verify Load Catalog entry (Use SYSBASE): 

Open an Xterm Window 

a. %: isql -Ufos_dba -P******* 

b. 1> use am1_fos_ops 

c. 2> go 

d. 1> select * from fos_load_cat 

e. 2> go 

View the Binary Load Builder and verify the file 
appears in the Load Catalog window. 

Verify that the updated load catalog is 
stored/maintained within the DMS database. 

Verify that the load catalog fields include the load 
name, load_size, the uplink time, valid start time, 
valid stop time, and the spacecraft subsystem (sc_id). 

The flight software load name (ex: CERES) will 
appear in the Load Catalog list box. 

44. Verify Load Report: 

Enter the following to change directory to reports: 

a. % cd /fosb/test/am1/reports (if this directory is 
already set, skip). 

b. ls -lt *.rpt 

A list of files in the specified directory will appear. 
There will be a file <flight software load name>.rpt 
associated with the load that was generated. 

45. Print the load report: 

% lp <filename> 

A hard copy of the report is sent to the printer. 
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46. View the report associated with the generated flight 
software load. 

Verify that in the report should show all necessary 
load control commands append to the flight software 
load. 

Verify that information such as: Load name, Load 
type, Valid uplink period, Load size in bytes, Starting 
and ending memory location, contents of the load in 
hex, are shown in the report. 

Verify the load generation preappends the load 
initiate command, load descriptor, start address, word 
count and CRC. (Note: GNC flight software loads 
use a 16 bit checksum in place of CRC. All other 
AM1 flight software loads use the 16 bit CCSDS 
CRC) 

47. Repeat Verify load contents step (25) for flight 
software load. 

Verify that the dump includes the file name, CRC, 
load initiate command, and Number of Packets. 

48. Select another file for instrument load named MISR 
from the load contents file list. 

Select Generate. 

The Generate Binary Load dialog is displayed with 
the correct load type: FSW (which is flight 
software), spacecraft: AM1, and name of the 
instrument load. 

49. Repeat Generate load  steps (14 -19, 21) for MISR 
instrument flight software load. 

50. Repeat Verify Load Catalog entry step (43) for 
MISR. 

Verify that load catalog entry was created and resides 
in the load catalog table in Sybase. 

The flight software load name (MISR) will appear in 
the Load Catalog list box. 
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51. Repeat Verify Load Report steps (44-46) for 
MISR. 

Verify the load generation preappends the load 
initiate command, load descriptor, start address, word 
count and CRC. (Note: MISR loads use 16 bit 
CCSDS CRC) 

52. Repeat Verify Load Contents step (25) for MISR. Verify that the dump includes the file name, CRC, 
load initiate command, and Number of Packets. 

53. Select another file for instrument load named 
MODIS from the load contents file list. 

Select Generate. 

The Generate Binary Load dialog is displayed with 
the correct load type: FSW (which is flight 
software), spacecraft: AM1, and name of the 
instrument load. 

54. Repeat Generate load  steps (14 -19, 21) for 
MODIS instrument flight software load. 

55. Repeat Verify Load Catalog entry step (43) for 
MODIS. 

Verify that load catalog entry was created and resides 
in the load catalog table in Sybase. 

The flight software load name (MODIS) will appear 
in the Load Catalog list box. 

56. Repeat Verify Load Report steps (44-46) for 
MODIS. 

Verify the load generation preappends the load 
initiate command, load descriptor, start address, word 
count and CRC. (Note: MODIS loads use 16 bit 
CCSDS CRC) 

57. Repeat Verify Load Contents step (25) for MODIS. Verify that the dump includes the file name, CRC, 
load initiate command, and Number of Packets. 

58. Select another file for instrument load named 
MOPITT from the load contents file list. 

Select Generate. 

The Generate Binary Load dialog is displayed with 
the correct load type: FSW (which is flight 
software), spacecraft: AM1, and name of the 
instrument load. 
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59. Repeat Generate load steps (14 -19, 21) for 
MOPITT instrument flight software load. 

60. Repeat Verify Load Catalog entry  step (43) for 
MOPITT. 

Verify that load catalog entry was created and resides 
in the load catalog table in Sybase. 

The flight software load name (MOPITT) will appear 
in the Load Catalog list box. 

61. Repeat Verify Load Report steps (44-46) for 
MOPITT. 

Verify the load generation preappends the load 
initiate command, load descriptor, start address, word 
count and CRC. (Note: MOPITT loads use 16 bit 
CCSDS CRC) 

62. Repeat Verify Load Contents step (25) for 
MOPITT. 

Verify that the dump includes the file name, CRC, 
load initiate command, and Number of Packets. 

63. Delete Load Catalog entry: 

a. Select one from Load Catalog entry 

b. Click ‘Delete’ button. 

A Question Dialog box is displayed to confirm the 
deletion. 

Note: Cannot delete loads that have been uplinked. 

64. Select ‘Yes’ or ‘No’ in the Question Dialog box. Select ‘Yes’ will send a request to CMS to delete the 
load from the load catalog. The result of deletion will 
be displayed as an event in the Control window. 
Select ‘No’ will ignore the deletion. 

65 Delete Load Contents: 

a. Select one from Load Contents. 

b. Click ‘Delete’ button. 

A Question Dialog box is displayed to confirm the 
deletion. 

66. Select ‘Yes’ or ‘No’ in the Question Dialog box. Select ‘Yes’ will delete the file from the ingest 
directory. Select ‘No’ will ignore the deletion. 
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67. End of test. 

5-209 322-CD-007-002/ 
411-CD-007-002 



ATC Load Generation & Validation 

Test Case No.:  CMS-2090B 

Test Configuration: See Appendix G 

Test Support: Test support will consist of pre-planned mission schedules developed in prior test cases. The activities utilized for 
scheduling purposes are created in test case PAS-2000B (Activity Definer Tool Test Procedure). Database utilities are needed for 
creating and inserting Hard and Soft constraints in conjunction with the activities. Careful planning to ensure these pre-requisites are 
met is essential. The test will interface with the CMS, PAS, and FUI subsystems. The following tools are needed as well: EOS 
Timeline, General Scheduler, Load Generator, Ground Script Display, and Control window. 

Test Description: 

This test verifies the Command Management Subsystem (CMS) capability to support the generation of an ATC load from Detailed 
Activity Schedule (DAS) received from Planning & Scheduling (PAS). This test also verifies the CMS’ capability to support the 
generation of a ground script over the same time period as the ATC upon receipt of a valid request from the User Interface. 

The test begins with the creation of the DAS using Planning & Scheduling delivered tools. The DAS will include activities and 
commands that were scheduled against the master plan. Once the DAS is created, a request is sent to the CMS Schedule Controller 
process for expansion of the DAS and generation of the ATC load. Upon completion of the ATC load, the PAS receives a completion 
status from CMS. Because the ATC load generation is primarily a background process, this test will require analysis on the part of 
the test team to ensure the build and storage of the load, creation of the load report, integrated report and the update of the load 
catalog. 

After ATC load generation, this test verifies the CMS capability to support a FUI request for ground script generation. A request will 
be sent to CMS for ground script generation over the same time period as the DAS. The test will require analysis on the part of the 
test team to verify the contents of the ground script against the DAS and ATC load. 

The final steps of the test verify the CMS’ capability to support the handling of an erroneous DAS sent from PAS. An effort will be 
made by the test team to create an ‘empty’ DAS (i.e. over a time period in which activities and commands are not scheduled against 
the master plan). Testing will verify that the PAS/CMS processes are capable of recognizing an erroneous DAS and generate an 
error status to the user as opposed to processing the DAS. 
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Success Criteria: 

The success of this test requires demonstration of an ATC load generation with soft constraints and the capability to prohibit hard 
constraints as well as the ability of an user to select a portion of the PAS timeline master plan and generate a DAS. This test requires 
a DAS to be sent successfully to the CMS Schedule Controller process for expansion and ATC load generation. ATC load generation 
will consist of the generation of the binary load, load report, integrated report and an update to the load catalog. Upon completion of 
the ATC load generation, CMS will return a completion status to the PAS load generator process. 
requests CMS to generate a ground schedule that corresponds to the start and stop time of the DAS used for ATC load generation. 
Erroneous DASs are recognized and the appropriate error message is sent to the user while the DAS is unsuccessfully processed. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. -2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. ­
2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

3. Log onto an FOT User Station. 

Start the User Station. -2010B ­
- User Station Startup and Authentication. 

The FOT User Station is running and the 
‘Control window’ is displayed. 

4. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

5. Select the ‘Event Display Global’ option. 

Click the ‘OK’ button. 

The Tools dialog box closes. 
window appears. 

6. Verify the ‘EOS Timeline’ is visible or Double Click on 
the icon. 

The EOS Timeline window is displayed. 

In addition, FUI automatically 

Reference Test Case SYS

Reference Test Case SYS

Reference Test Case SYS

The Event Display 
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7. Verify the ‘Load Generator’ is visible or Double Click on 
the icon. Record the DAS Start Date and Time for future 
reference. 

The Load Generator window is displayed. 

8. Verify the ‘General Scheduler’ is visible or Double Click 
on the icon. 

The General Scheduler window is displayed. 

9. PART ONE 

10. Within the EOS Timeline select the ‘Open’ option under 
the File menu. 

The New Plan dialog box appears. 

11. Select the Plan Name. 

Master Plan 

Enter a start date and time or use the default start time. 

TBD 

Enter a stop date and time based on the scheduled 
activities. 

TBD 

Click the ‘OK’ button. Record the times for future 
reference. 

The Open Plan dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:1. 

The Event Display message indicates: Master 
Plan opened from <start time> to <stop time>. 

The EOS Timeline displays the times inserted. 

12. General Activity Scheduling 

From the General Scheduler window, click the ‘Resource’ 
button and select TBD. 

TBD appears on the Filter By Resource button. 

13. Select the ‘Activities’ option from the ‘Filter’ menu. A list of activities defined under the TBD 
resource appears in the Activities field. 
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 14. Select the ‘TBD’ activity for scheduling. 

Select the ‘Master Plan:1’ as the scheduling plan. 

The selected activity and plan are highlighted. 
Default scheduling information appears. 

15. Select the ‘Impact’ option under the Action menu. The Impact button is selected. 

16. Enter a valid start and stop Date/Time in the designated 
box. (Ensure these times are within the times scheduled 
for the Master Plan.) Record times for reference. 

Select the ‘Schedule’ option from the ‘Action’ menu or 
click on the ‘Schedule’ button. 

The activity will appear on the timeline in the 
specified scheduled location. 

The activity schedule message will appear on the 
Event Display. 

Note: Depending on previously scheduled 
activities, the resource chosen may have to be 
unlocked before scheduling is successful. A 
message may appear in the Events Window. This 
involves selecting ‘Show Locks’ on the Load 
Generate’ Window and unlocking the resource. 

17. Click the ‘Save’ button on the timeline. The current contents are saved to the Master 
Plan. 
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18. Load Generate Window 

Select the DAS/ATC Load toggle button. 

Select the Master Plan from the Plans field. 

Input a DAS Stop time. (Do not change the DAS start 
time.) 

TBD 

Input a valid Uplink Request time. (The Uplink time must 
start and end BEFORE the DAS Start time) 

TBD 

Click the ‘Submit’ button. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue area. 

Upon completion the job will appear in the Jobs 
Completed area. 

A DAS end line will appear on the EOS 
Timeline at the specified location. 

19. Soft Constraint Activity Scheduling 

Repeat the steps for General Activity Scheduling; 
however, schedule the activity that violates soft 
constraints. 

Note: Depending on previously scheduled 
activities, the resource chosen may have to be 
unlocked before scheduling is successful. A 
message may appear in the Events Window. This 
involves selecting ‘Show Locks’ on the Load 
Generate’ Window and unlocking the resource. 

20. Click the ‘Save’ button on the timeline. The current contents are saved to the Master 
Plan. 

21. Repeat the steps for Load Generate Window. The selected activity will appear on the timeline 
in the scheduled location. 

22. Verify the activity in the Jobs Queue area is in the 
‘Pending’ status. 

The job remains in the pending status. 

5-214 322-CD-007-002/ 
411-CD-007-002 



23. Click on the activity. 

Click on the ‘View Constraint’ button. 

The activity is highlighted. 

A Soft Constraint Violation dialog box will 
appear. A list of the violations will appear within 
the box. 

24. Verify the violations are correct and click on the violation. 

Click ‘Approve’ to allow the DAS to complete. 

The Soft constraint Violation dialog box closes. 

The DAS is completed successfully. 

Upon completion the job will appear in the Jobs 
Completed area. 

A DAS end line will appear on the EOS 
Timeline at the specified location. 

25. Hard Constraint Activity Scheduling 

Repeat the steps for General Activity Scheduling; 
however, schedule the activity that violates hard 
constraints. 

Note: Depending on previously scheduled 
activities, the resource chosen may have to be 
unlocked before scheduling is successful. A 
message may appear in the Events Window. This 
involves selecting ‘Show Locks’ on the Load 
Generate’ Window and unlocking the resource. 

26. Click the ‘Save’ button on the timeline. The current contents are saved to the Master 
Plan. 
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27. Repeat the steps for Load Generate Window. The selected activity will appear on the timeline 
in the scheduled location. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue Area. Upon 
completion the job will appear in the Jobs 
Completed Area as failed. 

The Event Display messages indicate the DAS 
has failed and the number of violations. 

28. Click on the the activity in the Jobs Completed Area. The activity is highlighted. 

29. Click on the ‘View Constraint’ button. A Hard Constraint Violation dialog box will 
appear. A list of the violations will appear within 
the boxes. No DAS or ATC loads are created 

30. Verify the violations are correct and click the ‘Close’ 
button to close out the box. 

The Hard Constraint Violation dialog box closes. 

31. From the ‘EOS Timeline’, select the violating activity. The activity is selected. 

32. Within the General Scheduler click the ‘Unschedule’ or 
‘Cut’ button. 

The activity is removed from the Master Plan 
and off the timeline. 

33. Click the ‘Save’ button on the timeline. The current contents are saved to the Master 
Plan. 

34. Soft and Hard Constraint Scheduling 

Repeat the steps for General Activity Scheduling; 
however, schedule the activity that violates soft and hard 
constraints. 

Note: Depending on previously scheduled 
activities, the resource chosen may have to be 
unlocked before scheduling is successful. A 
message may appear in the Events Window. This 
involves selecting ‘Show Locks’ on the Load 
Generate’ Window and unlocking the resource. 
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 35. Click the ‘Save’ button on the timeline. The current contents are saved to the Master 
Plan. 

36. Repeat the steps for Load Generate Window. The selected activity will appear on the timeline 
in the scheduled location. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue Area. Upon 
completion the job will appear in the Jobs 
Completed Area as failed. 

The Event Display messages indicate the DAS 
has failed and the number of violations. 

37. Click on the the activity in the Jobs Completed Area. The activity is highlighted. 

38. Click on the ‘View Constraint’ button. A Soft and Hard Constraint Violation dialog box 
will appear. A list of the violations will appear 
within the box. No DAS or ATC loads are 
created. 

39. Verify the violations are correct and click the ‘Close’ 
button to close out the box. 

The Violation dialog box closes. 

40. From the ‘EOS Timeline’, select the violating activity. The activity is selected. 

41. Within the General Scheduler click the ‘Unschedule’ or 
‘Cut’ button. 

The activity is removed from the Master Plan 
and off the timeline. 

42. Click the ‘Save’ button on the timeline. The current contents are saved to the Master 
Plan. 

43. Close the EOS Timeline. 
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44. Verify Load Catalog Entries: 

Record the Job ID for all of the loads completed 
sucessfully. 

The Load ID’s for the General Activity and Soft 
Constraint Activity are successful. 

45. From an Xterm window 

a. %: isql -Ufos_dba -P******* 

b. 1> use am1_fos_ops 

c. 2> go 

d. 1> select * from fos_load_cat 

e. 2> go 

Verify that the updated load catalogs are stored 
/maintained within the DMS database. 

46. Verify the correct files are created: 

From an Xterm window 

a. % cd /fosb/test/am1/loads/atc 

% ls -lt 

Verify the ATC load contents (*.cnt), the load image 
(*.img) and the uplink (*.upl) files are created for each 
load. 

A list of files in the specified directory will 
appear for each load. 

47. Verify the ATC load reports have been generated and 
stored. The files are stored in the following directories: 

a. % cd /fosb/test/am1/reports 

b. % ls -lt *.rpt 

A list of files in the specified directory will 
appear for each load. There will be a file 
<filename>.rpt associated with each load 
generated. 
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48. Print the load reports: 

% lp -o landscape <filename>.rpt 

A hard copy of the reports are sent to the printer. 

49. View the reports associated with each load. Note: Off-line Analysis includes verifcation of 
the following: 

The command portion of the ATC has been 
converted from mnemonic to binary. 

The time tag of each ATC has been converted to 
the applicable spacecraft compatible format. 

The time tags have a resolution of 1 second. 

The time tags have the following format: 2 bits 
representing day and 22 bits representing 
milliseconds of day. 

The load control commands (load init) have been 
pre-pended to the ATC load. 

The beginning and end boundaries of the ATC 
load generated corresponds to the boundaries 
selected for the expanded DAS. 
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50. Verify Load Contents: 

Dump the image uplink files by using the 
FmUnDumpUplinkImage tool. 

a. % cd /fosb/test/am1/scripts/setup 

b. % setenv SCRIPT UserStation 

c. % source FosEnvVars 

d. % cd /fosb/test/am1/bin/sun_sparc_5-5 

e. % FmUnDumpUplinkImage ../../loads/loadname.upl 

< directory path where .upl files reside>/<loadname> 

Verify the dumps include the file name, CRC, 
load initiate command, and Number of Packets. 

Note: Off-line Analysis includes verification of 
the following: 

Consistent format specified in ICD-106. 

Consistent format according to CCSDS packet 
protocol. 

Correct load size. 

51. PART TWO 

52.  No Activity Scheduling 

Click on the ‘General Scheduler’ window. 

Click the ‘Schedule’ button without selecting an activity. 

Note: Depending on previously scheduled 
activities, the resource chosen may have to be 
unlocked before scheduling is successful. A 
message may appear in the Events Window. This 
involves selecting ‘Show Locks’ on the Load 
Generate’ Window and unlocking the resource. 

53. Verify the error message. 

Click ‘OK’ to close the box. 

An error message box appears indicating an item 
must be selected to schedule. 

54. On the ‘EOS Timeline’, select ‘Close’ under the File 
menu. 

The Master Plan is closed. 
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55. Partial Activity Scheduling 

Click on the ‘Load Generator’ window and record the 
DAS Start Date and Time for future reference. 

Note: Depending on previously scheduled 
activities, the resource chosen may have to be 
unlocked before scheduling is successful. A 
message may appear in the Events Window. This 
involves selecting ‘Show Locks’ on the Load 
Generate’ Window and unlocking the resource. 

56. Within the EOS Timeline select the ‘Open’ option under 
the File menu. 

The New Plan dialog box appears. 

57. Select the Plan Name. 

Master Plan 

Enter a start date and time or use the default start time. 

TBD 

Enter a stop date and time for approx. 24 hours in the 
future. 

TBD 

Click the ‘OK’ button. Record the times for future 
reference. 

The Open Plan dialog box closes. The timeline 
updates with the requested time period and plan 
name as Master Plan:1. 

The Event Display message indicates: Master 
Plan opened from <start time> to <stop time>. 

The EOS Timeline displays the times inserted. 

58. From the General Scheduler window, click on the ‘BAPS’ 
button to schedule the activity. 

The ‘BAPS’ button is selected. 

59. Click the ‘Resource’ button and select TBD. The TBD resource appears. 

60. Select the ‘Activities’ option from the ‘Filter’ menu. A list of activities defined under the TBD 
resource appears in the Activities field. 
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61. Select the ‘TBD’ activity for scheduling. 

Select the ‘Master Plan:1’ as the scheduling plan. 

The selected activity and plan are highlighted. 
Default scheduling information appears. 

62. Select the ‘Impact’ option under the Action menu. The Impact button is selected. 

63. Enter a valid start and stop Date/Time in the designated 
box. (Ensure these times are within the times scheduled 
for the Master Plan and are approx. 24 hours.) Record 
times for reference. 

Select the ‘Schedule’ option from the ‘Action’ menu or 
click on the ‘Schedule’ button. 

Note: Due to the length of the activity, the time 
to schedule the activity will vary. 

The activity will appear on the timeline in the 
specified scheduled location. 

The activity schedule message will appear on the 
Event Display. 

Note: Depending on previously scheduled 
activities, the resource chosen may have to be 
unlocked before scheduling is successful. A 
message may appear in the Events Window. This 
involves selecting ‘Show Locks’ on the Load 
Generate’ Window and unlocking the resource. 

64. Click the ‘Save’ button on the timeline. Note: The time to do this may vary. 

The current contents are saved to the Master 
Plan. 
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65 From the Load Generate Window, select the DAS/ATC 
Load toggle button. 

Select the Master Plan from the Plans field. 

Input a DAS Stop time approx. 24 hours in length. (Do not 
change the DAS start time.) 

TBD 

Input a valid Uplink Request time. (The Uplink time must 
start and end BEFORE the DAS Start time) 

TBD 

Click the ‘Submit’ button. 

Note: The time to do this may vary. 

The job is submitted to the queue and the process 
will appear in the Jobs in Queue area. 

Upon completion the job will appear in the Jobs 
Completed area. 

A DAS end line will appear on the EOS 
Timeline at the specified location. 

66. Repeat the steps to Verify Load Catalog Entries. 

67. Repeat the steps to Verify The Correct Files Are 
Created. 

68. Repeat the steps to Verify Load Contents. 

69. Ground Script Display 

Print the Integrated reports associated with each ATC load 
generated to verify the accuracy of the load information. 

% cd /fosb/test/am1/reports/integrated 

% ls -lt 

% lp -o landscape <integrated report name> 

Verify the following information: 

-Reporting Period Start/Stop Times. 

-ATC Load Location. 

-ATC Load Command and Description . 

-ATC Command Mnemonic and Description. 

-ATC Safe Command Load Information. 
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70. Appended Command Verification 

View the <TBD> activity to determine which commands 
are defined as appended commands for each ATC load. 

Verify that the command(s) is listed last in the Load 
Contents Report under the Command Mnemonic and 
Command Binary sections of the report. 

Note: The SAFE_ACTIVITY name in the 
FmMm…. Configuration file contains the 
activity name with the valid appended 
commands. 

Off-line Analysis to be performed. 

71. End Of Test. 
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ATC Load Management


Test Case No.: CMS-2100B 

Test Configuration: See Appendix G 

Test Support: Test support consists of interfacing with CMS, PAS, and FUI. 
Scheduler, EOC Timeline, Load Generator, ATC Buffer Display, and Control window. System directories should be available for 
the storage of related reports as well. Retrieve the ATC Load Reports for each load and a printout of each activity scheduled for the 
load. 

Test Description: 

This test will demonstrate the ability to create an partitioned ATC load. 
available command locations. 

Success Criteria: 

Success is measured on the ability to generate and verify related reports; the ability to partition ATC loads; the ability to manipulate 
the ATC buffer display. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. -2000B – 
FOS Server Startup. 

Data Server processes are running. 

2. Log onto an FOT User Station. 

Start the User Station. -2010B 
– User Station Startup and Authentication. 

The FOT User Station is running and the 
‘Control window’ is displayed. 

3. Within the Control window, click the ‘Tools’ button. The Tools dialog box appears. 

The following tools should be available; General 

The use of the ATC buffer is displayed to show the 
Several reports are verified to meet specific requirements. 

Reference Test Case SYS

Reference Test Case SYS
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4. Select the ‘Event Display Global’ option. 

Click the ‘OK’ button. 

Customize the Events. 

The Tool dialog box closes. The Event Display 
window appears. 

5. Manual Uplink Notification 

Enter the MUN command to send manual uplink 
notification to CMS. From the Command Input line: 

Enter: MUN <Full Uplink Load File Name> <time 
(YYYY.DDD.HH.MM.SS.sss)> 

Note: This information comes from the uplink times on 
the load report for each load. 

The Event Display message indicates 
‘successfully updated ATC Buffer Model with 
load <loadname>’. 

The ATCBuffer,mdl file is created in the reports 
directory. 

6. Within the Control window, click the ‘Tools’ button. The Tools dialog box appears. 

7. ATC Buffer Display Information 

Select the ‘ATC Buffer Display’. 

Click the ‘OK’ button. 

The Tool dialog box closes. The ATC Buffer 
Display window appears. 

8. From the ATC Buffer Dialog box, Enter information on 
the following, based on the load information: 

Select the options available for: Start Address, End 
Address, Sub/Instr 

Click ‘Apply’ and ‘OK’. 

Repeat using the maximum number of commands 

A separate window displays the requested 
information. 

Verify the following information based on the 
load report: 

a. Address Locations 

b. No. Of Commands 

c. No. Of Critical Commands 
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allowable. d. Command Information 

9. Within the Control window, click the ‘Tools’ button. The Tools dialog box appears. 

10. Modeling Report Information 

Select the ‘Report Generator’ from the list box. 

The Report Selector display window appears. 

11. In the Report Selector display, select the spacecraft id, the 
Report Category and the Report Type. 

From the Spacecraft Id pull down, select AM1, from the 
Report Category pull down, select CMS, click the On 
Demand toggle button. 

The Report Selector display will filter in AM1, 
CMS on demand reports and display the 
available report types in the Available Reports 
section of the Report Selector diplay. 

12. Select Modeling Reports from the Available Reports 
section of the Report Selector display and click ‘OK’. 

Select Default time or click on ‘Select Time’ and ‘OK’ for 
a specific time period. Click’OK’. 

The Report Selection display disappears and 
On_Demand Report Selector display appears. 
The display will contain the Modeling Reports in 
the Report Name text field, the User Name in the 
Requester Name text field, and the default start 
and stop time in the appropriate fields. The 
default stop time will be current time and the 
start time will be 2 hours earlier. (time will be in 
the format YYYY/DDD HH:MM:SS.mmm 

13. From the On_Demand Report Selector click on the New 
Report… push button. 

The On_Demand Report Specification display 
will appear and display the available reports for 
the CMS on demand category. These report 
types will appear in a selection dialog portion of 
the display. The available types are ATC Map 
Report, RTS Buffer Report, RTS Map Report, 
Table Buffer Report and Table Map Report. 

14. From the On_Demand Report Specification display, select T h e  A T C  M a p  r e p o r t  
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ATC Map Report and click on Apply. (AM1_ATC_Buffer_NNN…rpt) is generated in 
the reports directory. 

15. Go to the Reports directory and print the report: 

% cd /fosb/test/am1/reports 

% ls -lrt *.rpt 

% lp -o landscape 
(AM1_ATC_Buffer_NNN….rpt) 

16. Repeat the steps for Manual Uplink Notification another 
load. 

17. Repeat the steps for ATC Buffer Display Information. 

18. Repeat the steps for Modeling Report Information. 

19. Buffer Overflow 

Repeat the steps for Manual Uplink Notification until the 
maximum number of commands are reached and the 
buffer is full. 

20. Repeat the steps for ATC Buffer Display Information. 

21. Repeat the steps for Modeling Report Information. 

22. Buffer Verification 

Verify the ATC Buffer Reports for each uplinked load 
contains the updated information. 

Verify the information matches the load report 
information. 

Verify the following: 

Memory Location, Command Exec Time, 
Command Mnemonic, Critical flags, Command 
Data is in Hex. 
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23. End of test. 
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Relative Time Sequence (RTS) Load Validation & Generation


Test Case No: CMS 2170B 

Test Configuration:  See Appendix G 

Test Support: EOC startup scripts, Document MIL STD 1750A 

Test Description: 

This test is designed to verify the capability to support the generation of a Relative Time Sequence (RTS) load content file using the 
FUI RTS Load Builder Tool. 
completion. The CMS subsystem generates a RTS load contents file, an uplink load file, an image load file and a report associated 
with that load. Another objective of this test is to verify CMS can store the uplink and load images files and send them to DMS to be 
saved as a load catalog entry. 
soft constraint violations defined in the FOS database. If a RTS load contains soft constraints the user will prompted to generate the 
load and override the soft constraint. However, if the load contains a hard constraint the user will be notified and load will not be 
generated. 
sixteen command mnemonics (i.e. critical, submnemonic). 

Success Criteria: 

The success of 
Load Builder. Upon load generation the Meta Data server places an uplink file, an image file, and a report (stored by CMS) in the 
appropriate CMS loads and reports directories. 
The users capability to ingest a RTS load. The user will be notified when the load contains a hard or soft constraint. The user will be 
allowed to override any soft constraints, however a load with hard constraints must be rejected for load generation. The user can 
define various types of commands, not to exceed sixteen. 

Step Id Action Expected Result/Output Pass/ 
Fail 

This test demonstrates that an authorized user can create a RTS load and invoke the FUI upon 

The validation process will be provided through the CMS prior to generation. If there are hard and 

The user will also have the capability to open or delete a RTS load based on the Load Catalog entry and define up to 

this test requires the demonstration that FOS provides the user the capability to generate RTS load contents the RTS 

Demonstrate that CMS is able to update the load catalog entry and send it to DMS. 
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1. Log onto an EOC workstation. 

Start the Data Server. Reference Test Case SYS-2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Log onto an FOT User Station. 

Start the User Station. Reference Test Case SYS-2010B --
User Station Startup and Authentication. 

The FOT User Station is running and the 
‘Control window’ is displayed. 

3. Click the Tools button on the Control window and select 
Event_Display_Global from the list box. Click ‘OK’. 

An Event Display Window appears. 
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4. Initiate the RTS Load Builder Tool. 

Click the Tools button on the Control window and select RTS 
Load Builder from the list box. Click ‘OK’. 

A Tools Selection list box appears. The tool 
selected appears in the text field box. The RTS 
Load Builder window is displayed containing 
the following items; 

-Four Pull down menus File, Edit, Utility, and 
Help. 

-RTS# field box 

-Purpose text box 

-Spacecraft option menu 

-Sub/Inst option menu 

-CMD# field box 

-UTC field box 

-Delta Time field box 

-Command text box 

-Insert, Replace, Delete, Generate…, and 
Validate push buttons. 

-RTS Name: status line. 

-In the text area 4 columns CMD#, Delta Time, 
Ticks and Command. 
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5. Define an RTS Load: 

From the RTS Selection window select the Spacecraft id 
(note: system will default to AM1). 

Select Subsystem. 

Complete the following information: 

-RTS # 

-Purpose 

-CMD # 

-UTC & Delta Time 

The Subsystem and the Spacecraft selected 
appear in the appropriate text fields. The RTSs 
associated with the S/C and Subsystem appear 
in the Table Template Selection window. 

6. Select Directive Builder from the Utility pull down menu. The Directive Builder appears. This window 
will contain the following: 

(1) An ECL text field. 

(2) Directive keywords text field and list box. 

(3) Subsystems list box with Filter button and 
selection buttons; All and None. 

(4) Cmds (Commands) and Tlms (Telemetry) 
selection buttons, text field and list box. 

(5) Selection Template list box. 

(6) Status message line. 

Control button selections; OK, Apply, Cancel, 
and Help. 

5-233 322-CD-007-002/ 
411-CD-007-002 



7. Select commands. Filter on the desired subsystem. 

Filter on the following: 

AM1_XXX 

Click Select 

Click ‘OK’ 

Click on AM1_XXX 

Choose a command listed in Cmds list box. Click on that 
command. 

Deselect on the chosen directive. 

Double click on the chosen directive. 

Double click on one of the parameters (if applicable). 

Click ‘OK’ and then ‘Insert’. 

The Filter window closes and the filter selection 
appears in the filter box within the Directive 
Builder window. Note: XXX refers to the 
subsystem or IST. 

The Cmds list box contains command directive 
directives. 

Any qualifiers/parameters associated with that 
command are displayed in the ‘Selection 
Templates:’ list box 

The command directive is placed in the ECL 
text field box. 

The command parameter is appended to the 
command. There is no value associated with the 
parameter. 

The command will be inserted in the text area 
of the RTS Builder, and the Filter window will 
close. 

8. Repeat the Define RTS steps to enter additional commands The commands selected will appear in the text 
area of the RTS Load Builder. 

9. Validate a RTS Load: 

From RTS Load Builder window, click on the Validate push 
button. 

Verify message(s) in the status line window that 
RTS load validation was successfully 
completed. 

Verify the the “Pass” status button displays 
green. 
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10. Generate a RTS load: 

Click on "Generate" to execute load generation. 

Enter an absolute start and stop time for the Valid Uplink 
Period or Click on ‘Select Time’ for default values. 

Click on ‘OK’. 

>YYYY/DDD HH:MM:SS.mmm 

The RTS Generator dialog box will be 
displayed. The RTS #, Spacecraft, Sub/Instr, 
and Purpose Fields will be filled if those exist 
in the RTS Load Builder window 

The Start Time and Stop Time fields for Valid 
Period will be filled. 

. 

11. Verify a command is in the Load Initiate text field The entered data will be the Load Initiate. 

12. Click ‘ OK’ push button. 

Click ‘No’ and the load will not be generated. 

Select ‘Save’ from the File menu to save the load. 

A request to generate a RTS Load will be sent 
to CMS and the RTS Generator dialog box will 
be closed. Any error encountered during the 
RTS load generation will be displayed in an 
Error Dialog box. The returned generation 
status from CMS will be displayed in the status 
line of the RTS Load. 
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13. Verify a RTS Load 

Verify message(s) in the status line window. 

Verify event messages 

The message in the status window will indicate 
the following: 

-RTS load validation was successfully 
completed 

-RTS load generation for <RTSname> was 
successfully completed. (note: software is 
designed to validate prior to generation). 

-Event messages indicating the load 
generation started and load generation 
completed. 

-Verify the status button displays green. 

An uplink load (.upl), image load (.img) and a 
contents (.cnt) file are created 

14. Verify Creation of Files 

Verify the uplink load (.upl) and an image load (.img) and 
contents (.cnt) file was created. 

Open a terminal window and enter the RTS directory. 

% cd /fosb/test/am1/loads/rts 

% ls -lt 

A list of files in the specified directory will 
appear. There will be an uplink, image load and 
contents file associated with the RTS load 
defined in the RTS load generation step. 

15. Verify a Load Report 

% cd /fosb/test/am1/reports 

% ls -lt *.rpt 

A list of files in the specified directory will 
appear. There will be a file <RTSname>.rpt 
associated with the RTS load that was 
generated. 

16. Print the load report. 

% lp <filename> 

A hard copy of the report is sent to the printer. 
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17. View the report associated with the generated RTS load. The following items are included: (where 
applicable): 

-Load name. 

-Starting and ending memory location. 

-Load type. 

-Contents of the load in hex, and in decimal. 

-Valid uplink period. 

-Load size in bytes. 

18. Verify Load Contents 

Verify load catalog entry was created and resides in the load 
catalog table in Sybase. 

Under the File option select Open. Provide the information 
requested in the dialog box. 

Click on ‘Load Catalog’ and verify the filename. 

The <RTSname> will appear in the Load 
Catalog list box. 
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19. Verify the load contents of the image uplink file by using the 
DumpUplinkImage tool. 

% cd /fosb/test/am1/scripts/setup 

% setenv SCRIPT UserStation 

% source FosEnvVars 

% cd /fosb/test/am1/bin/sun_sparc_5-5 

% FmUnDumpUplinkImage /fos/test/am1/loads/rts 

loadname.upl 

<directory path where .upl file resides>/<loadname> 

The tool provides hex representation of the RTS 
load contents. The dump also includes the 
Filename, CRC, load initiate command, and 
Number of Packets. 

20. RTS Load Generated From A Previous Load 

Select Quit from the File pull down menu. 

Click the Tools button on the Control window and select RTS 
Load Builder from the list box. 

A tool Selection list box appears. The tool 
selected appears in the test field box. The RTS 
Load Builder window is displayed. 

21. Select Open from the File pull down menu. 

22. Click on ‘Ingest Directory’ and choose a file name 

Click on ‘OK’ . 

The file is highlighted and appears in the 
Selection Box. 

The file is opened with command information 
in the text area. 

23. Enter a new RTS#, Purpose and UTC/Delta Time 
information. 

The new information is displayed in the 
appropriate boxes. 
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24. Click on ‘Generate’. 

Click ‘Select Time’ and ‘OK’. 

Select ‘Save’ from the File menu. 

The load is generated with the new information. 

The message in the status window will indicate 
the following: 

-RTS load validation was successfully 
completed 

-RTS load generation for <RTSname> was 
successfully completed. (note: software is 
designed to validate prior to generation). 

-Event messages indicating the load 
generation started and load generation 
completed. 

-Verify the status button displays green. 

An uplink load (.upl), image load (.img) and a 
contents (.cnt) file are created 

25. Select ‘Open’ from the File menu. 

Click on the file just generated. 

Click ‘OK’. 

The file appears in the selection list box. 

The file is displayed. 

26. Follow the procedures to Verify Creation of Files. 

27. Follow the procedures to Verify a Load Report. 

28. Follow the procedures to Verify Load Contents. 
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 29. RTS Load With Soft Constraint 

Select ‘New’ from the File menu. 

Follow procedures to Define an RTS Load. 

Follow procedures to Generate a RTS Load. 

Click ‘Yes’ to override any soft constraint violations where 
applicable. 

Note: Select the specific subsytem and 
commands to generate soft constraint 
violations. 

Note: CMS will validate the load prior to 
generation. If there are soft constraints, a soft 
constraints window will appear prompting user 
to Generate load with violations. 

30. Follow procedures to Verify a RTS Load. The message in the status window will indicate 
the following: 

-RTS load validation was successfully 
completed 

-RTS load generation for <RTSname> was 
successfully completed. (note: software is 
designed to validate prior to generation). 

-Event messages indicating the load 
generation started and load generation 
completed. 

-Verify the status button displays green. 

An uplink load (.upl), image load (.img) and a 
contents (.cnt) file are created 

31. Follow the procedures to Verify Creation of Files. 

32. Follow the procedures to Verify a Load Report. 

33. Follow the procedures to Verify Load Contents. 
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 34. RTS Load With Hard Constraint 

Select ‘New’ from File menu. 

Follow procedures to Define an RTS Load. 

Follow procedures to Generate a RTS Load. 

Click ‘OK’ for hard constraints. The Load will not be 
generated. 

Note: 

Select the specific subsytem and commands to 
generate hard constraint violations. 

Note: CMS will validate the load prior to 
generation. If the load has hard constraints a 
window will appear; however, the user can only 
acknowledge the constraint. Loads cannot be 
generated with hard constraints. 

Verify the Load was not generated. 

35. RTS Load With Submnemonics/Parameters 

Select ‘New’ from File menu. 

Follow the procedures to Define an RTS Load. 

Specify the value of the parameter by entering the value after 
the equal sign. (note: the range is displayed) 

Click ‘OK’ and then ‘Insert’. 

Follow procedures to Generate a RTS Load. 

Follow procedures to Verify a RTS Load. 

Note: 

Select the specific subsytem and commands that 
require parameter information. 

The command directive and parameter with 
specified value are displayed in the ECL text 
box. 

36. Follow the procedures to Verify Creation of Files. 

37. Follow the procedures to Verify a Load Report. 

38. Follow the procedures to Verify Load Contents. 

5-241 322-CD-007-002/ 
411-CD-007-002 



39. Error Conditions. 

For each of the error conditions below, verify the dialog box 
displays the correct error information. 

a. No data in Delta Time field. (Click on Insert.) 

b. Command No. - No CMD# or Out Of Range. (Click on 
Insert.) 

c. RTS No.- No RTS# or Out Of Range. (Attempt to Generate 
Load.) 

d. Inconsistency between the mnemonic chosen and the 
subsytem selected. (Attempt to generate Load.) 

e. Cmd# greater than 16. (Attempt to Insert.) 

Verify the correct messages are displayed for 
each error condition. 

40. Open a RTS load from the Load Catalog 

Select Open from File menu. 

Select Load Catalog toggle button. 

RTS Load names in the load catalog will be 
displayed in the listbox. 

41. Select one RTS load name 

Click ‘OK’ 

The selected RTS load will be displayed in the 
RTS Load Builder. 

42. Delete the Load Catalog entry for a RTS load 

Select Delete from File menu. 

Select Load Catalog toggle button. 

RTS Load names in the load catalog will be 
displayed in the listbox. 

43. Select one RTS load name. 

Click ‘OK’. 

A Question Dialog box will be displayed to 
confirm the deletion. 
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44. Select Yes or No in the Question Dialog box. 

If Yes, verify the file is no longer present. 

Select Yes will send a request to CMS to delete 
the load from load catalog . The result of the 
deletion will be displayed as an event in the 
Control window. Select No will ignore the 
deletion. 

45. Select Delete from File menu. 

Do not select a RTS load name. 

Click ‘OK’. 

Delete Dialog box appears. 

Error Dialog box will be displayed with 
appropriate message. 

46. Select Open from File menu. 

Do not select a RTS load name. 

Click ‘OK’. 

Delete Dialog box appears. 

Error Dialog box will be displayed with 
appropriate message. 

47. End of test. 
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RTS Load Management


Test Case No: CMS 2180B 

Test Configuration: See Appendix G 

Test Support: EOC startup scripts 

Test Description: 

This test is designed to verify that the RTS buffer in load management are being properly modeled. 
maintain a RTS buffer model that mirrors what is on the spacecraft for each of the 128 buffer locations. This test demonstrates that 
when the user uplinks a RTS load, CMS updates its buffer model. 
user can request a map report which is a summary report of all of the buffers, or the user can request a report on one specific RTS 
buffer. This test will also demonstrate the ability to view all available RTS loads that have been generated and that are stored in the 
DMS load catalog. 

Success Criteria: 

A user is able to generate both RTS buffer model reports and ensure the information contained in the report is correct. 
success criteria will be that the user can generate a report on the available RTS load for uplink via the load catalog. 
success criteria is that after a load is uplinked the CMS buffer model is updated with the contents of the newly uplinked load 
through the use of the Manual Uplink Notification directive. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. -2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Log onto an FOT User Station. 

Start the User Station. 2010B --
User Station Startup and Authentication. 

The FOT User Station is running and the 
‘Control window’ is displayed. 

Load management should 

Once the load is uplinked and the buffer model is updated, the 

The validation and generation of the RTS load is covered in Test Case CMS-2170B. 

The second 
The third 

Reference Test Case SYS

Reference Test Case SYS-
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3. Manual Uplink Notification 

Use the Manual Uplink Directive (MUN) to uplink a RTS 
Load generated to update the RTS buffer. From the 
Command Control window enter the following directive: 

ECL> MUN <loadname> <partitionIndicator> 
<partitionAmount> YYYY:DDD:HH:MM:SS:mmm 

An event message will be generated indicating 
Successfully updated RTS Buffer Model with 
load <loadname>. 

4. Bring up netscape. 

%netscape 

Netscape browser will appear. 

5. In netscape, go to the data base utility. 

In the location section at the top of the netscape browser 
enter: 

http://elmyra.hitc.com/db_util/db_util_dba <CR> 

The Flight Operations Segment Database 
Utilities page appears. 

6. Go to the Reports section of the data base utilities. 

Click on the Reports section of the page. The Flight Operations Segment Database 
Reports page appears. 

7. Go to the Generate Reports section of the data base utilities 
web browser. 

Click on Generate Reports section of the page. 
The Flight Operations Segment Generate 
Database Reports page appears. 

8. Go to the Load Catalog Report section of the data base 
utilities web browser. 

Click on Load Catalog Reports section of the page. 
The Flight Operations Segment Database 
Reports page appears. 
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 9. Go to the RTS Load Catalog Report section of the data base 
utilities web browser and Generate the report. 

1) Click on the RTS Load Catalog Report section of the 
page. 

2) Click the Okay push button 

The verification page appears to generate a RTS 
load catalog report. 

Page appears which indicates the RTS load 
catalog report name and that the report has 
completed. 

10. Go back to the data base utility reports section of the data 
base utilities. 

1) Click on the back button at the top of the Netscape 
Browser 4 TIMES. 

or 

1) In the location section at the top of the netscape browser 
enter: 

http://elmyra.hitc.com/db_util/db_util_dba 

2) Click on the Reports section of the page. 

The Flight Operation Database Reports page re­
appears. 

11. Go to the View Reports section of the data base utilities web 
browser. 

Click on the View Reports section of the page. 
The Flight Operations View Database Reports 
page appears. 
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12. Go to the Load Catalog Reports section of the data base 
utilities web browser. 

1) Click on the Load Catalog Reports Section of the page. 

2) Enter the report name into the Report Name in the text 
box provided. 

3) Click the Okay push button. 

A list of available reports to view appears. 

The report appears on the page. Contents of the 
report include the Generation Date, Time, and 
Title. The report also contains the Load Name, 
RTS Buffer ID, Load Contents Source, and 
Valid Uplink Period (start and stop time), and 
actual uplink time for each RTS entry in the load 
catalog. 

13. Click on the back button at the top of the Netscape Browser 
4 TIMES. 

The Flight Operations Segment Database 
Reports page appears. 

14. Click on Print Reports section of the page, Click Load 
Catalog Reports. 

Enter the report name into the Report Name in the text box 
provided. 

Click the Okay push button. 

Select ‘Exit’ from File menu. 

A list of available reports to view appears. 

A hard copy of the report will be generated 

Netscape exits 

15. Invoke the RTS buffer model display. 

1) Click on the ‘Tools’ button in the Control window. 

2) Select RTS Buffer Display from the tools list box and 
click ‘OK’. 

or 

3) Double click on the RTS Buffer Display in the tools 
selection box. 

A Tools Selection list box appears. 

The tool selected appears in the text field box. 

The RTS Buffer Start Dialog window is 
displayed. 
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16. Get a map of the 128 RTS buffers and display it in the 
RTS Buffer display. 

1) In the RTS Buffer Display, click on the Spacecraft Id 
pull down menu and select AM1. 

2)  In the RTS Buffer Display, click on the Mode pull 
down menu and select operational. 

3) Click on the OK button. 

The Spacecraft id selected appears in the 
appropriate text fields. 

The Subsystem selected appears in the 
appropriate text fields. 

The RTS Buffer display is populated with the 
summary information of all 128 buffers. The 
display indicates the RTS number, number of 
links to other RTS’s, and the Inhibit id number. 
Criticality, Owner, Subsystem/Instrument, and 
Inhibit ID filter fields are empty. 

17. Invoke the filter selection display. 

1) From the RTS Buffer Display, click on the Filter… 
button. 

The RTS filter display appears. The Subsystem 
and the Spacecraft id selected appear in the 
appropriate text fields. The Critical, Owner, 
Sub/Inst and Inhibit Id field appear unselected. 

18. Select Critical in the Filter display to display the critical 
buffers. 

1) Click on the Critical toggle button. 

2) Click the ‘Apply’ button. 

3) Click the ‘OK’ button. 

The toggle button changes to selected. 

The RTS buffers that are critical are indicated on 
the RTS Buffer display. The ‘C’ field for each 
critical RTS changes to being highlighted red. 

Note: Requires a load with critical command(s) 
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19. View the contents of a specific RTS buffer using the RTS 
Command Buffer Display. 

1) Click on the RTS number that was just uplinked with 
MUN directive, to view the contents. 

2) Click ‘Close’. 

The RTS Command Display appears populated 
with the contents of the RTS and with the RTS 
number selected at the top of the display. For 
each command in the RTS the relative time in 
HH:MM:SS.mmm, any EXEC RTS commands 
will have the RTS number in the “Links To” 
Field of the command and the textual mnemonic 
of the command will be displayed. 

20. Report Generator (1 of 3) 

1) Click the Tools button on the Control window. 

2) Select Report Generator from the list box. 

3) Click ‘OK’ 

A Tools Selection list box appears. 

The tool selected appears in the text field box. 
The Report Selector window is displayed. 

21. Report Generator (2 of 3) 

In the Report Selector display, select the spacecraft id, the 
Report Category and the Report Type. 

1) From the Spacecraft Id pull down, select AM1. 

2) From the Report Category pull down, select CMS. 

3) Click the On Demand toggle button. 

4) Click Modeling Reports (On Demmand). 

The Report Selector display will filter on AM1, 
CMS on demand reports and display the 
available report types in the Available Reports 
section of the Report Selector display. 

The On_Demand Report Specification display 
will appear and display the available reports for 
the CMS on demand category. These report 
types will appear in a selection dialog portion of 
the display. The available types are ATC Map 
Report, RTS Buffer Report, RTS Map Report, 
Table Buffer Report and Table Map Report 
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22. Report Generator (3 of 3) 

Filter on the On-Demand type of reports that can be 
generated. 

From the On_Demand Report Selector click on the New 
Report… push button. 

The On_Demand Report Specification display 
will appear and display the available reports for 
the CMS on demand category. These report 
types will appear in a selection dialog portion of 
the display. The available types are ATC Map 
Report, RTS Buffer Report, RTS Map Report, 
Table Buffer Report and Table Map Report. 

23. Generate a RTS Map report 

1) From the On_Demand Report Specification display, 
select RTS Map Report. 

2) Click on Apply. 

The RTS Map Report becomes highlighted 

The RTS Map report is generated. 

Verify, via event display, the RTS map report 
was generated successfully 

24. Retrieve the RTS Map report that was previously 
generated. 

1) From the On_Demand Report Selector Display, click on 
Retrieve Reports. 

2) From the list of available reports, click on the RTS map 
report that was previously generated. 

3) Click OK. 

The On_Demand Report Selector display will 
update and list the reports available for viewing. 

RTS Map report entry will become highlighted. 

25. Verify the RTS Map Report contains the name of the RTS 
load content that is currently loaded into each of the 128 
RTS buffers. 

All information for each of the 128 RTS buffers 
is correct. 
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26. Generate the RTS Buffer Report 

Select RTS Buffer Report. 

1) From the On_Demand Report Specification display, 
select RTS Buffer Report. 

2) Click on the RTS Number toggle button. 

3) Enter in the RTS Number that the report is to be 
generated for. 

4) Click on Apply. 

The On_Demand Report Specification display 
will update and the RTS Number and RTS Load 
Name selection boxes will appear on the display. 

The RTS Buffer Report for the will be 
generated. 

Verify, via event display, the RTS buffer report 
was generated successfully 

27. Retrieve the RTS Buffer Map report that was previously 
generated. 

1) From the On_Demand Report Selector Display, click on 
Retrieve Reports. 

2) From the list of available reports, click on the RTS buffer 
map report that was previously generated. 

3) Click OK. 

The On_Demand Report Selector display will 
update and list the reports available for viewing. 

RTS Buffer Map report entry will become 
highlighted. 

28. Verify the RTS buffer report contains the list of commands 
in the buffer, their associated buffer location and the 
contents of each location. 

Report contains all information about the RTS 
buffer. 

29. Repeat Manual Uplink Notification. 

5-251 322-CD-007-002/ 
411-CD-007-002 



30. Filter on all of the RTS buffers that are owned by the COM 
subsystem. 

1) Select the COM owner by clicking on the Owner pull 
down menu on the display and highlighting COM. 

2) Click the ‘Apply’ button 

3) Click the ‘OK’ button 

The toggle button changes to selected. 

The owner pull down displays all possible 
owners and COM stays displayed after being 
selected. 

The RTS buffers that are owned by the COM 
subsystem are indicated on the RTS Buffer 
display. The ‘O’ field for each RTS owned by 
COM changes to being highlighted. 

31. Repeat Invoke the filter selection display. 

32. Repeat View the contents of a specific RTS. 

33. Repeat all 3 Report Generator steps. 

34. Repeat Generate a RTS Map report. 

35. Repeat Generate the RTS Buffer Report. 

36. Repeat Manual Uplink Notification. 

37. Filter on all of the RTS buffers that contain commands for 
the COM subsystem/instrument. 

Click on the Sub/Instr toggle button. 

Select the subsystem/instrument (AST) from the Sub/Instr 
pull down. 

Click the ‘Apply’ button. 

Click the ‘OK’ button 

The toggle button changes to selected. 

The Sub/Instr pull down displays all possible 
subsystem/instruments that are available and 
AST stays displayed after being selected. 

The RTS buffers that are for the AST 
subsystem/instrument are indicated on the RTS 
Buffer display. The ‘S’ field for each RTS 
owned by AST changes to being highlighted. 
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38. Filter on all of the RTS buffers that contain commands for 
the AST subsystem/instrument. 

Click on the Inhibit Id toggle button. 

Enter the Inhibit Id (0). 

Click the ‘Apply’ button. 

Click the ‘OK’ button. 

The toggle button changes to selected. 

The RTS buffers that are associated with the 
inhibit id 0 are indicated on the RTS Buffer 
display. The ‘I’ field for each RTS associated 
with inhibit id 0 changes to being highlighted. 

39. Repeat View the contents of a specific RTS. 

40. Repeat all 3 Report Generator steps. 

41. Repeat Generate a RTS Map report. 

42. Repeat Generate the RTS Buffer Report. 

43. Close the RTS Command Buffer Display. 

Click on the ‘Close’ button of the RTS Command. The RTS command display disappears. 

44. End of test. 

5-253 322-CD-007-002/ 
411-CD-007-002 



Table Load Management


Test Case No: CMS 2190B 

Test Configuration: See Appendix G 

Test Support: Test support will consist of pre-planned loads created in prior test cases. EOC Startup scripts are required. The Table 
Loads are created in Test Case CMS -2040B. Database Utilities are needed for creating and viewing database reports. Retrieve the 
Table Load Reports from the Table Load Generation for reference purposes. Report Generation tools are required for new reports. 

Test Description: 

This test is designed to verify that the Table buffers in load management are being properly modeled. 
maintain a Table buffer model that mirrors what is on the spacecraft. This test demonstrates that when the user uplinks a Table load, 
CMS updates its buffer model. 
summary report of all of the table buffers, or the user can request a report on one specific Table buffer. This test will also demonstrate 
the ability to view all available Table loads that have been generated and that are stored in the DMS load catalog. 
generation of the Table load is covered in Test Case CMS-2040B. 

Success Criteria: 

A user is able to generate both Table buffer model reports and ensure the information contained in the report is correct. 
success criteria will be that the user can generate a report on the available Table load for uplink via the load catalog. 
criteria is that after a load is uplinked the CMS buffer model is updated with the contents of the newly uplinked load. 

Step Id Action Expected Result/Output Pass/ 
Fail 

1. Log onto an EOC workstation. 

Start the Data Server. 2000B --
FOS Server Startup. 

Data Server processes are running. 

2. Start the Real-Time Server. ­
2000B -- FOS Server Startup. 

Real-Time Server processes are running. 

Load management should 

Once the load is uplinked and the buffer model is updated, the user can request a map report which is a 

The validation and 

The second 
The third success 

Reference Test Case SYS-

Reference Test Case SYS
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3. Log onto an FOT User Station. 

Start the User Station. Reference Test Case SYS-2010B – 
User Station Startup and Authentication. 

The FOT User Station is running and the ‘Control 
window’ is displayed. 

4. Within the Control window click the ‘Tools’ button. The Tools dialog box appears. 

5. Select the ‘Event Display Global’ option. 

Click the ‘OK’ button. 

Note: Customize the Window. 

The Tools dialog box closes. The Event Display 
window appears. 

6. Manual Uplink Notification 

Enter the MUN command to send manual uplink 
notification to CMS. From the Command Input line: 

Enter: MUN <Full Uplink Load File Name> < time 
(YYYY:DDD:HH:MM:SS.mmm)> 

Note: This information comes from the uplink times on the 
load report for each load. 

The Event Display message indicates ‘successfully 
uplinked Table Model with <Load File Name>. 

A TableBuffer.mdl and a <loadname>.buf file are 
created in the reports directory. 

7. Database Report Verification 

Start Netscape Internet Browser 

% netscape & 

OR 

Click and hold the right mouse button and select Netscape. 

The Netscape Browser will appear. 
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8. In the location field of the Netscape Browser, Enter 
http://elmyra.hitc.com/db_util/db_util_dba <CR> 

OR 

Select the designated bookmark for FOS Database Utilities 

The Flight Operations Segment Database Utilities 
page appears. 

9. Click on the Database Reports  section of the page. The Flight Operations Segment Database Reports 
page appears. 

10. Click on Generate Reports section of the page. The Flight Operations Segment Generate Database 
Reports page appears. 

11. Click on Load Catalog Reports section of the page. The Flight Operations Segment Load Catalog 
Reports page appears. 

12. Click on the Table Load Catalog Report section of the 
page. 

The verification page appears to generate a Table 
load catalog report. 

13. Click ‘Okay’. Page appears which indicates the Table load catalog 
report name and that the report has completed. 

14. Click on the back button at the top of the Netscape 
Browser 4 TIMES. 

The Flight Operations Segment Database Reports 
page re-appears. 

15. Click on the View Reports section of the page. The Flight Operations Segment View Database 
Reports page appears. 

16. Click on the Load Catalog Reports Section of the page. A list of available reports to view appears. 

17. Click on the back button at the top of the Netscape 
Browser 4 TIMES. 

The Flight Operations Segment Database Reports 
page appears. 
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18. Click on Print Reports section of the page, followed by 
Load Catalog Reports. 

Enter the Report Name in the box. Click Okay. 

A list of available reports to view appears. 

19. Within the Control window, click the ‘Tools’ button. The Tools dialog box appears. 

20. Modeling Report Information 

Select the ‘Report Generator’ from the list box. 

The Report Selector display window appears. 

21. In the Report Selector display, select the spacecraft id, the 
Report Category and the Report Type. 

From the Spacecraft Id pull down, select AM1, from the 
Report Category pull down, select CMS, Double click the 
On Demand toggle button. 

The Report Selector display will filter on AM1, 
CMS on demand reports and display the available 
report types in the Available Reports section of the 
Report Selector display. 

22. Select Modeling Reports from the Available Reports 
section of the Report Selector display and click OK. 

Select Default time or click on ‘Select Time’ and ‘OK’ for 
a specific time period. Click’OK’. 

The Report Selection display disappears and 
On_Demand Report Selector display appears. The 
display will contain the Modeling Reports in the 
Report Name text field, the User Name in the 
Requester Name text field, and the default start and 
stop time in the appropriate fields. The default stop 
time will be current time and the start time will be 2 
hours earlier. (Time will be in the format 
YYYY/DDD HH:MM:SS.mmm.) 

23. From the On_Demand Report Selector click on the New 
Report… push button. 

The On_Demand Report Specification display will 
appear and display the available reports for the CMS 
on demand category. These report types will appear 
in a selection dialog portion of the display. The 
available types are ATC Map Report, RTS Buffer 
Report, RTS Map Report, Table Buffer Report and 
Table Map Report. 

5-257 322-CD-007-002/ 
411-CD-007-002 



24. From the On_Demand Report Specification display, select 
Table Buffer Report and click on Apply. 

Enter the Table ID or Load Name in the appropriate box. 

The Table Buffer Report (Table_Buffer) is 
generated in the reports directory. 

25. From the On_Demand Report Specification display, select 
Table Map Report and click on Apply. Click ‘OK’. 

The Table Map Report (Table_Model) is generated 
in the reports directory. 

26. Go to the Reports directory and print the Table_Model 
(AM1_Table_Buffer….rpt) report. 

% cd /fosb/test/am1/reports 

% ls -ltr *.rpt 

% lp -o landscape (AM1_Table_Model_YYYY…rpt) 

The contents of this reports are compared with later 
reports. 

27. Repeat the steps for Manual Uplink Notification using a 
previously created Table Load file. 

28. Repeat the steps for Modeling Report Information. 

29. Partial Load 

Repeat the steps for Manual Uplink Notification using a 
Partial Load. 

30. Repeat the steps for Modeling Report Information. 
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31. Buffer Verification (These steps may be performed 
during off-line analysis) 

Verify the Database Report Information (Table Load 
Catalog Report) against the Load Report for each load 
uplinked. 

Verify the following: 

Table Load Name, Table Name, Table Load 
Number, Valid Uplink Start/Stop 

32. Ver i fy  the  Tab le  Model  Map Repor t  
(AM1_Table_Model_YYYY…rpt) against the Database 
reports for the loads uplinked. 

Verify the following: 

Table Number, Table Name, Last Uplinked 
Loadname, Owner and Tablesize 

33. V e r i f y  t h e  T a b l e  B u f f e r  R e p o r t  
(AM1_Table_Buffer_NN…rpt) Information has been 
updated for each load uplinked and that it matches the 
Load Created. 

Verify the following: 

Field Number, Field Size, Value, Default Value 

34. End of test. 

5-259 322-CD-007-002/ 
411-CD-007-002 


